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 مقدمه-1

 m.abdolah68@yahoo.comپست الکترونیکی:                                         تهیه کننده: محمد عبداله 

. این کتاب ویژگی ها و تکنیک های مربوط به به نرم افزار شبیه سازی کامسول مالتی فیزیک خوش آمدید

عنوان مثال، اطلاعاتی درباره ه ب را شرح می دهد. 1.4ورژن  COMSOLدر نرم افزار  مدل سازیتمامی مراحل 

مش برای تحلیل، چگونگی ایجاد پارامترها و  ایجادچگونگی ساخت هندسه مدل در کامسول، چگونگی 

نگی اضافه کردن رابط های فیزیکی و مشخصات مواد و چگونگی حل متغیرهای مورد استفاده در مدل، چگو

و و نمایش نتایج توضیح داده شده است. بطور کلی مجموعه ای کامل از مستندات بصورت گام به گام،  مسئله

 محیط کامسول را نمایش می دهد. قابلیت های آن درچگونگی انجام توابع و 

سول مالتی فیزیک و مجموعه محصولات آن، مجموعه ای از مستندات دید کلی از کاماین کتاب ل مقدمه، صفدر 

 ارائه شده است.و سایر منابع 

 COMSOLدارای ویژگی های توسعه یافته  و بهینه سازی شده، از قبیل کامسول نرم افزار  1.4نسخه 

Application Builder  وCOMSOL Server  آن برای ایجاد و توسعه قدرتمند و درعین حال می باشد که از

 باشد.بر اساس کامسول مالتی فیزیک قدرتمند می مورد استفاده برنامه های کاربردی به منظور ساخت آسان 

 

 درباره کامسول مالتی فیزیک

مدل و  ایجاد  برای،(powerful interactive environment)کامسول مالتی فیزیک یک محیط ارتباطی قدرتمند 

وقدرتمندی  محیط دسکتاپ یکپارچه داری مسائل مهندسی و علمی می باشد. این نرم افزارانواع حل همه 

(powerful integrated desktop environment ،) با استفاده از مدل ساز  می باشد کهModel Builder  دید

دراختیار شما قرار می دهد. با استفاده از کامسول مالتی آن دسترسی به تمام قابلیت ها امکان کامل از مدل و 

برای یک نوع از فیزیک خاص را توسعه داده و در مدل های  متداولفیزیک شما می توانید به راحتی مدل های 

.  دسترسی به این انجام دهیدبطور همزمان می باشد را  هاآنحل فیزیک های کوپل شده که  تاثیرمالتی فیزیک ، 

 نیست. ریاضیات و تحلیل عددیدر زمینه   کافیدانش و علم مند داستن  قدرتمند نیازقابلیت 

خواص  ازو پشتیبانی پیشرفته مختلف  (،physics interfaces)های فیزیکی  رابط استفاده ازشما می توانید با 

با تعریف  (،fluxesها )و شار (sources) منابع (،constraints) قیدها (،loads)بارها (،material properties)مواد
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شما می توانید متغیرها، عبارات یا اعداد را مستقیما به همچنین . مدلسازی خود را انجام دهید معادلات اساسی 

مستقل از مش های محاسباتی اعمال کنید. سپس، را نقاط جامد یا سیال یا ، مرزها، لبه ها و دامین های 

 می کند. حلمعادلات، کل مدل را مجموعه ای از  جمع آوریکامسول با 

از طریق رابط کاربر به طوری که امکان نمایش آن ، همچنین جهت دستیابی به یک محصول مستقل از کامسول 

 Applicationوجود داشته باشد، شما می توانید با ایجاد  مدل کاربردی از طریق منعطف  (GUI) گرافیکی

Builder   یاجاوا های در محیط کامسول و یا از برنامه ( برنامه متلبLiveLink™ for MATLAB® license) 

را که  (studies) با استفاده از این رابط های فیزیکی، شما می توانید انواع متفاوتی از مطالعات استفاده نمایید

 انجام دهید:موارد زیر است را  شامل

 (.transientیا گذرا )وابسته به زمان -( و زمانStationaryمطالعات پایدار ) -

 (.Linear and nonlinear studies) مطالعات خطی یا غیرخطی -

 (.Eigenfrequency, modal, and frequency response) فرکانس و پاسخ فرکانسی مدولمطالعات  -

مسائل را اسمبل کامسول با استفاده از مجموعه ای از ابزارهای آنالیز عددی پیشرفته هنگام حل مدل ها، 

(assemble ) را بطور همزمان با مش تطبیقی )درصورتی که انتخاب  این آنالیز ها راو حل می نماید. نرم افزار

 را کنترل می کند. ها شود( اجرا کرده و با استفاده از انواع حل کننده های عددی خطا

 cluster) و بصورت دسته ایر (multiprocessor systems)این مطالعات می تواند از سیستم های چندپردازنده 

computing)  استفاده کند و شما می توانیدbatch job   ها وparametric sweep .ها را اجرا کنید 

پارامتری امکان کند. این کار،  می را ثبتنتایج ، هندسه، مش،مطالعات و حل گر تمامی مراحل ایجاد کامسول 

از مدل درختی امکان اجرا  هر گره و به سادگی با اعمال تغییر در  کردن هربخش از مدل را آسان می کند؛

 مدل دوباره اجرا می شود.آن وجود دارد و تمامی طالاعات ذخیره شده مجددا 

 

 (REAL-WORLD APPLICATIONSطبیعت واقعی کاربردی )

پدیده انواع ( اساس قوانین علمی را تشکیل می دهد و پایه ای برای مدلسازی PDEsمعادلات دیفرانسیل جزئی )

گسترده ای از پدیده های مهندسی و علمی را ارائه می کند. شما می توانید در در طیف  های مهندسی و علمی 

 از کامسول استفاده کنید که شامل می شوند: ختلفزمینه های کاربردی م
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• Acoustics 

• Bioscience 

• Chemical reactions 

• Corrosion and corrosion protection 

• Diffusion 

• Electrochemistry 

• Electromagnetics 

• Fatigue analysis 

• Fluid dynamics 

• Fuel cells and electrochemistry 

• Geophysics and geomechanics 

• Heat transfer 

• Microelectromechanical systems (MEMS) 

• Microfluidics 
 

• Microwave engineering 

• Multibody dynamics 

• Optics 

• Particle tracing 

• Piezoelectric devices 

• Photonics 

• Plasma physics 

• Porous media flow 

• Quantum mechanics 

• Radio-frequency components 

• Semiconductor devices 

• Structural mechanics 

• Transport phenomena 

• Wave propagation 
 

 

 PDEهمزمان یک سیستم مالتی فیزیک  شامل شبیه سازیاز برنامه های کاربردی واقعی در طبیعت  بسیاری

تغییر می کند و یک مدل حامل جریان  ی آناغلب دما کنداکتور، که . برای مثال، مقاومت الکتریکی می باشد

تکنیک های  روش های مدل سازی مالتی فیزیکشامل شود. بخش داراست  گرمایی را  -مقاومت که تاثیرات

از پیش  مختلفرابط فیزیکی برای استفاده آسان بخش های  تعدادیمدل کردن مالتی فیزیک را بیان می کند. 

 تعریف شده است.

بسیاری از زمینه های کاربردی است. برای مدلسازی در  کربندی ، کامسول یک آنالیز قوی برای پیبراساس 

، مخصوصوجود دارد. این ماژول های  مختلف ماژول های انتخابی امکانبهکار گیری  کاربردی دامینچندین 

تحلیل مدل ها  می کند که تولید و تجزیه و حل مخصوصی دارند که همگی از یک نظم خاصی پیروی روش های

 نرم افزار وجود دارد، کتابخانه مدل برای هر ماژول  مثال های مختلفی  وجود دارد که در را آسان می کند. 

 ماژول های کامسول و قابلیت های ارتباط آن

از دوطرفه  رابط هایو  CADمانند وارد کردن مدل از نرم افزار  یماژول های انتخابی، شامل قابلیت های ارتباط

. اغلب برای برخی ماژول ها، می باشددقیق و رابط های فیزیکی به منظور بهینه سازی،  ، ™LiveLink طریق

 د.شدر دسترس می با المان ها و ابزارهای نمایشمواد حل گرهای تخصصی، انواع  افزودن کتابخانه های
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Helاسناد و -2 p در کامسول 

  comsol_multiphysics@yahoo.com :پست الکترونیکی             تهیه کننده: مرتضی مالکی        

 
هستند که شما می توانید از طریق آدرس زیر قابل  PDFهایی با فرمت  ها فایلDocumentaionاسناد یا 

 باشند: دسترس می

Start Menu> All Programs> COMSOL Multiphysics 5.1> Documentations 

 همچنین برای دسترسی به این اسناد از طریق نرم افزار همانند شکل زیر عمل کنید.

 

 افزار کامسول وجود دارد، شامل عناوین زیر است: اسنادی که به همراه نرمی کامل  مجموعه

در خصوص که شامل اطلاعاتی  -(Introduction to COMSOL Multiphysics)ای بر کامسول  مقدمه

افزار( است. این متن نسبتاً  نرم Desktopها با استفاده از محیط میزکار ) و چگونگی ساخت مدل 1.4ی  نسخه

ی کلید و دستورات و توابع را  حجم شامل مراجع  می باشند که امکان دسترسی سریع به میانبرهای صفحه کم

کار ابتدا این قسمت  ی افراد تازه شود همه پیشنهاد می فراهم می کند، و دید ابتدایی به کاربران تازه کار می دهد.

 را مطالعه و تمرینات عملی آن را اجرا کنند.

افرادی که قصد عزیمت به خارج از کشور  :(COMSOL License Agreementی مجوز کامسول ) نامه توافق

 نامه را مطالعه نمایند. را دارند، بد نیست این توافق

mailto:comsol_multiphysics@yahoo.com
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که در کنار پوشش دادن   :(COMSOL Multiphysics Installation Guideراهنمای نصب کامسول)

افزار کامسول را  بندی و اجرای نرم های سیستم و چگونگی ترکیب افزار، نیازمندی های مختلف نصب نرم گزینه

افزارهای مختلف( مختلف، که  افزارها و یا نرم های میکروکامپیوتری با سخت های )یعنی سیستم روی پلتفرم

بندی( باشند، را شرح  های تسهیم حافظه و توزیع موازی )خوشه توانند با کلاینت یا سرور و همچنین نسخه می

 دهد. می

یا با انجام تسهیم  serverتوان در صورت داشتن لیسانس  ی این راهنما، و داشتن مهارت کافی، می با مطالعه

ی کامپیوتر در یک شبکه به طور همزمان برای حل ی یک سر های نهفته و خفته بندی از قابلیت حافظه و خوشه

 کند. افزار کمک شایانی می پردازشی نرم استفاده کرد که به تسریع حل و همچنین ارتقاء کیفیت داده

 :(COMSOL Multiphysics Reference Manualافزار مولتی فیزیک کامسول ) دستورالعمل مرجع نرم 

سازی هندسه  رد و تمامی متون اسنادی در آن موجود است. از مدلاین کتاب، وظایف عملکرد کامسول را دا

سازی مبنی بر  های مختلف و مدل های فیزیکی برای فیزیک سازی، شامل واسط گرفته تا بررسی نتایج و بصری

افزار  باشد. این کتاب، به عنوان یک خودآموز و به عنوان یک راهنمای مرجع برای استفاده از نرم معادلات می

ها  کننده بندی(، حل بندی )شبکه ی کار هندسه، مش کند. این کتاب نحوه فیزیکی کامسول عمل میچند

(solverو نتایج را مرور کرده و اطلاعاتی در مورد تنظیمات و گزینه ،) کند که  های هر یک از این موارد بیان می

افزار نیز شرح داده  ی نرم  ات پیشرفتهدارای جزئیات کامل است. علاوه بر این، در کتاب برخی از وظایف و تنظیم

 کند. زمینه برای مواد و مراجع را نیز ایجاد می شده و یک پیش

کار در مورد سوالات عمومی مربوط به نرم افزار است. یعنی اطلاعات  این مرجع بهترین مرجع برای افراد تازه

ا خواند این مرجع و فیزیکی که باید در ها در این مرجع موجود است، شما به تنهایی ب تخصصی مرتبط با فیزیک

شوید. سپس هر جا نیازی به اطلاعات بیشتر  افزار متخصص می ی خود در این نرم آن مهارت پیدا کنید، در رشته

 بود، به راحتی پیدا خواهید کرد.

 COMSOL Multiphysics Programmingافزار کامسول ) نویسی در نرم دستورالعمل مرجع برنامه

Reference Manual): کند تا کامسول را با  این کتاب جزئیاتی راجع به امکانات و فنونی را که به شما کمک می

( آن کنترل شود را فراهم Application Programming Interface) API نویسی کاربردی استفاده از واسط برنامه

ی  (، در یک برنامهApplication Builderهای کاربردی ) توان در بخش ساخت برنامه را می APIآورد.  می

Javaکاربردی 
های دارای سرور(، و با استفاده از  شود و نه سیستم های منفرد تعریف می )که برای سیستم ®
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MATLABافزار  نرم
LiveLinkTM، به کمک لینک زنده )®

کار گرفت(. این قسمت به شما  به برای واسط متلب 

 ول را با استفاده از جاوا یا متلب از بین ببرید.های کامس کند تا محدودیت کمک می

مطالبی در  های کاربردی: دستورالعمل مرجع ساخت برنامه وهای کاربردی  ای بر ساخت برنامه مقدمه

از ( Server)دستورالعمل کامسول برای یک سرور های کاربردی ارائه شده است. همچنین  ارتباط با ساخت برنامه

 های کاربردی کامسول قابل مشاهده است. های آن برای برنامه و کلاینت بندی سرور قبیل: ترکیب

های  ها را با مدل های خود به طور عملی استفاده کنید و آن کنند تا از مدل های کاربردی به شما کمک می برنامه

در کنار هم  های کاربردی دیگری که )مثلا در یک سازمان( تولید شده است کنار هم قرار بدهید تا بتوانید مدل

 داشته باشید.

بندی،  اندازی، ترکیب اطلاعاتی راجع به راه :(COMSOL Server Manual) دستورالعمل کامسول برای سرور

 های کاربردی در داخل یک سازمان را در بر دارد. و اجرای یک سرور برای کامسول برای اجرا و آرایش برنامه

های تسهیم  فته شد، یک سرور مورد نیاز است، که بتوان از قابلیتبرای یک سازمان، مثل سازمانی که در بالا گ

 اطلاعات و تسریع محاسبات استفاده کرد.

مرتبط با ساخت فیزیک را ارائه  توضیحاتی:( Physics Builder Manualدستورالعمل ساخت فیزیک )

برد. در واقع  افزار را از بین می نرمهای فعلی  هایی است که محدودیت این قسمت هم یکی دیگر از بخش دهد. می

تواند آن پدیده را  سازی کند، می خواهد شبیه ی فیزیکی که می هر کسی با داشتن اطلاعات کافی در مورد پدیده

 به صورت یک ماژول فیزیکی برای کامسول در آورد.

نکات و اطلاعاتی  :(Essentials of Postprocessing and Visualization)سازی  پردازش و بصری اصول پس

 سازی در را کامسول بگیرید. پردازش و بصری در این قسمت ارائه شده است، تا بیشترین خروجی از ابزار پس

های مختلفی را استخراج  در واقع شما پس از حل مسأله،می توانید از معادلات اصلی حل شده نتایج و خروجی

کنید به صورت ترکیب یا  فرضی که استفاده می های پیشها به جای مقدار متغیر کنید، کافی است  در خروجی

توابعی از متغیرهای مختلف بنویسید. بصری سازی هم در واقع کمک به درک استفاده از انواع نمودارهای 

 خروجی کامسول است.
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ه نصب نصب مبادرت بتوانید در هنگام  هایی که می های دلخواه ]منظور ماژول ها، هر یک از ماژول علاوه بر این

The های کامسول ) های ماژول ها و واسط ها بکنید یا نکنید[ شامل یک دستورالعمل هستند که در گزینه آن

COMSOL Modules and Interfacing Optionsکنیم. مطالبی که برای  ها بیشتر صحبت می ( در مورد آن

ای در  های جداگانه و لینک زنده به آن وجود دارد در دستورالعمل CADی ماژول دلخواه وارد کردن از  بسته

 Materialمواد کاربر )ی  ی مواد دلخواه نیز در راهنمای کتابخانه دسترس است، و مطالبی در مورد کتابخانه

Library User’s Guide )باشد. موجود می 

 COMSOL LiveLink™ for MATLAB® User’sی کامسول و متلب برای کاربر ) مای لینک زندهنراه

Guide)- های کامسول  نویسی متلب به قابلیت توان با استفاده از محیط برنامه دهد که چگونه می نشان می

 دسترسی پیدا کرد.

 های مختلف های مختلف برای سیستم عامل دستورالعمل

کند، که سبکی  شود[ استفاده می افزار مشاهده می پلتفرم ویندوز از یک آرایش نواری ]نواری که در بالای نرم

( با آن آشنا هستند و البته در بسیاری دیگر از Microsoft® Officeی آفیس ) است که کاربران مجموعه

افزاری استفاده می شود. آرایش نواری یک سبک مبنی بر درک شهودی است و امکان کار بر  نرمهای  طراحی

ای وجود دارد که  های لینوکس و مک نوارابزارهای گسترده کند. در پلتفرم های مشابه زیاد را راحت می روی گزینه

و تنها با یک کلیک برای هر گزینه کاربر افزار،  کند که برای انجام بیشتر کارها در نرم تقریباً حالتی را ایجاد می

 می تواند امکان دسترسی آسان به آن را داشته باشد.

استفاده از نوار برای کاربران ویندوز بدین معنی است که نسبت به کاربران مک و لینوکس، تفاوت ساختاری 

های  وقتی دستورالعملها لحاظ شده است.  ها و گزینه ها در خصوص چگونگی دسترسی به ویژگی کمی برای آن

ها با  ی( خاص را پیدا کرد، در این دستورالعمل توان یک ویژگی )یا گزینه خاصی در مورد اینکه در کجا می

های عامل مختلف تمایز قائل شده است. به عبارت دیگر، مشخص شده  های مختلف بین سیستم استفاده از آیکون

 گزینه دسترسی پیدا کرد. است که در هر سیستم عامل چگونه می توان به یک

 ها استفاده نشده است. های مختلف وجود ندارد، از این آیکون در جاهایی که تفاوتی بین سیستم عامل -

های جزئی و کوچکی در شکل ظاهری یا قابلیت دسترسی وجود دارد، اما عملکردها در  وقتی که تفاوت -

 ها استفاده نشده است. نهای مختلف مثل هم هستند، باز هم از این آیکو عامل سیستم

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_introduction.08.03.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_introduction.08.03.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_introduction.08.03.html
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ها و امکانات از طریق  ها برای تمامی پلتفرم ها به گونهای می باشد، که ویژگی به طور کلی، دستورالعمل -

همگی  Geometry ، یاHome ،Physics ،Meshنوارابزارها قابل دسترسی هستند. برای مثال، نوارابزار 

برهای نوار ابزار و  میانهر نوارابزار، بخش ر در مورد توانید برای اطلاعات بیشت همین حالت را دارند. می

 ( را مشاهده کنید.Toolbars and Keyboard Shortcuts) کلید صفحه

 

 

tab ی ویندوز می باشد. همانند شکل زیر: نواری، گروه نواری، در نسخه 

 

 

 

وجود دارد که برای کاربران مک و لینوکس است.  cross-platformی پلتفرم  نوارابزار در نسخه

 همانند شکل زیر:

  
 

 اند هایی که در این دستورالعمل استفاده شده در مورد عکس

اند با استفاده از پلتفرم ویندوز گرفته شده است،  دستورالعمل مرجع استفاده شدههایی که در خلال این  عکس

 ها وجود داشته باشد. ی نمایش بین ویندوز و دیگر پلتفرم مگر اینکه تفاوت مشخصی به غیر از خط یا نحوه

 

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.33.html
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 منابع اینترنتی 

ند، از جمله اطلاعات مرتبط با تعدادی منابع اینترنتی وجود دارد که اطلاعات بیشتری در مورد کامسول دار

مبنی بر موضوع یا مبنی بر مفهوم، و  Help( و اطلاعات فنی. اسناد الکترونیکی، Licensingمجوزها )

 های کاربردی از طریق میزکار کامسول قابل دسترسی است. کتابخانه

 

های  کنید، لینک روی کامپیوتر خود مطالعه می PDFها را با فرمت فایل Documentationاگر 

اند کار نخواهند کرد. بهرحال، اگر از  دهی شده ها و مفاهیمی که مرجع رنگ برای باز کردن برنامه آبی

های دیگر )در صورتی  ها برای باز کردن ماژول کنید، این لینک در کامسول استفاده می Helpسیستم 

 ی متون دیگر فعال هستند. های کاربردی، و مجموعه الکه در مجوز شما موجود باشند(، مث

و فیلترشکن از اطلاعات اینترنتی کامسول  VPNتوان فقط از طریق  البته باید توجه داشت که در ایران می نکته:

 Forumهایی به شکل  استفاده کرد. چون این سایت کشور ما را تحریم کرده است. در سایت کامسول قسمت

ید مشکلات خود را با متخصصان یا کاربران دیگر به اشتراک بگذارید. فقط مراقب باشید که توان هست که می

کنند، حتی پست شما را  ی کاربری شما را حذف می متوجه نشوند از ایران هستید. وگرنه گذشته از اینکه شناسه

 کنند. بندند و حذف می نیز می

 

 با کامسول از طریق ایمیل ارتباط

 تماس بگیرید. info@comsol.comبرای اطلاعات کلی محصولات، با آدرس 

برای دریافت حمایت فنی از کامسول برای محصولات این شرکت، لطفا با پشتیبان محلی خود تماس گرفته یا 

بندی به ایمیل شما  های بسته های خودکار و شماره بفرستید. اعلامیه suppor@comsol.comبه سوال خود را 

 فرستاده خواهند شد.

 

 

 

mailto:info@comsol.com
mailto:suppor@comsol.com
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 سایت کامسول وب

 www.comsol.com سایت کامسول وب

 www.comsol/contact ارتباط با کامسول

 www.comsol.com/support مرکز پشتیبانی

 www.comsol.com/product-download دانلود محصولات

 www.comsol.com/support/updates رسانی محصول بروز

 www.comsol.com/community هاForumبحث در 

 www.comsol.com/events رویدادها

 www.comsol.com/video ویدئویی کامسول گالری

 www.comsol.com/support/knowledgebase پایگاه پشتیبانی دانش

 

 proxyاستفاده کنید. در اغلب موارد  vps و vpnسعی کنید برای استفاده از امکانات، بیشتر غیرفعال باشید یا از 

 قابل شناسایی و رهگیری است. 

 

 بر اساس عناوین Helpی  پنجره

های موجود در میز کار کامسول متصل هست کاربردی و مفید  به این دلیل که بسیاری از گزینه Helpی  پنجره

توانید تمامی  شود. همچنین شما می مضمونی گفته می Helpبر مبنای عناوین یا  Helpاست. با این مفهوم، 

وجو کنید. وقتی این پنجره باز باشد، روی هر  هستند را در این پنجره جست HTMLمطالب متونی که به فرمت 

شود. و از همین بابت این  ی تنظیم کردن آن آورده می ای که کلیک کنید، توضیحات مرتبط با آن و نحوه گره

 searchتوانید در آن  شود. از آن گذشته، اگر موضوع خاصی مورد نظر شما باشد، می پنجره بسیار کاربردی می

 وجو بهره بگیرید. کنید تا از کل متون کمکی و آموزشی کامسول در این جست

 

یک سرور وب بر روی کامپیوتری که  8090، به طور خودکار با استفاده از درگاه Helpسیستم 

کند. بسته به تنظیمات امنیتی کامپیوتر شما، ممکن است  کامسول روی آن نصب شده است، ایجاد می

افزار استفاده کنید، از شما پرسیده شود که آیا این  نرم Helpخواهید از سیستم  اولین باری که می

http://www.comsol.com/
http://www.comsol/contact
http://www.comsol.com/support
http://www.comsol.com/product-download/
http://www.comsol.com/support/updates
http://www.comsol.com/community
http://www.comsol.com/events/
http://www.comsol.com/video/
http://www.comsol.com/support/knowledgebase/
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 پورت اجازه دارد فعال شود یا خیر.

( بدهد. برای firewallز ممکن است یک هشدار امنیتی در خصوص دیوارآتش )سیستم عامل نی

 ، به کامسول اجازه دسترسی از طریق این دیوار آتش را بدهید.Helpاستفاده از 

 نکته:هنگام استفاده از فیلترشکن های مانند سایفون این هلپ غیر فعال می شود.

)اولین پنجره سمت چپ که مدل را در آن ساخته و  برای آشنایی بیشتر با یک گره در قسمت ساخت مدل

افزار است(، روی آن گره  نرم Desktopکنیم(، یا با پنجره روی میز کار )منظور همان  جا اضافه می ها را در آن گره

باز شده و  Help ی را فشار دهید. پنجره F1در بیاید، سپس کلید  Highlight یا پنجره کلیک کنید تا به صورت

 دهد. اطلاعات مرتبط با آن گزینه را نمایش می

 مبنی بر عناوین Helpو  Helpی  باز کردن پنجره

 وجود دارد: Helpی  چندین راه برای باز کردن پنجره

 را فشار دهید. F1 کلید -

 مشخص شده است( کلیک کنید. )که با علامت سؤال  Help روی نوار ابزار اصلی روی کلید -

 ( کلیک کنید.راست میز کار کامسول، روی علامت سؤال )در قسمت بالای سمت  -

 را برای مک و لینوکس انتخاب کنید. Help>Help را برای ویندو، و File>Help، از منوی اصلی -

 را انتخاب کنید. Helpی  ای در قسمت ساخت مدل کلیک راست کرده و گزینه روی هر گره -

 مفهومی Helpبرای دسترسی به  F1در خصوص استفاده از کلید 

توانید یکی از  در میز کار کامسول، می Helpی  ( در پنجرهcontext)برای نشان دادن اطلاعات بر اساس موضوع 

 کارهای زیر را انجام دهید:

در بیاید. برای مثال روی  Highlightی ساخت مدل، روی یک گره کلیک کنید تا به حالت  در پنجره -

 .Geometryیا  Componentی  گره

 .Messages، یا Model Builder ،Add Studyپنجره کلیک کنید، برای مثال  tabروی یک  -
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توانند ماوس خود را روی کلیدهای نوار ابزار ببرند تا ابزارک نشان داده شود، و در  کاربران ویندوز می

را فشار دهند تا جزئیات بیشتری نمایش داده شود. این  F1حالی که ابزارک در حال نمایش است، کلید 

 پذیر است. های منوها، امکان حالت تنها برای کلیدها، و نه زیرمجموعه

 و اسناد Helpنوارابزار  -4-4جدول 

 
 توضیح نام کلید

 

 خانه
اسناد در گردد. تنها برای  ی اسناد کامسول باز می ی پنجره ی خانه به صفحه

 باشد. )در قسمت های بعدی توضیح داده خواهد شد(. ویندوز موجود می

 

 مضامین

اسناد و  HTMLی  کند. این نسخه یک منوی درختی از اسناد کامسول باز می

هم قابل دسترسی است. این  Documentationی  متون است که از طریق پنجره

. وقتی که یک گره را در وجود دارد Helpی  منوی درختی تنها برای پنجره

 Topicی  کنید، عنوان مرتبط با آن در صفحه جدول درخت مضامین انتخاب می

 شود. نمایش داده می

 

 وجو جست

وجو برای یافتن  ، روی این آیکون کلیک کنید تا موتور جستHelpی  در پنجره

خواهید در میان اسناد و متون کمکی کامسول روشن شود.  مضمونی که می

بندی  های مختلف کامسول، دسته ی نتایج یافته شده بر اساس بخشتمام

 شوند. می

وجو را در قسمت مربوطه  عبارات مورد جست ،Documentationی  در پنجره

 Search scope—All documents، Selectedهای  وارد کنید و یکی از گزینه

only یا ،Application library .را انتخاب کنید 

وجو و محتویات  مربوط به جست Helpتوانید قسمت  برای اطلاعات بیشتر می

( را ببینید تا متوجه Searching Help and Documentation Content) اسناد

توانید استفاده کنید)در قسمت  وجوی خود می شوید از چه شرایطی در جست

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_introduction.08.07.html
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 های بعدی توضیح داده خواهد شد(.

 

 عنوان

، مستقیما به اطلاعاتی در خصوص یک گره یا پنجره که در Helpی  در پنجره

فعال است. اید بپرید. این بخش یک محیط  میزکار کامسول روی آن کلیک کرده

 روی گره کلیک کنید تا محتوای این قسمت همزمان با آن تغییر کند.

 

 Helpقفل 

(Sticky Help) 

ی فعلی قفل شود )که در  روی این کلید کلیک کنید تا صفحه Helpی  در پنجره

(، که برای حفظ کردن گردد  می Highlightصورت قفل بودن، این کلید 

هایی که باید مورد بررسی قرار گرفته یا اجرا  لبرخی از عناوین یا دستورالعم

سرهم عوض شدن  تواند برای جلوگیری کردن از پشت شوند، مفید است، یا می

 های مختلف کمک کند. موضوعات این پنجره در هنگام کار با قسمت

 

Back گردد. به عنوان که قبلاً انتخاب شده بود، برمی 

 

Forward 
ی بعدی  گردد. البته تنها در زمانی فعال است که گزینه برمیبه عنوان بعدی 

 وجود داشته باشد.

 

Next رود. به عنوان بعدی در سری نمایش داده شده می 

 

Previous رود. به عنوان قبلی در سری نمایش داده شده می 

 

 

 Helpفرض  تغییر تنظیمات پیش

کلیک کنید. )در قسمت های  Helpرا باز کرده و روی  Preferences Dialog Boxبرای ویرایش تنظیمات زیر، 

 بعدی توضیح داده خواهد شد(.

که  Helpانتخاب کنید تا محتوای  Help Modeرا از لیست  Integratedفرضِ(  ، )حالت پیشFormatی  در ناحیه

ارچه است، نمایش شود را که با محیط کامسول همخوانی دارد و به صورت یکپ نمایش داده می Helpی  در پنجره

را انتخاب کنید تا این مفاهیم را در مرورگرهای جداگانه نشان دهد. برای این حالت  Web Browserدهد، یا 

(Integrated تنظیمات ،)PDF-file target های  آنچه را که در هنگام کلیک کردن شما بر روی لینکPDF  در

در  PDFرا انتخاب کنید تا متون  In Placeی  د. گزینهکن افتد، کنترل می اتفاق می Documentationی  پنجره

ها را مرورگر وب  را انتخاب کنید تا آن New Windowنشان داده شود یا  Documentationی  پنجره

 فرضتان نمایش دهد. پیش
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به صورت محلی و با استفاده از  Helpقرار دهید تا  Localرا بروی حالت  Source ،Locationدر قسمت 

سایت کامسول استفاده کنید  وب Helpرا انتخاب کنید تا از  Onlineای نصب شده نمایش داده شود یا ه فایل

مطمئن استفاده  Proxyیا  VPNهای نصب شده استفاده کرد، مگر اینکه از یک  )البته در ایران تنها باید از فایل

، مسیر Localروز خواهید بود(. برای حالت  ، بهHelpی آنلاین این است که همیشه از لحاظ  کنید. خوبی استفاده

ها بر مبنای  فرض فایل را در صورت نیاز ویرایش کنید. مسیر پیش Documentation root directoryفایل 

 های مختلف بصورت زیر است: پلتفرم

 برای ویندوز:

C:\Program Files\COMSOL\COMSOL51\Multiphysics\doc, or generically COMSOL51\doc 

 ی مسیری که کامسول در آن نصب شده است: برای مک و لینوکس، در ادامه

COMSOL51/Multiphysics/doc 

 Proxyتنظیمات سرور 

توانید از این قسمت برای مشخص کردن تنظیمات مربوط  به اینترنت متصل هستید، می Proxyاگر از طریق یک 

در حالت  Helpارتباط هستید از نمایش آنلاین  کمک کنید تا زمانی که با سایت کامسول در Proxyبه 

Integrated ی  استفاده کنید و همچنین کتابخانهApplication Library ی  و کتابخانهPart Library  کامسول را

 Application Library The Application Library Updateی  روزرسانی کتابخانه ی به روزرسانی کنید )پنجره به

Window ی  روزرسانی کتابخانه ی به و پنجرهPart Library The Part Library Update Window  را برای

 اطلاع از جزئیات بیشتر در خصوص این خدمات مشاهده کنید(.

 باشد: های زیر می ( دارای گزینهConfigurationبندی ) لیست ترکیب

شود و تمامی  روزرسانی متصل می (: مستقیم به سرور بهNo Proxy Server) Proxyبدون سرور  -

 فرض به همین صورت است. زند. تنظیمات پیش ها را دور می پروکسی

کند  ی سیستم استفاده می (: از پروکسی گستردهUse System Settingاستفاده از تنظیمات سیستم ) -

 قرار گرفته شده است.که تنظیمات آن در سیستم شما 

خواهید یک سرور پروکسی را با وارد  (: این گزینه را زمانی انتخاب کنید که میManualتنظیم دستی ) -

تعریف  Port Numberو  Serverی درگاه )پورت( آن در فیلدهای  آن( و شماره IPکردن نام )یا آدرس 

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.22.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.22.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.22.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.23.html
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فرض  ( به طور پیشHTTPS) HTTPاست که برای ارتباط امن  199فرض  ی پورت پیش کنید. شماره

گیرد. اگر سرور پروکسی تأییدیه نیاز داشته باشد، اولین باری که هر بخش  مورد استفاده قرار می

دسترسی  Part Libraryیا  Application Libraryهای  های کتابخانه روزرسانی کامسول به متون و به

 خواهد شد.ی عبور از شما خواسته  کند، نام کاربری و کلمه پیدا می

 انتخاب یک مرورگر وب

توانید انتخاب کنید  می )تنها برای ویندوز و لینوکس( Web Browser، زیر Prefrencesی  در بخش اصلی صفحه

کند، باید از کدام مرورگر برای نمایش  در مرورگر وب استفاده می Helpافزار کامسول از حالت  که زمانی که نرم

 باشند: استفاده کند. تنظیمات زیر موجود می Helpسایت کامسول و محتوای  صفحات وب

فرض سیستم  قرار دهید تا از مرورگر پیش system defaultرا روی حالت  Programدر ویندوز: تنظیمات 

را انتخاب کرده و سپس مسیری به مکان فایل اجرایی یک  Customد حالت توانی استفاده کند. همچنین می

 مرورگر متفاوت که بر روی کامپیوترتان نصب شده است، وارد کنید.

کلیک کرده و  Browserبنویسید یا روی کلید  Executableدر لینوکس: مسیر مرورگر وب را مستقیما در فیلد 

 ه کنید.سپس به فایل اجرایی بر روی سیستم اشار

 

فرض سیستم  در مک، این تنظیمات وجود ندارد، و کامسول همیشه از مرورگر وب پیش

 کند. استفاده می
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 پنجره ی اسناد و جستجوی در محتوای اسناد -3

  hosseinmghasemi@ut.ac.ir  پست الکترونیکی:                               تهیه کننده: محمد قاسمی   

 :در ویندوز باز کردن پنجره ی اسناد 

 Ctrl +F1 را بزنید.  

  از منویFile  ،Help>Documentation  کنید .  را انتخاب 

 :در مکینتاش  و لینوکسباز کردن پنجره ی اسناد 

 Ctrl +F1  را بزنید 

    در نوار ابزار اصلی، روی دکمه یDocumentation ( بزنید .) 

  از منویHelp  ،Documentation   .را انتخاب کنید 

سته به نوع لایسنس( ب،)  HTMLیا  PDF، شما می توانید در فرمت های  Documentationدر پنجره ی 

اطلاعات وجود دارد که در  جهت دسترسی به اینمختلفی  وش هایکنید. ر مشاهدهاسناد را جستجو و 

 شکل های زیر نشان داده شده است.

 

در دسترس خواهند بود و می توان در شاخه های درختی جستجو  HTMLدر این شکل بر حسب لایسنس، لینک ها با فرمت 

 کرد. هنگامی که روی یک موضوع کلیک کنید، تمامی اطلاعات مربوط به آن در سمت  راست صفحهقابل مشاهده می باشد.

mailto:comsol_multiphysics@yahoo.com
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قابل دسترسی   HTMLیا  PDFهمانطور که در شکل بالا مشاهده می شود، بر اساس نوع لایسنس ،  اسناد با فرمت های 

 PDFکلیک منید ، صفحه به اولین صفحه ی اسناد مربوطه متقل می شود و هنگانیکه روی  HTMLهستند. هنگامی که روی 

 کنید. saveکلیک کنید می توانید،  نسخه ی کامل آن را 

 

 اسناد  در محتوای جستجوی

را  File  ،Help>Documentationبرای جستجو یک موضوع در هلپ نرم افزار، در سیستم عامل ویندوز از منوی 

وارد کنید و ( Search expressionجستجوی عبارت )عبارت جستجو را داخل بخش  سپسکنید.  انتخاب 

چنانچه می خواهید عبارت مورد نظر در . انتخاب کنیدی جستجو را محدوده(، search scopeسپس از لیست )

برای جستجو در مدل های کتابخانه نرم افزار ، All documentsکلیه قسمت های هلپ جستجو شود گزینه 

چنانچه می خواهید جستو محدود به یک قسمت از هلپ یاشد  را انتخاب کنید. Application libraryگرینه 

 از لیست  Selected onlyپس از انتخاب گزینه  (COMSOL Multiphysics Reference Manual)برای مثال 

(search scope) با کلیک بر روی گزینه انتخاب کنید و سپس را  مورد نظر از نمودار درختی قسمتsearch 

 The Documentationی اسناد )کلیه عبارات شبیه با موضوع جستجو می شود. نتایج جستجو در پنچره

Windowافزار شود.  در شکل زیر یک نمونه از روش جستجو در اسناد نرم ( دسته بندی و نمایش داده می

 .نمایش داده شده است

 

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_introduction.08.06.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_introduction.08.06.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_introduction.08.06.html
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 برای جستجویپیشرفته در نرم افزار کاربرمی تواند از عملگرهای زیر استفاده کند.

 جستجو برای پارامترهای موجود در کامسول

 توضیحات مثال عملگر
&&, AND block && cone 

block AND cone 
 نتایج  جستجو شامل تمامی کلمات باشد

OR, || block OR cone 

block || cone 
 نتایج جستجو شامل هر کلمه ای از عبارات وارد شده باشد. 

+, − +block −cone ( و برای در نظر نگرفتن  عبارت دیگر)+( نتیجه جستجو برای یک عبارت-) 
“, ~ “plot line”~10  نتایج جستجوشامل عباراتی که در داخل کوتیشن قرار دادهم ی شوند  و تعداد

 شخص می شود. ( م~نتایج در این زمینه با )
~ ecentric~  برای کلماتی که معمولا به صورتی خاص ، بیان می شوند، مثلا ؛ کلمه ی

eccentric نتیجه جستجو شامل این کلمه خواهد بود. 
? h?t 

استفاده از علامت سوال به منظور اشاره ی دقیق به یک حرف است. برای مثال 

،  aکه علامت سوال )؟( نشانگر  hutو  hat ،hitجستجو کنید برای تمامی موارد 

i  یا هر کلمه ای بینh  وt .باشد 

* strain* 

strain*d  جستجو برای هر کلمه ای که باstrain  شروع می شود. نتایجی به صورت
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strain-based ، strain-rate  یاstrain  خواهد بود. برای مثال ستاره تعداد

عبارت استفاده شود، آنگاه برای کراکترها را مشخص می کند.اگر ستاره در وسط 

 است. strainedجستجو صورت میگیرد. نتیجه برای این مثال  dو  n حرفی بین

enclosed 

quotation 

marks “ ” 

“time dependent study”  استفاده از علامت کوتیشن در طرفین عبارت برای جستجوی دقیق عبارت است؛

 آورده شده اند ،جستجو صورت می گیرد.به طوریکه به ترتیبی که کلمات عبارت 
@ strain@  شود. تمامی موارد دارای کلمه ی یک کاراکتر ناشناخته محسوب می @علامت

strain .ارائه می گردد 

 

 نکات مهم در جستجو:

  کاربر با شناخت کلی از هلپ نرم افزار و روش جستجو در هر مرحله از مدلسازی می تواند سوالات خود را در

کامسول جستجو کند، برای مثال در زمینه پارامتر نویسی چنانچه مشکلی داشته باشید می توانید با جستجو 

تمامی مطالب مربوط به این عنوان را مشاهده کنید. قابل ذکر هست  که عبارت جستجو  parameterعبارات

 آسان این عبارت را می دهد.شده است که به کاربر امکان نمایش  high lightشده در هر صفحه با رنگ زرد 

  چنانچه به تازگی کار با نرم افزار کامسول را آغاز کردید، استفاده ازهلپ به شما کمک می کند تا از طریق

جستجو در مدل کتابخانه ای نرم افزار مدل مورد نظر را پیدا کنید. و چنانچه میخواهید تئوری و معادلات 

ید شما می توانید به آسانی با جستجو در اسناد با شتاب بیشتری مربوط به موضوع مورد نظر را مشاهده کن

 این نرم افزار را یاد بگیرید.

  جستجوی یک عبارت بسته به نوع پردازشگر رایانه می تواند از ثانیه تا چند دقیقه طول بکشد، از آنجایی که

 ( غیر فعال می شود.Desktopسیستم اسنادی با نرم افزار یکپارچه است به هنگام جستجو نرم افزار )

 ِمانند سایفون استفاده کنید جستجو و مشاهده هلپ برای شما غیر فعال می گردد  یچنانچه از فیلتر شکن

 چرا که همانطور که گفته شد این هلپ با یک پروکسی به نرم افزار متصل است.

 

 برای آشنایی بیشتر کاربر با هلپ نرم افزار به ذکر مثالی می پردازیم.

محمد دانشجوی ترم سوم رشته کارشناسی ارشد مهندسی شیمی هست، او می خواهد برای پایانامه خود بر روی 

 احتراق کار کند و می خواهد بداند که آیا در مدل های کتابخانه نرم افزار مثالی در زمینه احتراق وجود دارد؟ 
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( یا همان احتراق را جستجو می combustionمحمد با توضیحات ارائه شده در زمینه هلپ در این بخش کلمه )

 پیدا می کند. CFDکند، همانطور که در شکل زیر مشاهده می شود، او مدلی در زمینه احتراق و در ماژول 

 

را در هلپ نرم افزار مشاهده می  combustionمحمد به آسانی پس از جستجو و انتخاب مدل مورد نظر عبارت 

 کند.
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چگونه می توان واکنش شیمیایی را در مدل خود اعمال کند با جستجوی کلمه  دداناز آنجایی که محمد نمی 

Reaction .و مشاهده نتایج با نحوه معادلات واکنش شیمیایی و نحوه مدلسازی آن آشنا می شود 

 

مدلی را که محمد شبیه سازی کرده است مدل دو بعدی می باشد، ولی بر حسب نیاز او به منظور اعتبار سنجی 

با نحوه رسم نمودار یک بعدی  1D plotتایج خود نیاز به رسم نمودار یک بعدی دارد، لذا او با جستجوی کلمه ن

 در نرم افزار آشنا می شود.
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 علائم تایپی -4

  ali_aghaeiii@yahoo.com  پست الکترونیکی:                                علی آقائی         تهیه کننده: 

از اصول تایپی ویژه ای استفاده شده فهمیدن رابظ های گرافیکی و تمام اسناد و اطلاعات به منظور درک آسان 

از میان اطلاعات  است که در جدول زیر نشان داده شده است. کاربر با درک این اصول می تواند به راحتی 

  گیرد.ببه کار  آنها را مختلف بهترین را انتخاب کرده و

 مثال علائم تایپی
 

Highlighted in 

blue 

دست   pdfکاربر می تواند به اظلاعات دیگری در  آبیدر صورت کلیک بر روی متن پر رنگ شده  رنگ 

بر روی عبارات آبی رنگ می توانید،  . همچنین زمانی که از هلپ کامسول استفاده می کنید با کلیکیابد

 به مدل های و مثال های کاربردی و مجموع اسناد و مدارک مورد نیاز برای کار دسترسی پیدا کنید.

 
 فوت های

boldface 

 

فونت حروف برجسته دقبقا نشان دهنده لغات و کلمات در دسکتاب کامسول هستند.برای مثال پنجره 

که شامل مدل درختی است. در مثال دیگر دستورالعمل ممکن است گفته شود   Model Builderای 

( کلیک کنید و این بدین معناست که هنگامی که شما بر روی دکمه شناور که بر روی دکمه زوم )

 موس کلیک می کنید مشابه همین عمل بر  روی صفحه نمایش در دسکتاب کامسول انجام می شود.

 
 فوت های

italic 

فونت معرف اصطلاحات مهم است و از این طریق اصطلاحات مهم در پاراگراف ها و واژه نامهای این 

مشابه مشخص شده است. نام اسناد و مدارک دیگر در مجموعه اسناد و مدارک کامسول با این فونت 

 مشخص شده است.

Forward 

arrow symbol 

> 
 

و اشکال و بخش ها را برای منظور خاصی این نماد بدین معنی است که شما یک سری از آیتم ها 

به این معناست و معادل است که در گره  Component>Mesh انتخاب کنید. برای مثال

Component  گزینه ،Mesh .را انتخاب کنید 

code به  کد فونت به این معناست که شما از طریق صفحه کلید می توانید به صفحه کامسول وارد شوید و

mailto:comsol_multiphysics@yahoo.com
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(monospace) 

font 

 

 کامسول دسترسی داشته باشید.شما ممکن است یک دستورالعمل مانند 

"enter (or type) 1.25 in the current density" 

 را ببینید.به اینگونه دستورالعمل ها و کدهای برنامه نویسی کد فونت می گویند.

Italic code 

(monospace) 

font 

 

ها می باشد که توسط کاربر وارد شده و یا مورد استفاده این فونت نشان دهنده دادها و قسمتی از نام 

 قرار گرفته است.

Arrow brackets <> following the code (monospace) or code (italic) fonts 

این فونت برای مثال ها و نمونه های برنامه نویسی کاربرد دارد و کاربر می تواند آزادانه از مطالب در 

 انتخاب یا وارد کند مانند ویژگی نام یا مطلب.به عنوان مثالرشته های مختلف را 

where <label> is the geometry’s label 

 

 گرافیکی آیکن های

از  سازمان دهی اظلاعات مورد استفاده قرار می گیرند.این آیکون ها بسیار مهم هستند ه منظوراین آیکون ها ب

 کنیم.این رو شما را به خواندن مطالب زیر دعوت می 

 توضیحات نام آیکن

 
Caution  این آیکون جهت تذکر به کاربر می باشد و به کاربر متذکر می شود که کلیه مراحل فرآیندی را

با دقت انجام دهد و مرحله به مرحله جلو رود.هم چنین وجود این آیکون می تواند به این 

ه مشکلی به ئلنیازدارد و یا در حل مسمنظور باشد که برای انجام فرآیند به یک دستورالعمل 

 وجود امده باشد.

 
Important  این آیکون اطلاعات کلیدی برای مدلسازی و طراحی و حل به ما ارایه می دهد. این اطلاعات

بسیار با اهمیت تر از یک یادداشت معمولی می باشند و کاربر باید از این دستورالعمل ها 

 پیروی کند.

 

 
Note ته باشید این آیکون اطلاعاتی را جهت استفاده در اختیار کاربر قرار می دهد و توصیه توجه داش

 ما بر این است که مظالب این قسمت خوانده شود.

 

 
Tip  این آیکون کلیه اطلاعات و تذکرات و کلیدهای میانبر و پیشنهادات خود را برای بهبود طراحی

 باشد را ارایه می دهد.مدل و سایر اطلاعات که ممکن است مفید 
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See Also  اگر به صورت آنلاین در حال کار هستین با کلیک بر رویhypelink  مستقیم به بخش

 اطلاعات می رود.

 

 
An example 

from the 

Application 

Libraries 

 

ها از این آیکون برای استفاده از اسناد موجود در کامسول استفاده می شود.مثال ها و نمونه 

 زمانی قابل استفاده هستند که شما لایسنس یا مجوز برای آن ماژول خاص را دارا باشید .

 
 Space 

Dimension 

 

سه بعدی استفاده می شود.از -دو بعدی-از این آیکون جهت ساختن مدل در فضای یک بعدی

ه ئلمس له و اطلاعاتئفضای یک بعدی معمولا استفاده نمی شود.و باید متناسب با فیزیک مس

 محیط را انتخاب کنیم.

1D axial symmetry , 2D , 2D axial symmetry, and 3D  

 

Windows .نشان می دهد اطلاعات مختص سیستم عامل ویندوز ماکروسافت است 

 

 

Mac 

 

 نشان میدهد که اطلاعات مختص سیستم عامل مک می باشد.

 

 

Linux عامل لینوکس می باشد. نشان می دهد که  اطلاعات مختص سیستم 

 

 (Overview of the Reference Manual) مرور کلی بر کتابچه راهنما

 (ENVIRONMENT)محیط 

بخش محیط مدل سازی کامسول این امکان را فراهم می کند که یک بررسی کلی از محیط مدلسازی کامسول و 

کنترل آن از طریق دسکتاب کامسول یا ابزارها و پنجرها در نسخه ویندوز و هم چنین نسخه کراس پلت فرم را 
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(، پنجره نرم افزار The COMSOL Desktop)موضوعات این بخش شامل دسکتاب کامسول  فراهم می کند.

 Model Wizardبا استفاده از  فیزیکی ایجاد و رابط های (، The Application Libraries Windowکتاب خانه)

 و ... می باشد.

 

 (MODELINGمدلسازی )

و معرفی  شرح در این قسمت توضیحاتی در مورد روش ها و موضوعاتی شامل مسایل زیر داده می شود.

شرایط مرزی و .... مورد بحث قرار  –تجزیه و تحلیل مدلها و دقت مدل ها -انتخاب رابط های فیزیکی-مدلسازی

 می گیرد.

 

 (CUSTOMIZING THE COMSOL DESKTOPکامسول دسکتاب سفارشی )

تنظیمات عملکردی و جزییاتی در مورد  و تغییراتاختصاصی سازی مدل در این بخش تنظیمات مربوط به 

( بحث Results Sections(، و نمایش نتایج بخش ها )Study(مطالعات )Advanced Physics)فیزیک پیشرفته 

 می شود.

 

 (DEFINITIONSتعاریف )

متغیرهای –این بخش ویزگی های ساختاری را توصیف می کند .مباحث در این بخش عبارتند از توابع و مثلثات 

 خواص تودها و توابع کوپلینگ  و ... –از پیش ساخته و تعریف شده 

Operators, Functions, and Constants, Predefined and Built-In Variables, Mass Properties, 

Functions, Component Couplings and Coupling Operators, Coordinate Systems, Identity and 

Contact Pairs, Probes, and Infinite Elements and Perfectly Matched Layers. 

 

 (VISUALIZATION AND SELECTION) تصویرپردازی و انتخاب

 مدل  و کنترل مدل و چگونه دیدن و انتخابصویرپردازی این بخش در مورد ابزارهای مورد استفاده برای ت

مهم ترین موضوعات این بخش عبارت و تنظیمات پنجره شرح می دهد.  گرافیکی نرم افزار درپنجره  هندسی

 تعریف شده توسط کاربر است.انتخاب نام و نمایش موارد  –کار با بخش های هندسی  است از

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.02.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.17.html
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 (GEOMETRYهندسه )

این بخش تمامی مراحل ساخت یک مدلدر مختصات فضایی یک بعدی، دو بعدی و سه بعدی و عملیات مربوط 

و خروجی گرفتن از مدل هندسی را توضیح می دهد.  DCAبه ساخت مدل هندسی و همچنین نحوه وارد کردن 

: ایجاد یک مدل هندسی برای آنالیز ، نحوه کار با ابزار های هندسی و..  مهمترین عناوین این بخش عبارتند از

 می باشد.

 

 (MESH) مش

در این قسمت خلاصه ای از نحوه ایجاد و کنترل مش در مختصات فضای یک بعدی، دو بعدی و سه بعدی 

عبارت است از : هندسه ترسیم شدهدر نرم افزار توضیحاتی ارائه شده است. مهمترین قسمت های این بخش 

(، Meshing Techniques(، تکنیک های مش بندی )Creating a Mesh for Analysisایجاد مش جهت آنالیز )

(، و وارد کردن وخروجی گرفتن از Meshing Operations and Attributesویژگی ها و عملکردهای مش بندی )

 می باشد. (Importing and Exporting Meshesمش ها )
 

 

 (MATERIAL) مواد

نحوه  انتخاب و تعریف مش در نرم افزار کامسول توضیحاتی ارائه  شده است که مهمترین در این بخش در مورد 

 Materialمرجع مشخصات مواد ) (،Working with Materialsعناوین این بخش عبارتند از :  کار با مواد )

Properties Reference( نحوه تعریف مواد در کتابخانه مواد ،)User-Defined Materials and Libraries ،)

 Module-Specific( و ماژول دیتابیس مواد مخصوص )Using Functions in Materialsاستفاده از توابع مواد )

Material Databases.می باشد ) 

 

 () DC AC/ ماژول

انواع  داده شده است که با استفاده از این ماژول کاربرمی تواند شرح  DC AC/ فیزیکی رابط، در این بخش

در زمینه  اساسیاصول  و  تئوری این بخش درباره  در همچنین ی را مدلسازی کند.الکترومغناطیس جریانهای

 .الکتریکال توضیحاتی داده شده است.
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 () Acoustics  آکوستیک

 Pressureتوضیحاتی در مورد ماژول آکوستیک و چگونکی کاربرد آن در فشار آکوستیکی ) این بخشدر 

Acoustics( رابط دامین فرکانسی ،)Frequency Domain interface توضیحاتی ارائه شده است. همچنین  ،)

 کاربر می تواند با استفاده از این رابط فیزیکی مدلسازی و شبیه سازی انواع آکوستیک و ارتعاشات را انجام دهد.

 

 () Chemical Species Transport ماژول انتقال جرم

انواع مدلسازی و شبیه سازی پدیده های انتقال جرم از طریق نفوذ و   با مطالعه این بخش کاربر می تواند

  را انجام دهد. (Fickبر اساس قانون فیک )جابجایی، 

 

 () Fluid Flow ماژول جریان سیال

کاربر با مطالعهاین بخش می تواند انواع  را توضیح می دهد.سیال جریان  رابطاین قسمت چگونگی استفاده از 

 مدلسازی و شبیه سازی مکانیک سیالاتی جریان ها را انجام دهد.

 

 ()  Heat Transfer ماژول  انتقال حرارت

انتقال حرارت )انتقال حرارت در جامدات و  توضیحاتی در مورد انواع مختلف رابط های فیزیکی این بخشدر 

  ارائه شده است. ژولحرارتی  رابطو   سیالات(

 

 ()  Solid mechanics  ماژول مکانیک جامدات

می تواند فیزیکی  را شرح می دهد ،کاربر با مطالعه این رابط جامداتی مکانیکرابط این بخش چگونگی کاربرد

 ی مانند تحلیل تنش را انجام دهد.مکانیک جامدات هایآنالیز مدلسازی و شبیه سازی انواع 
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 ()  Equation-based modeling مدلسازی ماژول معادلات

کاربر با مطالعه این بخش می دهد. را شرح میدر مدلسازی بر پایه معادلات  ریاضی رابطاین بخش کاربرد در 

( و سایر sODE(، معادلات دیفرانسیل مرتبه اول )PDEsتواند بر حسب نیاز انواع معادلات مشتقات جزئی )

 خود افزوده و یا مدلسازی وحل نماید.معادلات ریاضی را به به مدل 

 

 () Sensitivity analysis  آنالیز حساسیت

بهینه  به منظور )Senstivity interfaceحساسیت ) رابط و کاربردآنالیز حساسیت  استفاده از این بخش چگونگی 

 را شرح می دهد.سازی 

 

 () Deformed Meshesماژول تغیرشکل مش ها 

 اصول بحاوی مطال همچنینکنترل تغییرمش در مدلسازی را شرح می دهد. فیزیکی  رابطکاربرد در این بخش 

-لاگرانژی دلخواه متد برای فرمولاسیون، اینو چهارچوب  اولر –اساسی درباره ی فرمولاسیون فیزیکی لاگرانژ 

 .می باشد (ALE) اویلری

 

 (Studies and solverمطالعات  و حل )

مراحل  کامسول می باشد وانواع مختلف حل کننده ها و مطالعات در زمینه ی نرم افزار  شامل  این قسمت

 ,batch jobsتنظیمات:  ( و major solversهای اصلی ) حل کنندهحل کننده ها همچنین  مطالعه و پیکربندی

parametric sweeps   وcluster computing .شرح داده شده است 

 (Results and Visuallzationتصویر پردازی ونتایج )

ابزار های مختلفی جهت تصویر پردازی و  کمک کرده و Comsolاین قسمت به شما در آنالیز نتایج در نرم افزار 

گرافیک های پیشرفته و نمایش اطلاعات و دراختیار کاربر قرار می دهد، این ابزارها عبارتند از:  ارزیابی نتایج

 کلی به ترتیب زیر می باشد.شامل قسمت های  و میدهد. باشد را ،شرح می خروجیتوابع 
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 Plot Groups andنمودارهای گروهی ) ، (Data Sets) ،تنظیم داده ها(Results Overview) خلاصه نتایج

Plots،) ( مشتق مقادیر و جداولDerived Values and Tables،)  داده های خروجی و تصاویر (Exporting 

Data and Images( گزارش گیری ،)Reports( و پرینت و عکس از صفحه نمایش )Printing and Capturing 

Screenshots ) 

 

 (Running Comsolکامسول درحال اجرا )

کامسول به علاوه ی رابط کاربر بر روی کامپیوتر (نرم افزار Runاجرا کردن) روش های مختلفاین قسمت شامل 

 محاسبات ابری می باشد.اختصاص داده شده،شامل کلاینت/ سرور و  معماری حافظه و 
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The COMSOL Modelمحیط مدلسازی کامسول )-5 i ng Envi ronment) 

 Alilotfalianmut@yahoo.comپست الکترونیکی:                                تهیه کننده:  علی لطفعلیان      

 

نمایش مدل های  و تحلیل، و تجزیه ایجاد، ای برای یکپارچه و کامل سازی مدل محیط یک نرم افزار کامسول 

 COMSOLسازی نرم افزار  مدل محیطبر  کلی مرور بخش این مولتی فیزیکی و کاربردی می باشد. در

Multiphysics  که در اینجا به آن پنجره کامسول(COMSOL Desktop  )ها و همچنین ابزار و می گوییم 

 های آن خواهیم پرداخت. پنجره

 (The COMSOL Desktopپنجره کامسول )

به صورت یکپارچه در  در این بخش خلاصه ای از قسمت های اصلی محیط کامسول ارایه می شود. این بخشها

( می باشند  و برحسب نیاز کاربر قابلیت شخصی سازی به صورت دلخواه COMSOL Desktopنرم افزار کامسول )

 را دارند. در شکل زیر قسمت های مختلف نرم افزار نشان داده شده است.

 

، پنجره تنظیمات (  Model Builderپنجره های موجود در نرم افزار عبارت است از: پنجره ساخت مدل)

(Settings windows)( پنجره گرافیکی  ،Graphics windows) کاربر برحسب فضای مورد نیاز برای کار در نرم ،
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افزار می تواند اندازه پنجره ها را تغییر دهد، همانطور که در شکل زیر نشان داده شده است، با کلیک بر روی 

به هر طرف فضای هر پنجره را تغییر دهید.  (Click and Drag)خط جدا کننده بین دو پنجره و کشیدن آن

 چنانچه تغییراتی در ابعاد پنجره ایجاد کنید این تغییرات در دفعات بعدی استفاده از نرم افزار اعمال می گردد.

 

، پنجره در گوشه میزکار  Toggle hideبا کلیک بر روی آیکن مثلثی شکل موجود در گوشه هر پنجره و انتخاب 

کلیک کرد. کوچک کردن پنجره امکان نمایش هر پنجره  مینیمایز می شود، و یا میتوان بر روی علامت آن 

درکل صفحه نمایشگر را ایجاد می کند. بخصوص در مواقعی که کاربر نیاز دارد نتایج گرافیکی را در ابعاد 

بر روی گوشه کناری صفحه نمایش  پنجره مورد نظر را انتخاب  بزرگتری مشاهده کند. برای بازگرداندن پنجره،

 کلیک کند. در شکل های زیر نحوه مینمایز کردن پنجره نشاندادهشده است. کرده و بر روی علامت آن 
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برای نمایش هر پنجره در کل صفحه نمایشگر با کلیک بر روی آیکن مثلثی شکل موجود در گوشه سمت راست 

کلیک کنید، برای بازگشت به  maximizeآنرا از میزکار جدا کرد و بر روی آیکن  floatهر پنجره و انتخاب 

به حالت اولیه بازگشت. اینکار برای سیستم عامل  dockحالت اولیه با راست کلیک بر روی پنجره و انتخاب 

پنجره جدا می شود و نیز برای بازگشت  detachویندوز است و برای مک و لیتوکس با راست کلیک و انتخاب 

 کرد به جای دلخواه انتقال داد. dragمیتوان آنرا 

  

پنجره های جدا شده را در محل  (،POSITION GUIDESبرای کاربران ویندوز میتوان با استفاده از جهت نما)

 دلخواه قرار داد.برای اینکار بر روی پنجره کلیک کنید و نگه دارید تا علامت مشابه شکل  زیر ظاهر شود
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کنید، با رفتن بر روی هر پنجره که از قبل بر روی میز کار وجود   dragسپس پنجره را بروی محل مورد نظر 

برو روی هرکدام  جره وسط انتخاب میشود ، با انتقال علامت مربوط به مووسداشته است آن پنجره به عنوان پن

 از علامت ها میتوان پنجره را در محل دلخواه چسباند

 

 

 جابجایی و مینیمایز و ماکسیمم کردن پنجره های برای کاربران مک و لینوکس

بروید، سپس مووس را بر محل Move>View  رمسی بهبرای جابجایی پنجره بروی سربرگ آن کلیک راست کنید و 

بروید و موس را بر محل    Move>Tab Groupبرای جابجایی چند پنجره از مسیر  دلخواه ببرید و کلیک کنید.

برای تغییر سایز بر روی هریک از گوشه  دلخواه ببرید و کلیک کنید تا پنجره ها به صورت گروهی جابجا شوند.
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و   ,Size>Left, Rightکردن سایز آنرا تغییر دهید و یا با کلیک راست   از مسیر  Dragها دبل کلیک کنید و با 

Top, or Bottom   ،.برای ماکسیمم شدن دوباره،  بر روی سربرگ پنجره  دابل کلیک  تغییر سایز را انجام دهید

 کنید و برای بازیابی دوباره بر روی مجددا دابل کلیک کنید.

را  Maximize یا        Minimizeراست گزینه  -برای ماکسیمم و مینیمم کردن می توان در قسمت گوشه  بالا

انتخاب کنید. برای پنجره هایی که مینیمایز شده اند)در گوشه سمت چپ میز کار قرار میگیرند( ، میتوان با 

 ایز شدن  افقی یا عمودی  انتخاب کرد.کلیک بر روی آنها و مسیر مشابه شکل زیر، جهت نمایش آن پس ماکزیم

 

 (Ribbon display)تغییرات در نوار نمایش

در سیستم عامل ویندوز، تغییر اندازه پنجره کامسول باعث عدم نمایش برخی نوار ابزارهای آن پنجره می شود 

این ابزارها در  در نوار نمایش    Model Builderجهت سهولت و دسترسی به کلیه ابزار های موجود در پنجره 

 گنجانده شده است. در شکل زیر نوار نمایش سیستم های عامل ویندوز، مک و لینوکس نشان داده شده است.
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 ساختن اپلیکیشن  

و به بالای نرم افزار کامسول این قابلیت وجود دارد، که کاربر می تواند از مدلسازی و شبیه  1در ورژن های 

شده، یک اپلیکیشن )درون برنامه ای( ایجاد کند، به این منظور به طور مستقیم از پنجره کامسول سازی انجام 

کلیک کند، تا به صفحه ساخت و ویرایش منتقل شوید.   (APPLICATION BUILDERبر روی آیکن اپلیکشن ساز)

که در محیط اپلیکشن ساز نیز این کار را انجام داد. هنگامی  Ctrl+Alt+Aهمچنین از طریق کلید های میانبر 

به محیط کامسول بازگردید، اینکار از طریق کلید های  Model builderهستید می توانید با کلیک بر روی 

در شکل زیر یک نمونه از اپلیکشن ساخته شده که در مدل کتابخانه   نیز امکان پذیر است. Ctrl+Alt+Mمیانبر 

 .ای نرم افزار وجود دارد نشان داده شده است

 

 

 برخی  ویژگی های پنجره کامسول 

در ادامه به بررسی جابجایی بین بخش های مختلف کامسول ، شامل پنجره ها و گره ها می پردازیم. با کلیک بر 

پنجرهتنظیمات آن ظاهر می شود و کاربر می تواند بر حسب نیاز   Model Builderروی هر گزینه موجود در 

 تنظیمات لازم در  هر قسمت را ااعمال کند.
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با انتخاب هر گزینه های در هر گره آن گزینه پر رنگ می شود. با کلیک راست بر روی هر گزینه جابجایی، کپی، 

 گزینه ها موجود است.  حذف تغییرنام و .. امکان پذیر است.  این ویژیگی برای تمامی

 زبان نوشتاری فارسی پشتیبانی می کند وکاربر می تواند برای هر گره نام دلخواه فارسی اختصاص دهد.از : نرم افزار کامسول نکته

 
 

 به منظور باز کردن شاخه ها و دیدن سایر گره های درون شاخه بر روی مثلث سفید کوچک چپ کلیک کنید. 

 

و برای برگشت به پنجره قبلی )برعکس  Ctrl+Tabجهت حرکت بین پنجرههای مختلف از کلید های میانبر 

 استفاده می شود. Ctrl+Shift+Tabکلیدهای قبلی( ازکلید های میان بر 
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 میزکار کامسول و نوار ابزار-6

 majedenouri@gmail.comپست الکترونیکی:                                      زادهتهیه کننده: ماجده نوری 

 

در سیستم عامل های مختلف اندکی تغییر می کند. اگرچه، تغییرات دسترس کامسول، منوها و نوارهای ابزار در 

 Crossو  Windows Toolbars and Menusهای نامحسوس و عملکرد کلی آنها یکسان می باشد.  قسمت 

Platform (Mac and Linux) Toolbars and Menus  مثال هایی از بخش ها و موقعیت های  اصلی نوار ابزار و

سیستم عامل ها )پلت فرم ها( برای تمامی  The Model Builder Toolbarنوار ابزار  منوها را نشان می دهد. 

 یکسان می باشد و در این بخش توضیح داده شده است. 

 MODEL BUILDERنوارابزار

های  مکان آن همانگونه که در شکل برای تمامی سیستم عامل ها یکسان می باشد.  Model Builderنوار ابزار 

 قرار گرفته.  نشان داده شده، در بالای پنجرهزیر 

 

 برای ویندوز )شکل راست( مک و لینوکس )شکل چپ( Model Builder نوارابزار

 

 

 نوارابزار و منوهای ویندوز

گزینه های موجود نوار ابزار؛ بسته به اینکه شما در کجای مدل در حال کار کردن هستید و آنچه که به طور 

( ساخته blank model) خالیمنطقی برای یک فعالیت در دسترس است، پویا می باشند. هنگامی که یک مدل 

در نوار ابزار قابل ( Model, Definitions, Study, and Resultsفقط  سربرگ های پیش فرض ) می شود،

هنگامی اضافه می شوند که یک مدل و رابط  Meshو  Physics ، Geometryسربرگ های مشاهده خواهند بود. 

میزکار بالای در  همانطور که در شکل زیر  نشان داده شده است،اضافه شده باشند.  Model Wizardفیزیکی به 

در پایین آن روبان گزینه ها  ( می باشد.Quick Access Toolbar)نوارابزار دسترسی سریع قابل تنظیم کامسول، 

 می شود. گفته( toolbarsو روبان گرافیکی می باشد که به کل این مجموعه، نوارابزارها )

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.07.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.08.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.08.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.08.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.06.html#1439308
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توانید نین می ( می تواند در موقعیت بالا یا پایین روبان ها قرار بگیرد. شما همچQuick Access Toolbar) نوارابزار دسترسی سریع

 .انواع گزینه ها تنظیم کنید یا اضافه کردن حذف نوارابزار را برای

 

 (Quick Access Toolbar)نوارابزار دسترسی سریع  شخصی سازی

که می توانند در بالا یا پایین روبان نمایش داده شوند.  ،است ختلفینوارابزار دسترسی سریع دارای گزینه های م

یع  کلیک کنید. شما به منظور شخصی سازی نوارابزار دسترسی سربر روی پیکان کوچک در انتهای نوارابزار، 

همچنین می توانید هرکدام از گزینه های پیش فرض نمایش داده شده را مستقیما از لیست ویرایش کنید، یا بر 

دکمه ها کلیک کنید. در شکل زیر قسمت های مختلف برای اضافه یا حذف کردن  More Commandsروی 

 نشان داده شده است. More Commandsاین ابزار  به همراه پنجره 
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 Show Quickروی روبان کلیک راست کنید تا ، بر جهت نمایش نوارابزار دسترسی سریع در بالا یا پایین روبان

Access Toolbar Above the) Ribbon)  یا(Show Quick Access Toolbar Below the Ribbon)  را انتخاب

برای کنید. این گزینه ها همچنین از منوی شخصی سازی نوارابزار ذسترسی سریع در دسترس می باشند. 

. برای تا نوار در میزکار مخفی شود خاب کنیدنترا ا ((Minimize the Ribbon ،گزینه کوچک ساز نوارابزار

کلیک  Minimize the Ribbonبرگرداندن روبان به حالت قبل، در هر جایی در بالای پنجره کلیک کنید و روی 

 کنید تا غیرفعال شود)علامت تیک را بردارید(
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 ویژگی آیکن های نوارابزارها  و منوها

است عنوان شده  شده است. همانطور کهداول زیر توشیح داده در ج در حالت کلی، گزینه ها یا ویژگی های منو،

ممکن است تغییراتی داشته ویندوز و چندپلتفرمی )مک و لینوکس(  عامل  سیستم های در محل این آیکن ها

 باشند.در شکل زیر نوار ابزار ها و منو ها  در سیستم عامل مک ولینوکس نشان داده شده است.

 

 

 

 

 

 

 (Creating Modelsایجاد مدل )

 توضیحات نام آیکن

 
New 

(Ctrl+N) پنجره جدید را باز کنید تا مدلسازی را با استفاده از Model Wizard  یا

Blank Model  کنید. برای تمامی کاربران، این قسمت از منوی را شروع

File  در دسترس است.همچنین از قسمتQuick Access Toolbar  برای(

پلتفرمی( نیز در -کاربران چندکاربران ویندوز( و یا منوی اصلی )برای 

 دسترس می باشد.

 
Blank 

Model 
( بدون هیچ تنظیماتی را آغاز می کند. این blank modelیک مدل خالی)

در دسترس خواهد بود. همچنین در  File>Newفرمان بعد از انتخاب 

( یزاس کاربران  Quick Access Toolbar) نوارابزار دسترسیقسمت 

 است.ویندوز در دسترس 
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 توضیحات نام آیکن

 
Application 

Builder 

(Ctrl+Alt+A) 

 COMSOL Multiphysics Modelو Application Builder جهت انتقال به محیط اپلیکشن ساز

Builder windows  نوارابزار . برای کاربران ویندوز این قسمت از از این آیکن استفاده می شود

 ( در دسترس است.homeاصلی )

 
Model Data 

Access 

رای کاربران ویندوز، این گزینه در که قابل اصلاح می باشد. ب form objects ی تنظیماتی انتخاب

  در دسترس می باشد.  Home ابزار نوار

 
Record a 

New Method 

. برای را امکان پذیرمی سازد.در یک متد جدید  قرا گرفتهتغییرات اعمال شده بر مدل ضبط کلیه 

 .در دسترس می باشد Home ابزار کاربران ویندوز، این گزینه ازنوار

 
Test 

Application 

(Ctrl+F8) 

برای  گانه با استفاده از این گزینه امکان پذیر می باشد.پنجره جد ساخته شده دراپلیکیشن  نست

 و نوارابزار دسترسی سریع در دسترس می باشد. Home کاربران ویندوز، این گزینه ازنوارابزار

 
Run 

Application 

برای .Application Builder .(*.mphapp files)اجرای یک برنامه ی ایجاد شده با استفاده از 

نوارابزار دسترسی در دسترس است. همچنین از قسمت  Fileتمامی کاربران، این قسمت از منوی 

 پلتفرمی( در دسترس می باشد.-سریع )برای کاربران ویندوز( یا منوی اصلی )برای کاربران چند

 

 Application Builderکار با 
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 توضیحات نام آیکن

 
New 

(Ctrl+N) پنجره جدید را باز کنید تا مدلسازی را با استفاده از Model Wizard  یاBlank Model  را شروع

 Quickدر دسترس است.همچنین از قسمت  Fileکنید. برای تمامی کاربران، این قسمت از منوی 

Access Toolbar پلتفرمی( نیز در -)برای کاربران ویندوز( و یا منوی اصلی )برای کاربران چند

 دسترس می باشد.

 
Run 

Application 
برای .Application Builder .(*.mphapp files)اجرای یک برنامه ی ایجاد شده با استفاده از 

نوارابزار دسترسی در دسترس است. همچنین از قسمت  Fileتمامی کاربران، این قسمت از منوی 

 پلتفرمی( در دسترس می باشد.-سریع )برای کاربران ویندوز( یا منوی اصلی )برای کاربران چند

 
Open 

(Ctrl+O) 

در  Fileبرای تمامی کاربران، این قسمت از منوی  باز کردن یک فایل موجود در کامپیوتر.

)برای کاربران ویندوز( و یا منوی اصلی  نوارابزار دسترسی سریعدسترس است. همچنین از قسمت 

 پلتفرمی( نیز در دسترس می باشد.-)برای کاربران چند

 
Recent files  را برای باز کردن انتخاب می کند. برای کاربران انجام شده است  اخیر  که فایل یک فایلاز منوی

-crossانتخاب می شود. برای کاربران چند پلتفرمی ) Recent ویندوز، فایل از طریق زیرمنوی

platform.کاربران ویندوز همچنین می توانند  ( فایل های اخیر در پایین لیست قرار می گیرند 

 را برای دسترسی به این گزینه شخصی سازی کنند. زار دسترسی سریعنواراب

 fileقمست های مختلف 
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Application 

Libraries 

در دسترس  fileدر منوی ویندوز یا منوی  homeبرای کاربران ویندوز این قسمت از نوارابزار 

را شخصی سازی کنید سپس روی دکمه  نوارابزار دسترسی سریع است. شما همچنین می توانید 

 در دسترس است. Fileپلتفرمی ، این قسمت از منوی -کلیک کنید.برای کاربران چند

 
Open 

Recovery 

File 

تمامی فایل هایی که تا کنون انجام دادید را در حافظه خود نگهداری می کند و کاربر کامسول 

این یک تنظیمات اولیه است که بازیابی وحل کند.می تواند با انتخاب این گزینه آن فایل ها را 

در دسترس  Fileبصورت پیش فرض فعال می باشد. برای تمامی کاربران، این قسمت از منوی 

شخصی سازی شده)برای کاربران ویندوزدر  نوارابزار دسترسی سریعاست. همچنین از قسمت 

 دسترس می باشد.

 
Save (Ctrl+S)  فایل فعلی را ذخیره می کند. برای تمامی کاربران، این قسمت از منویFile  .در دسترس است

)برای کاربران ویندوز( یا منوی اصلی )برای کاربران  نوارابزار دسترسی سریعهمچنین از قسمت 

 پلتفرمی( در دسترس می باشد.-چند

 
Save As  هایفایل انجام شده در فرمت برای ذخیره سازی 

 مختلف از این گزینه استفاده می شود. فرمت های 

 موجود در این قسمت همانند شکل زیر می باشد. 

ابزار  نواردر دسترس است. همچنین از قسمت  Fileبرای تمامی کاربران، این قسمت از منوی 

 )برای کاربران ویندوز( در دسترس می باشد. دسترسی سریع

 
Revert to 

Saved 

برای تمامی می باشد.  GUIآن بصورت اولیه  باز کرد جهت باز کردن آخرین فایل ذخیره شده و 

 نوارابزار دسترسی سریعدر دسترس است. همچنین از قسمت  Fileکاربران، این قسمت از منوی 

پلتفرمی( در -شخصی سازی شده )برای کاربران ویندوز( یا منوی اصلی )برای کاربران چند

 دسترس می باشد.

 
Compact 

History 

، از جمله وارد شده است پیشینه ی مدلدر  جاوا یا متلب با فرمت های فایل هایشامل 

 شوند. تنظیماتی که دیگر بخشی از مدل نمی باشند یا اپلیکیشن ها  را شامل می
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نوارابزار در دسترس است. همچنین از قسمت  Fileبرای تمامی کاربران، این قسمت از منوی 

 شخصی سازی شده )برای کاربران ویندوز( در دسترس می باشد. دسترسی سریع

 
Licensed and 

Used 

Products 

جهت  مشاهده لایسنس نرم افزار اینکه شامل کدام ماژولهامی باشد و تنظیمات آناز این گزینه 

در دسترس است.  شما  fileاستفاده می شود. برای کاربران ویندوز، این قسمت از منوی 

همچنین می توانید  نوارابزار دسترسی سریع را شخصی سازی کنید سپس روی دکمه کلیک 

 در دسترس است. Optionsپلتفرمی ، این قسمت از منوی -ن چندکنید. برای کاربرا

 
Preferences   ،با استفاده از این گزینه کاربر می تواند تنظیمات کلی نرم افزار را انجام دهد.برای کاربران ویندوز

در دسترس است.  شما همچنین می توانید  نوارابزار دسترسی سریع را  fileاین قسمت از منوی 

پلتفرمی ، این قسمت از -شخصی سازی کنید سپس روی دکمه کلیک کنید. برای کاربران چند

 در دسترس است. Optionsمنوی 

 

 
 توضیحات نام آیکن

 
Connect to 

Server 

جهت اتصال نرم افزار دسکتاب  به یک سرور از این گزینه استفاده می شود. برای تمامی کاربران، 

در دسترس می باشد. همچنین از قسمت نوارابزار  File> Client Server این گزینه از منوی 

 دسترسی سریع شخصی سازی شده )برای کاربران ویندوز( در دسترس می باشد.

 
Disconnect 

from Server 

برای قطع اتصال تماس با سرور یا متلب از این گزینه استفاده می شود. برای تمامی کاربران، این 

در دسترس می باشد. همچنین از قسمت نوارابزار  File> Client Server گزینه از منوی 

 دسترسی سریع شخصی سازی شده )برای کاربران ویندوز( در دسترس می باشد.

 

 Client Server کلاینت سرور
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Import 

Application 

from Server 

 از این گزینه برای فراخوان کردن یک اپلیکیشن خاص هنگام کار کردن با متلب، اکسل، یا سایر

API  کامسول استفاده می شود.برای تمامی کاربران، این گزینه از منوی File> Client 

Server ه در دسترس می باشد. همچنین از قسمت نوارابزار دسترسی سریع شخصی سازی شد

 )برای کاربران ویندوز( در دسترس می باشد.

 
Remove 

Applications 

from Server 

 ModelUtilبرای حذف اپلیکیشن هایی )برداشتن آنها از روی سرور( که شما با استفاده از 

در دسترس می  File> Client Server ساخته اید.برای تمامی کاربران، این گزینه از منوی 

سمت نوارابزار دسترسی سریع شخصی سازی شده )برای کاربران ویندوز( در باشد. همچنین از ق

 دسترس می باشد.

 

 
 توضیحات نام آیکن

 
Connect to 

Server 

جهت اتصال نرم افزار دسکتاب  به یک سرور از این گزینه استفاده می شود. برای تمامی کاربران، 

در دسترس می باشد. همچنین از قسمت نوارابزار  File> Client Server این گزینه از منوی 

 دسترسی سریع شخصی سازی شده )برای کاربران ویندوز( در دسترس می باشد.

 
Disconnect 

from Server 

برای قطع اتصال تماس با سرور یا متلب از این گزینه استفاده می شود. برای تمامی کاربران، این 

در دسترس می باشد. همچنین از قسمت نوارابزار  File> Client Server گزینه از منوی 

 دسترسی سریع شخصی سازی شده )برای کاربران ویندوز( در دسترس می باشد.

 

 
Import 

Application 

from Server 

 از این گزینه برای فراخوان کردن یک اپلیکیشن خاص هنگام کار کردن با متلب، اکسل، یا سایر

API  کامسول استفاده می شود.برای تمامی کاربران، این گزینه از منوی File> Client 

Server  در دسترس می باشد. همچنین از قسمت نوارابزار دسترسی سریع شخصی سازی شده

 Client Server کلاینت سرور
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 )برای کاربران ویندوز( در دسترس می باشد.

 
Remove 

Applications 

from Server 

 ModelUtilبرای حذف اپلیکیشن هایی )برداشتن آنها از روی سرور( که شما با استفاده از 

در دسترس می  File> Client Server ین گزینه از منوی ساخته اید.برای تمامی کاربران، ا

باشد. همچنین از قسمت نوارابزار دسترسی سریع شخصی سازی شده )برای کاربران ویندوز( در 

 دسترس می باشد.

 

 
 توضیحات نام آیکن

 
Documentation 

(Ctrl+F1) 

جهت مشاهده اسناد در بستر کامسول دسکتاب از این گزینه استفاده می شود. برای 

در دسترس می باشد.برای کاربران  File>Help کاربران ویندوز، این گزینه از منوی 

در  help( از طریق منوی اصلی نوارابزار یا منوی platform usersچند پلتفرمی )

 دسترس است.

 
Help (F1) ن اسناد راهنمای کامسول در پنجره ای جداگانه از این گزینه استفاده می جهت باز کرد

یا گوشه سمت راست بالای  File>Help  شود. برای کاربران ویندوز، این گزینه از منوی 

( از طریق platform usersدر دسترس می باشد.  برای کاربران چند پلتفرمی ) میزکار 

 در دسترس است. helpمنوی اصلی نوارابزار یا منوی 

 
Support Center  ..جهت اتصال به مرکز پشتیبانی آنلاین در وبسایت کامسولاز اینگزینه استفاده می شود

در دسترس می باشد. برای  File>Help برای کاربران ویندوز، این گزینه از منوی 

Help( از طریق منوی platform usersکاربران چند پلتفرمی ) در دسترس است.   

  HELP هلپ 
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Training  .کاربر با انتخاب این گزینه به به صفحه ی آموزش در وبسایت کامسول متصل می شود

در دسترس می باشد. برای  File>Help برای کاربران ویندوز، این گزینه از قسمت 

 در دسترس است. Help( از طریق منوی platform usersکاربران چند پلتفرمی )

 
Check for Product 

Updates 

جهت بررسی محصولات تولیدی کامسول  از این گزینه استفاده می شود. برای کاربران 

در دسترس می باشد. برای کاربران چند  File>Help ویندوز، این گزینه از قسمت 

 در دسترس است. Help( از طریق منوی platform usersپلتفرمی )

 
Update the 

COMSOL 

Application Library 

کاربر با انتخاب این گزینه چنانچه لایسنس نرم افزار را در اختیار داشته باشد می تواند 

مدل های کتابخانه ای نرم افزار را بروز رسانی کند. برای کاربران ویندوز، این گزینه از 

 platformدر دسترس می باشد. برای کاربران چند پلتفرمی ) File>Help قسمت 

users از طریق منوی )Help .در دسترس است 

 
Update the 

COMSOL 

Part Library 

در دسترس می باشد. برای  File>Help برای کاربران ویندوز، این گزینه از قسمت 

 در دسترس است. Help( از طریق منوی platform usersکاربران چند پلتفرمی )

 
About COMSOL 

Multiphysics 

با انتخاب این گزینه کاربر اطلاعاتی در باره کامسول را مشاهده خواهد کرد. برای کاربران 

در دسترس می باشد. برای کاربران چند  File>Help ویندوز، این گزینه از قسمت 

 در دسترس است.  Help( از طریق منوی platform usersپلتفرمی )

 

  Model Builder نوار ابزار 

 
 توضیحات نام آیکن

 

 

Previous Node 

(Alt+Left)Next 

Node(Alt+Right) 

 جهت هدایت به گره ای که قبلا انتخاب شده یا گره ی بعدی از یک رشته. 
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Show  جهت نمایش و افزودن و تنظیمات گزینه های موجود درModel Builder .استفاده می شود 

 

Collapse All 

Expand All 

گزینه  کلیه قسمت های متصل به گره درختی به صورت کرکره ای  مشاهده و با کلیک برای  این 

 یا فقط گره های اصلی نمایش داده می شود.

 
Model 

Builder Node 

Label 

با انتخاب گزینه های موجود در این لیست کاربر می تواند، نام، نوع و برچسب هایی که هر گزینه 

اضافه نمایید. این برچسب ها به کاربر برای تعریف موجود در شاخه های درختی دارند، را 

 متغییرها کمک می کند.

 

Undo, Redo, Copy, Paste, Duplicate, and Delete 

 
 توضیحات نام آیکن

 

Undo (Ctrl+Z) 

Redo (Ctrl+Y) 

برای بازگرداند و یا رفتن به مرحله بعدی آخرین عملیات انجام شده از این گزینه استفاده می 

شود. برای کاربران ویندوز این قسمت  در نوارابزار دسترس سریع در دسترس است.برای کاربران 

 پلتفرمی این قسمت در نوارابزار اصلی یا از منوی ویرایش قابل دسترسی است.-چند

 
Copy  برای کپی کردن یک گزینه و یا یک عبارت از این آیکن استفاده می شود.برای کاربران ویندوز این

پلتفرمی این قسمت در -سمت  در نوارابزار دسترس سریع در دسترس است.برای کاربران چندق

 نوارابزار اصلی یا از منوی ویرایش قابل دسترسی است.

 
Paste 

برای چسباندن  یک گزینه و یا یک عبارت از این آیکن استفاده می شود. برای کاربران ویندوز این 

پلتفرمی این قسمت در -در دسترس است.برای کاربران چند قسمت  در نوارابزار دسترس سریع

 نوارابزار اصلی یا از منوی ویرایش قابل دسترسی است.

 
Duplicate  برای ایجاد گزینه  همسان  از این آیکن استفاده می شود. برای مثال می خواهید در یک مدل دو

اولی را  INTIAL VALUEداشته باشید برای اینکار گزینه  INTIAL VALUEگزینه 

دیگر به نمودار درختی افزوده می  INTIAL VALUEانتخاب کرده و با انتخاب این آیکن یک 

شود. برای کاربران ویندوز این قسمت  در نوارابزار دسترس سریع در دسترس است.برای کاربران 
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 پلتفرمی این قسمت در نوارابزار اصلی یا از منوی ویرایش قابل دسترسی است.-چند

 
Delete (Del)  پاک کردن بعضی از گره ها در طول ایجاد یک مدل. همچنین با فشار دادن دکمه یDel  یا

کلیک راست روی یک گره می توانید این گزینه را از منوی موارد انتخاب کنید.برای کاربران 

ن پلتفرمی ای-ویندوز این قسمت  در نوارابزار دسترس سریع در دسترس است.برای کاربران چند

 قسمت در نورابزار اصلی یا از منوی ویرایش قابل دسترسی است.

 

 

 

Select All 

Clear 

Selection 

در پنجره ی  geometryبرای انتخاب همه یا پاک کردن همه قسمت های انتخابی یک 

Graphics  به ترتیب بر رویSelect All  یاClear Selection  کلیک کنید. برای کاربران

پلتفرمی این -مت  در نوارابزار دسترس سریع در دسترس است. برای کاربران چندویندوز این قس

 قسمت در منوی ویرایش قابل دسترسی است.

 
Find  با انتخاب این گزینه پنجره ای باز می شود، و به کاربر این امکان را می دهد تا قسمت های

را فشار دهید. کاربران ویندوز همچنین می توانند  نوارابزار  Ctrl+Fمختلف نرم افزار جستجو کند

 دسترسی سریع را برای دسترسی به این گزینه شخصی سازی کنند.

 

 سایر

 توضیحات نام آیکن

 
Reset 

Desktop 

از این گزینه برای برگرداندن میزکار کامسول به حالت صفحه عریض یا معمولی یا بازنشاندن آن 

  Layoutدر منوی  homeبه تنظیمات پیش فرض. برای کاربران ویندوز این قسمت  در نوارابزار 

در دسترس است. شما همچنین می توانید  نوارابزار دسترسی سریع را شخصی سازی کنید سپس 

 پلتفرمی این قسمت در نورابزار اصلی از منوی-مه کلیک کنید. برای کاربران چندروی دک

Windows>Desktop Layout .قابل دسترسی است 
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 پنجره پیغامها-7

 amin_1986@live.comپست الکترونیکی:                                    معظمی       تهیه کننده: امین

)پنجره پیغامها  ، در این پنجره کلیه اطلاعات کاربردی پس از شود بصورت پیش فرض  نمایش داده می  (

ثبت می شود، و کاربر پس از انجام هر عملیات می توانید عملیات ثبت شده را مشاهده نمایید.  یعملیاتانجام هر 

 در شکل زیر این پنجره نشان داده شده است.

 

 باشد:اطلاعات این پنجره شامل موارد زیر می 

  جزئیاتی درباره باز و ذخیره کردن مدلها شامل فایلهایMPH. 

  اطلاعات در مورد موضوعاتGeometry   وارد شده با فرمت هایCAD. 

  در نوارابزارMesh  وGeometry   بر روی دکمه( )  measure   کلیک کنید تا اطلاعاتی در زمینه های زیر

)   geometric entities( و در مورد تعداد assemblyیا  union) شکل دادن  geometryمشاهده کنید: اتمام 

 . تعداد المانهای مش و درجه های آزاد در مدل. geometryدامنه، مرزها و ...( در به پایان رساندن 

 ..مدت زمان حل مسئله 

 .پیغام های خطا. این پیغام ها بصورت ترتیبی هستندو می توان آنها را مشاهده کرد 

 ن پنجره پیغام ها  در سیستم عامل های مختلف می توان به صورت زیر عمل کرد.برای بازکرد

  از نوار ابزارHome  کاربران ویندوز( مسیر (windows>>messages  
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 windows>>messagesاز منوی اصلی ) کاربران مکینتاش و لینوکس ( مسیر 

) clearبرای پاک کردن پنجره تمام پیغامها ، دکمه   را کلیک کنید . (

 

 درباره فرمت های مدل کامسول

ها، فایل های  applicationبرای مدلها و  MPHدر زیر لیستی از فرمت های کامسول یافت میشود: فایل های  

 .VBAمدل برای جاوا، فایلهای مدل برای متلب، و فایلهای مدل برای 

 

 rootگره 

) rootوقتی که در ابتدا یک مدل جدید را باز یا ایجاد می کنید، گره  در بالاترین نقطه درخت قرار دارد.   (

شناخته می شوند . زمانیکه کاربر مدل انجام  Untitled.mphبصورت پیش فرض، فایل های بدون نام بصورت 

 کند.  تغییر می rootشده را با یک نام ذخیره کند، این نام در بالای گره 

 

 کامسول MPHفایلهای 

ذخیره می شوند. این فایل ها شامل اطلاعات باینری و  mph.فایلهای استاندارد بصورت پیش فرض با پسوند 

متنی می باشند. اطلاعات مش و حل بصورت باینری ذخیره می شوند، در حالیکه سایر اطلاعات بصورت متن 

 ساده ذخیره میشوند.
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ها در کتابخانه کامسول در  applicationرا ذخیره و بازیابی کنید. تمام  MPHشما به سرعت می توانید فایلهای 

 درکتابخانه میتوانند دو نمونه باشند: MPHذخیره شده اند. فایلهای  MPHماژولها بصورت فایلهای 

ظاهر  این فایلها با آیکون  applicationکه شامل تمام مشها و حل ها. در پنجره کتابخانه  MPHفایلهای 

و اندازه فایل زمانیکه نشانگر  "large file"با متن  tooltipتجاوز کند، یک  25MBمیشوند. اگر حجم  فایلها از 

 ببرید ظاهر می شود. applicationخود را روی گره مورد نظر در درخت کتابخانه 

کمی  MPHون مش و اطلاعات حل به منظور ذخیره)فایلهای فشرده شامل تمام تنظیمات اما بد MPHفایلهای 

فشرده شده حل را به دلایل دیگری ندارند(  فضا ساخته شده اند. شما می توانید اینها را به منظور بررسی 

اکثر آنها با –با مش و حل –تنظیمات و مش بندی و حل مجدد آن باز کنید. همچنین امکان دانلود ورژن کامل 

مشاهده  این با یک آیکون  applicationوجود دارد. در کتابخانه  Applicationکتابخانه به روزرسانی 

 Noببرید، یک پیغام  applicationمیشود.اگر شما نشانگر خود را بر روی فایل فشرده در پنجره کتابخانه 

solutions stored   ظاهر  میشود. اگر یک فایلMPH متن گره متناظر  کامل برای دانلود موجود باشد، منوی

)  Download File With Solutionشامل آیکون   می باشد. (

 

 قفل کردن فایل

را باز و ویرایش کند. اگر شما تلاش می کنید تا یک فایل   MPHفقط یک کاربر میتواند در یک زمان یک فایل 

MPH  فایل   که توسط شخص دیگری بازشده است را باز کنید، آنMPH  قفل شده است و شما یه گزینه برای
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( دارید. این بدان معناست که شما میتوانید click Open As Read-Only)  read onlyباز کردن آن بصورت مد

قفل  MPHمدل را ویرایش کنید اما امکان ذخیره تا زمانیکه با یک اسم دیگر باشد وجود ندارد. وقتی یک فایل 

میسازد که در همان  Lock.بعلاوه پسوند  MPHبا اسم مشابه بعنوان فایل  باشد،کامسول یک فایل قفل مجزا

های  sessionقفل شده نگهداری میشود. اگر فایل قفل شده بعد از اتمام کلیه  MPHآدرس بعنوان فایل 

انیکه کامسول )زمانی اتفاق می افتد که کامسول به شکلی غیر استاندارد بسته شود(  باقی ماند، شما میتوانید  زم

 . reset lock and openفایل را در مراجعه بعدی باز میکنید قفل را بازیابی کنید با کلیک بر روی 

 

لینوکس و مکینتاش فایلهای قفل سیستم عامل را پششتیبانی نمی کنند. در آنها قفل کردن به منظور 

اما امکان ردکردن قفل فایل و حذف کمک به کاربر برای دوری از ویرایش فایل نمونه یکسان پشتیبانی می شود، 

 قفل فایلها موجود می باشد.

 

 فایلهای مدل برای جاوا 

قابل ویرایش که شامل دنباله دستورات کامسول با کد جاوا هستند. شما می توانید این فیلهای  scriptفایل های 

 textرا در ویرایشگر متنی ) مجزا اجرا کنید ویرایش .فایلها applicationجاوا را گردهم آورده و بعنوان یک 

editor.به منظور اضافه کردن دستورات انجام می گیرد ) 
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 فایل های مدل برای متلب

( ، مشابه فایلهای مدل برای جاوا،  برای استفاده M-filesفایلهای مدل برای متلب فایل های متنی قابل ویرایش )

میباشد. شما  M-fileدستورات کامسول بعنوان یک با متلب هستند. یک فایل نمونه برای متلب حاوی ترتیب 

دیگر اجرا کنید. شما همچنین میتوانید فایل ها  M-fileمیتوانید این فایلهای نمونه را در متلب مانند هر ساختار 

 را در ویرایشگر متنی برای اضافه کردن دستورات کامسول یا دستورات دیگر متلب ویرایش کنید.

 برای متلب میباشد.  ™LiveLinkنیازمند  M-fileدر فرمت اجرای فایلهای نمونه  

 

 VBAفایلهای مدل برای 

 

فایلهای متنی قابل ویرایش هستند، مشابه فایلهای مدل برای جاوا، برای استفاده با  VBAفایلهای مدل برای 

VBA (visual basic for application در اکسل. یک فایل نمونه برای )VBA  حاوی ترتیبی از دستورات

( میباشد. شما میتوانید برای دسترسی به تنظیمات و داده این vba.)پسوند  VBAکامسول بعنوان یک فایل 

 فایلها در مدلهای کامسول از اکسل استفاده کنید.

 برای اکسل میباشد.  ™LiveLinkنیازمند   VBAاستفاده از فایلهای نمونه در قالب 

 

 کامسولذخیره فایلهای 

 جدید applicationذخیره یک 

را ذخیره کنید، یا می خواهید آن را ارتقا داده و نام و فرمت  applicationاگر برای اولین بار می خواهید یک 

 عموما راههای زیر برای ذخیره مدل وجود دارد: فعلی آنرا حفظ کنید،
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  بر روی دکمه ذخیره(  بر روی نوارابزار دسترسی سریع و یا نوارابزار اصلی کلیک کنید. (

  دکمه ترکیبیCtrl+S را فشار دهید 

  مسیرfile>>save را انتخاب کنید 

 

 save asایجاد یک کپی با استفاده از 

 اگر مدل از قبل ذخیره شده بود، و شما قصد تولید یک کپی داشته باشید، می توانید یکی از فرمت های فایل

 save asباز میشود و از لیست  saveرا انتخاب کنید. پنجره  file>>save asکامسول  را انتخاب کنید . گزینه 

file :یکی از گزینه های زیر را انتخاب کنید 

COMSOL Application (*.mph) (the default) 

 Application (*.mphapp) 

Model file for Java (*.java) 

 Model file for MATLAB (*.m) 

 در تمام موارد برای ذخیره به آدرس مورد نظر رفته ، نام فایل را وارد و بر روی  کلید ذخیره کلیک کنید.

 

 The Preferences  .شما میتوانید مولف را در سربرگ فایلهای نمونه برای جاوا و متلب اضافه کنید 

Dialog Box   را باز کرده و زیرgeneral>>history export تیک گزینه ،Include author .را انتخاب کنید 

 

 

 

 

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_customizing.11.09.html#964909
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_customizing.11.09.html#964909
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_customizing.11.09.html#964909
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 بازگشت به آخرین فایل ذخیره شده

)  file>>revert to saved، گزینه GUIبرای بازکردن آخرین نسخه فایل و مقدار دهی مجدد  را انتخاب (

 revert toکنید.برای کاربران ویندوز، همچنین میتوانید نوار ابزار دسترسی سریع را شخصی سازی کرده و دکمه 

saved .را کلیک کنید 

 فشرده سازی تاریخچه

، شامل تنظیماتی که دیگر جزئی applicationو متلب حاوی تاریخچه دست نخورده  فایلهای کامسول برای جاوا

از آن نیستند. برای فشرده سازی تاریخچه چنانچه فایلها فقط شامل تنظیماتی که بخشی از مدل کنونی هستند، 

ابزار دسترسی را انتخاب کنید. برای کاربران ویندوز، همچنین میتوانید نوار  file>>compact historyگزینه 

) compact historyسریع را شخصی سازی کرده و دکمه   را کلیک کنید.  (

 

 ذخیره و بازکردن فایلهای بازیابی

نرم افزار کامسول می تواند فایلهای بازیابی را هر بار که شما حل را شروع می کنید، نگهداری کند.این تنظیمات 

را  file>>open recovery fileدر ابتدا بصورت پیش فرض فعال است. برای باز کردن فایل بازیابی، گزینه 

 openترسی سریع را شخصی سازی کرده و دکمه انتخاب کنید. کاربران ویندوز همچنین می توانید نوار ابزار دس

recovery file (  .را کلیک کنید  (

 به روز رسانی فایل بازیابی در حالات زیر انجام می گیرد :

 ( بعد از پایان حل برای هر بازه زمانی مشخص شده برای یک شبیه سازی وابسته به زمانparametric 

simulationوده زمان ها را انتخاب کنید.( بعنوان زمانهای خروجی در محد 

 ( بعد از پایان هر مرحله پارامتر در شبیه سازی پارامتریparametric simulation.) 
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 ( بعد از پایان موفقیت آمیز هر تکرار نیوتنی در یک شبیه سازی پایدار غیرخطیnonlinear stationary 

simulation .) 

کامسول نمایانگر شرایطی در زمان هستند که ذخیره شده اند. ممکن است در بازیابی آنها  MPHبازیابی فایلهای 

 بوجود بیاید ، که می توانند مخصوصا برای وابستگی زمانی طولانی یا اجراهای پارامتری . solverیک خطای 

لها به فرم تاریخ و زمان تمام فایل های بازیابی را بصورت زمانی مرتب میکند. فای open recovery filesپنجره 

 okذخیره شدن مرتب شده اند. زمانی که یک فایل بازیابی انتخاب می شود، برای بازکردن آن در کامسول روی 

کلیک  show/hidden detailsکلیک کنید. برای نمایش یا مخفی کردن جزئیات بیشتر در مورد فایل بازیابی روی

م فایل بازیابی می باشد. برای حذف کردن فایل بازیابی انتخاب کنید. نمایش جزئیات شامل مسیر کامل و حج

 کلیک کنید. delete all و برای حذف تمام فایل های بازیابی روی delete شده، روی 

 

 

( recovery fileنرم افزار کامسول مراحل زمانی محاسبه شده یا  مراحل پارامتری را در فایلهای بازیابی )

گزینه  studyی ادامه محاسبات از نقطه ای که در فایل بازیابی نگهداری شده، از گره نگهداری می کند، پس برا

continue ( را انتخاب کنید. اگر شما یک مساله غیر پارامتری پایدار را حل می کنید، آخرین تکرار نیوتنی  (

د ادامه حل از این شرایط کاربر می توان continueمورد نظر در فایل بلزیابی ذخیره می شود. با انتخاب گزینه  

 ذخیره شده را انجام دهد.
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را تغییر   fileدر قسمت  The Preferences Dialog Boxنکته: کاربر می توانید این تنظیمات پیش فرض را در 

 دهد.

  تیک گزینهsave recovery file  بصورت پیش فرض به منظور ذخیره فایل روی دیسک در هنگام مراحل

 ( انتخاب شده است.time-dependent, parametric, and nonlinear solversحل برای شرایط مختلف )

  درfolder for recovery files  پوشه متفاوت از پیش فرض انتخاب کند، برای مثال، ، کاربر می تواند یک

استفاده از یک پوشه روی سرور جائیکه فضای کافی برای نگهداری فایل های موقتی  با حجم بزرگتر وجود 

 کلیک کنید. browseداشته باشد. برای انتخاب یک پوشه برای فایلهای موقت روی 

  اگر شما نرم افزار کامشول را بر روی پیکر بندیclient-server  اجرا می کنید، می توانید یک پوشه برای

( و یک پوشه برای فایلهای موقت Folder for temporary files on clientفایلهای موقت بر روی کلاینت )

 ( تخصیص دهید.Folder for temporary files on serverروی سرور  )

 

 

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_customizing.11.09.html#964909
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 ( Rootی تنظیمات ریشه )ویژگی های پنجره-8

  h.azizakram@gmail.comپست الکترونیکی:                                      عزیزاکرم حمید کننده:تهیه 

. با قرار دارد Application Builderدر   Explorerو   Model Builderبالاترین سطح درخت های  در  root گره

باز می شود که شامل اطلاعاتی درباره مدل است. برای باز کردن  rootبرای  settingپنجره  گرهکلیک روی این 

 راست کلیک کرده و از منو مربوطه آنرا انتخاب کرد. rootمربوطه باید روی ایکن  propertiesپنجره 

 

 :(root settingی تنظیمات )پنجره

کاربر می تواند تغییر نیست.نمایش می دهند که قابل رخلاف سایر پنجره ها که فقط اطلاعاتی بدر این پنجره 

برخی فیلد ها یا اطلاعاتی که تغییر آن در کل مدل اعمال می شود را به طور مستقیم در این پنجره ویرایش 

  نماید. در زیر به توضیح قسمت های مختلف این پنجره پرداخته شده است.

protection:  با کلیک بر رویediting not protected  و در ادامهset password  را پسورد مورد دلخواه می توان

 وارد کرد. protect edit with passwordدر کادر 
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Used Products.اطلاعاتی درباره لایسنس خریداری شده ماژول ها را در اختیار کاربر قرار می دهد : 

presentation  به صورت پیش بنویسید: در این بخش شما می توانید برای مدل خود یک عنوان و توصیف .

، شما می توانید computation time. در نوشته می شود "title page "فرض عناوینی که استفاده می شود در 

ی اخرین زمان محاسبه lastدر فیلد  ارد کنید، و expectedمورد نظرتان برای محاسبه را در فیلد تقریبی  زمان 

در این قسمت قرار بدهد. این  یک تصویر کوچک دتوان میکاربر مدل، شکل . برای نشان دادن ثبت می شود

 .نمایش داده شود نیز application librariesدر پنجره  تصویر 
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  :(unit systemسیستم واحد )

 .است که می توان واحد دلخواه را از لیست انتخاب کرد  SIواحد پیش فرض واحد 

 

کاربر می تواند در این قسمت فونت مورد نظرخود  (:font in graphics)نمایش فوت ها در پنجره گرافیکی 

که کاربر می  .می باشد 3پیش فرض فونت با سایز  را برای نمایش در پنجره گرافیکی انتخاب کند. به صورت

با توجه به سیستم عاملی که استفاده می  تواند مقدار سایز فونت های مورد نظر خود را در این قسمت وارد کند.

. لازم به ذکر انتخاب کنید familyهایی که نصب کره اید می توانید فونت مناسب را از لیست کنید یا فونت 

است که کامسول قادر به نمایش فونت های فارسی )حروف( نیست، و فقط اعداد را به صورت فارسی در پنجره 

 گرافیکی نمایش می دهد.

 

 (:ROOT PROPERTIESپنجره ی ویژگی ها )

 را propertiesگزینه راست کرده و از منو مربوطه کلیک  root گرهروی ب propertiesپنجره  مشاهدهبرای 

 این پنجره شامل موارد زیر می باشد: نید. در این پنجره امکان ویرایش وجود ندارد،انتخاب ک
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ه شد وقتی فایل در یک مسیر جدید ذخیر فایل در این قسمت نشان داده شده است.ذخیره  مسیر (:Fileفایل)

 ه طور خودکار تنظیم می شود.ب

شامل ورژن و ساخت کامسول است که توسط خود سیستم ایجاد می (: COMSOL versionورژن کامسول)

 شود.

این قسمت ها توسط خود سیستم و به  (:Created and Last modifiedتاریخ ایجاد و اخرین ویرایش )

 و به تاریخ و زمان سیستم کامپیوتر بستگی دارند. ثبت می شود،طور خودکار 

شماره سریالی که در مراحل نصب استفاده شده است در این  (:Saved with licenseسریال ذخیره شده )

 .قسمت قرار دارد

در این قسمت کاربر می تواند اطلاعاتی را به منظور ردیابی داخلی  (:Application versionورژن اپلیکشنی )

 Internal Draft V1, Sales Demonstration V2, or Version Bکند برای مثال: وارد 

 

 (:Unit Systemsدستگاه های یکا )

 نرم افزار کامسول از دستگاه های یکای زیر استفاده می کند:
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 متریک سیستم

نیز  MKSاست )برخی اوقات با  نرم افزار واحد پیش فرض )سیستم بین المللی واحدها(، SIواحد های 

 شناخته می شود(. 

 SIواحد 

SYMBOL UNIT NAME BASE QUANTITY 

m meter, metre* length 

kg kilogram mass 

s second time 

A ampere electric current 

K kelvin** temperature 

mol mole amount of substance 

cd candela luminous intensity 

 

طول،  دیمانسیون هایمخفف سانتی متر، گرم و ثانیه است که به ترتیب  CGSدستگاه  :CGSAدستگاه یکای 

برای طول، جرم، نیرو، فشار و  CGSیکسان است.دستگاه  SIبا دستگاه بقیه واحدها جرم و زمان می باشند. 

ضعیف  و با نیروهای الکترومغناطیسکوچک مقیاس   انرژی های کوچک نتایج خوبی می دهد وقتی بر روی یک

 CGSA. در دستگاهergو dyne ،baryeکار می کنیم. یکاهای وابسته ی  نیرو، فشار و انرژی به ترتیب عبارتند از: 

 واحد آمپر واحد پایه برای جریان الکتریکی است. 

 CGSAواحد 

SYMBOL UNIT NAME BASE QUANTITY 

cm centimeter length 

g gram mass 
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مپر است که در آن واحد جریان الکتریکی با آ(. این دستگاه بر پایه ی قانون EMUواحدهای الکترومغناطیسی )

از طرف کاربر تعیین می شود. به هنگام مواجه با اثرات مغناطیسی، بهتر  cانتخاب یک مقدار مناسب برای ثابت 

برای باقی دیمانسیون های پایه استفاده  CGSرا انتخاب کنیم. اگر چنانچه دستگاه  4مقدار  cاست که برای 

شود، واحد جریان یک آمپر نامیده می شود و سیستم واحد مزبوطه وحدهای الکترومغناطیس نامیده می شود. 

 مربوطه ساخته می شوند. SIبه واحدهای  -abنام واحدهای وابسته با پیشوند 

 EMUواحد 

SYMBOL UNIT NAME BASE QUANTITY 

cm centimeter length 

g gram mass 

N/A abampere, biot electric current 

برای واحد بار  ESUبر اساس قانون کولومب بین بارهای نقطه ای، دستگاه  (.ESUواحدهای الکترواستاتیک )

 CGSمعرفی می کند و باقی واحدها را برای طول، جرم و زمان از دستگاه  statcoulombالکتریکی را یک 

ساخته می  ESUو باقی واحدهای وابسته دستگاه   franklinیا   statampereاستفاده می کند. به این صورت 

 شود.

 ESUواحد 

SYMBOL UNIT NAME BASE QUANTITY 

cm centimeter length 

g gram mass 

N/A statampere, franklin electric current 

 

(، مواقعی که چگالی در stationary structural mechanics) پایدار. در مکانیک ساختاری MPaواحدهای 

معادلات ظاهر نشود بهتر است که از دستگاهی استفاده شود که در آن برای نیرو و فشار به تریتب از یکاهای 
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برای زمان، واحدهای  SIبا حفظ واحد   (استفاده شود.MPaوابسته ی طبیعی نیوتن و مگاپاسکال )معرف نام 

 یه ی طول و جرم میلیمتر و تن می باشند. به جز واحدهای نیرو فشار، سایر یکاهای وابسته بدون نام هستند. پا

 MPaواحد 

SYMBOL UNIT NAME BASE QUANTITY 

mm millimeter length 

t tonne, ton mass 

MPa megapascal pressure 

 

 سیستم انگلیسی 

این دستگاه تنها دستگاهی است که از واحد پوند برای جرم (.FPSثانیه )یکاهای -پوند-واحدهای فوت

)پوند واحدی برای جرم است نه نیرو( است. یکای  IEEE، در توافق با استاندارد FPSاستفاده می کند. دستگاه 

 ( است. poundalوابسته ی نیرو پوندال )

 FPSواحد 

SYMBOL UNIT NAME BASE QUANTITY 

ft foot length 

lb pound mass 

degF Fahrenheit temperature 

 

پوند -فوت-فوت یا ثانیه-اسلاگ-. دستگاه یکای مهندسی )دستگاه گرانشی ثانیهیکاهای مهندسی بریتانیایی

استاندارد است. در این دستگاه، پوند یکایی برای نیرو است،  FPSنیز نامیده می شود( جایگزینی برای دستگاه 

 فوت در مجذور ثانیه تعریف می شود. -که با در نظر گرفتن واحد اسلاگ برای جرم به صورت اسلاگ
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  BRITISH ENGINEERINGواحد 

SYMBOL UNIT NAME BASE QUANTITY 

ft foot length 

N/A slug mass 

degF Fahrenheit temperature 

lbf pound-force force 

با استفاده از واحد اینچ به جای فوت برای یکای اصلی   (.IPSثانیه )واحدهای -پوند-دستگاه یکای اینچ

 گرانشی. IPS( و دستگاه IPSمطلق )به نام  IPSطول، دو دستگاه یکا بوجود امده است: دستگاه 

 IPSواحد 

SYMBOL UNIT NAME BASE QUANTITY 

in inch length 

lb pound mass 

degF Fahrenheit temperature 

از واحد پوند به عنوان یک واحد وزن به جای یکای  IPSاین نسخه از دستگاه یکای  گرانشی. IPSواحدهای 

 جرم استفاده می کند.

 GRAVITATIONAL IPSواحد 

SYMBOL UNIT NAME BASE QUANTITY 

in inch length 

N/A GIPS_mass mass 

degF Fahrenheit temperature 

 

 سایر .

 هیچ یکایی در این حالت ظاهر نمی شود. این حالت برای سیستم های بی بعد می تواند مفید باشد. 
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 جستجو و یافتن متن

باز خواهد شد و شما می توانید هر متغیر یا متنی را در هر جای نرم افزار  Findپنجره  Ctrl+Eبا فشردن 

، جستجو در داخل نرم افزار انجام می شود که شامل بخش All، با کلیک بر روی findجستجو کنید. در ابزار 

   ،Exact matchهای محیط کاربری، ورودی مدل ها و برچسب ها می باشد. با فعال کردن تیک گزینه های 

regulat expression  و یاcase sensitive  امکان جستجوی مربوطه فراهم است. کاربران ویندوز با فعال کردن

 می توانند از این حالت استفاده کنند. quick access toolbarگزینه 

 . بند، یا با متن دیگر جایگزین نمایدمتنی را پیدا ک دمی توانکاربر  Methodsبا کلیک بر روی 

. نتایج جستجو برای شود ، امکان جستجو فراهم میFindکلیک بر روی گزینه پس از نوشتن متن مورد نظر با 

نمایش داده می شود به طورکه هر سطر نمایانگر یک مورد یافته شده است. با  پیغامهر اقدام در پنجره 

Double-click اهد شد.بر روی هر سطر مورد یافته شده در مکان اصلی خود نمایان خو 
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 پنجره کتابخانه ی برنامه ها-9

  m.m.khoozestani@gmail.comپست الکترونیکی:                     خوزستانی مهدی محمدتهیه کننده: 

کاربر می که  کاربردی می باشد،ی شامل مجموعه ای ازبرنامه هانرم افزار کامسول پنجره کتابخانه برنامه های 

یادگیری . در مثال های گنجانده شده در کتابخانه مراحل مختلف از موارد از آن استفاده کنید یدر بسیار تواند

به کاربر آموزش داده می شود و بهترین منبع برای آموزش کاربرانی می  چگونگی ساخت مدل های کامسول

همراه  ههر ماژول شامل کتابخانه برنامه مخصوص به خود ب غاز کرده اند. باشد که به تازگی کار با کامسول را آ

اطلاعاتی در مورد نحوه استفاده  ماژول در محدوده ی کاربرد های آن است. هر فایل شامل مدارک کامل و یک 

 توضیح مختصر  شامل زمان حل مثال و اطلاعاتی در رابطه با سیستم کامپیوتری مورد نیاز جهت حل مثال،

 جهت دسترسی به مدل های کتابخانه نرم افزار در سیستم های عامل مختلف به ترتیب زیر عمل نمایید. است.

 نحوه دسترسی به کتابخانه کامسول سیتم عامل

 

 

 

)به منظور باز کردن پنجره کتابخانه برنامه ها  ، Windows، منوی Homeاز نوار ابزار  : (

Application Libraries  .را انتخاب نمایید 

همچنین شما می توانید نوار ابزار دسترسی سریع را شخصی سازی کنید و سپس بر روی 

Application Libraries   کلیک کنید. از منویFile  ،Application Libraries را انتخاب  

 نمایید.

 

 

) Application Librariesبرای باز کردن پنجره  :نوار ابزار اصلی را باز کنید، دکمه (

Application Libraries  .را بزنید Windows>Application Libraries د.را انتخاب کنی 

پس از  پنجره کتابخانه برنامه ها نمایش داده شده است، در سمت راست مورد هر مثالدر  ربوط اطلاعات م

 شامل موارد زیر است: مدلاطلاعات مربوط به هر انتخاب هر مدل این اظلاعات نمایش داده می شود. 

mailto:m.m.khoozestani@gmail.com
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 نام مدل 

 رابط های فیزیکی استفاده شده 

 ورژن نرم افزار استفاده شده جهت تهیه و ساخته مدل 

  مدت زمانمورد نیاز برای حل مدل.  اگر شما در خصوص زمان محاسبه تردید داشتید، یک راهنما اطلاعات

عت، و تعداد هسته ها( را نمایش می دهد و در صورت وجود، زمان ، رنج ساCPUمربوط به کامپیوتر شامل ) 

 های حل برای هر مرحله از مثال را نمایش می دهد.

 .زمان و تاریخ ساخت مدل و همچنین زمان آخرین تغییرات اعمال شده آن 

 

 کتابخانهاز یک مدل  بارگزاری
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دادید و مثال شما یک جستجو انجام  برای ، به محض اینکه شما فایل مورد نظر برای باز کردن را انتخاب کردید 

می  سپس برای باز کردن فایل -و یا شما از لیست کتابخانه برنامه استفاده کردید، این جستجو به نتیجه رسید، 

 :توانید یکی از روش های زیر را انتخاب کنید

  لیست دو بار کلیک کنید رمدل دبر روی. 

 را انتخاب و سپس بر روی  مدلOpen Application .کلیک کنید. 

  کلیک راست کنید سپس گزینه ی  بر روی  مدلOpen Application خاب نمایید.ترا ان 

( باشد، شما می توانید با application builderاگر یک برنامه شامل یک رابط مخصوص با برنامه سازنده باشد )

آن مدل را اجرا نمایید. این گزینه برای برنامه هایی که این رایط  Run application کلیک بر روی 

 مخصوص را ندارند، فعال نمی باشد.

 مدل کتابخانه ایpdf باز کردن یک فایل 

  انجام دهد: رازیر  کاربر می تواند یکی از روش های PDF با فرمت مدل برای مشاهده فایل 

 گزینه Open PDF Document   انتخاب کنیدرا. 

  گزینه  موجود،بر روی نام کلیک راست نمایید و سپس از منویOpen PDF Document  را انتخاب

 نمایید.

فایل هر مدل شامل اطلاعات مفیدی شامل: اطلاعات کامل مدل، معادلات استفاده شده در مدل، مراجع  نکته:

 استفاده شده برای مدلسازی و مراحل مدلسازی مرحله به مرحله می باشد.

 

 جستجو در کتابخانه کاربردها
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به صورت پیش  جستجو کنید.مدل مد نظر را شما می توانید در کتابخانه برنامه ها به منظور یافتن یک فایل 

، نام کلی مدلبخشی و یا  که می تواند شاملمی باشد.  Search فرض، جستجو شامل تمامی کلمات شامل کادر

 و یا هر کلمه ی دیگر را وارد کنید.  ’@‘ نماد طرح و یا لیبل با پیشوندرابط های فیزیکی، 

چون نام فایل همان نام مدل فایل . گذاری شده اندفایل های کامسول بر اساس تاکید بر روی کلمات نام  نکته:

MPH  نیز می باشد. این تاکیدات به دلیل شکل گیری یک نام صحیح لازم است، بنابراین پیش نهاد می گردد در

   Searchحین جستجو به دنبال یک مدل، اگر در مورد نام کامل آن اطمینان ندارید، فقط کلمه اول را در قسمت 

 وارد کنید.

 پیشرفته کتابخانه جستجوی 

  به منظور جستجوی یک برنامه بر اساس نام، از پیشوند“@name:”  استفاده نمایید و به طور مثال

@name:busbar  در ابتدا و انتهای موضوع مورد جستجو استفاده  ’*‘. شما همچنین می توانید از کاراکتر

 .*name:*electr@ یا   *name:fluid@کنیدو به طور مثال 

 

  اگر شما به موضوع که شامل کلمات مجزا شده با فاصله هست را جستجو کنید، مدل هایی که شامل همه ی

 کلمات است را جستجو و نمایش می دهد.

  استفاده کنید، به طور  ’@‘محدوده جستجوی خود را توسط تگ ها، نام ها، لیبل ها و یا تایپ ها از پیشوند

 <physics:<name@. به منظور جستجو برای یا رابط فیزیک خاص از عبارت   ehs@ یا   genext@مثال 

 Solidد تا تمام مدل هایی که رابط را وارد کنی physics:solid@به طور مثال  عبارت  .استفاده کنید

Mechanics .را استفاده می کنند، یافت شود 
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 علاوه بر@physics  عبارات ،@geom, @mesh, @probe, @result, @selection,   و @study نیز

در   Ifی که به دنبال مدلی که شامل عبارت را در صورت  geom:if@به طور مثال،  قابل استفاده است.

 است، وارد کنید.  Geometryبخش 

  

 می دهد اگر جستجوی شما به نتیجه نرسید، پنچره کتابخانه برنامه ها پیغام زیر را نمایش 

 No Results Found.  دکمهRefresh ( که در زیر لیست قراردارد را به منظور بازگشت به لیست (

 اصلی کتابخانه برنامه ها، بزنید.  
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 (Demo) برنامه های دمو

شما برنامه هایی با رابط های خاص متناسب با برنامه سازنده    Demo applicationدر فولدر کتابخانه 

(application builder را به منظور تسهیل حل یک مسئله خاص با استفاده از )COMSOL Multiphysics    ،

مشخص  پایین آیکون همچون   –مشاهده می کنید. این گونه برنامه ها توسط فلش سبز در قسمت راست 

)می شوند. برای راه اندازی یک برنامه بر روی  ) Run Application  بدانید کلیک کنید. و یا در صورت  اینکه

)چگونه یک برنامه ساخته شده است، بر روی   )Open Application   کلیک کنید. برای برنامه های دمو، با

)کلیک بر روی  ) Open PDF document   فایلPDF   باز می شود که شما می توانید از طریق اجرای برنامه

 به آن دسترسی پیدا کنید. 
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کامل و فشرده، فایل های انتخاب در لیست مشاهده می نماید.  جهتدر این فسمت شما دو نوع فایل : کتهن

ارائه  گردند که شامل مش های ذخیره شده و یا حل مسئله  MPHبرخی از برنامه ممکن است همراه با فایل 

مشخص می  مشخص می شوند. مدل های کامل با آیکون  نیست. این گونه فایل های فشرده با آیکون 

)می باشد. برنامه های فشرده  اجرائی گردند. آیکون های زیر نمایانگر برنامه های  )و کامل  ( ). 

 به همراه راه حل ها MPHدانلود فایل 

 via Application Library Updateرا به همراه راه حل مربوطه از طریق  MPH شما می توانید فایل های کامل 

را مشاهده فرمایید( دانلود نمایید. بصورت جایگزین، بر The Application Library Update Window) لطفا 

)گره فشرده  روی  Download File withدر بخش لیست کتابخانه برنامه راست کلیک نمایید و  (

Solutions .را انتخاب کنید 

 

 تنظیمات کتابخانه برنامه ها

به منظور ویرایش کلیک    Application Librariesرا باز کرده و بر روی  The Preferences Dialog Boxبخش 

 یست فولدر های کتابخانه برنامه قرار دارد.  کنید. کلید ها در بخش پایین ل

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.22.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_customizing.11.09.html#964909
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)  Add User Libraryبر روی دکمه  شخصی برای اضافه کردن کتابخانه برنامه به منظور خصوصی سازی  (

، مسیر فولدری  Browse for Folderدر بخش   User Application Libraryفولدر ها کلیک کنید. در لیست 

کلیک کنید. به   Make New Folderتر خود بسازید را مشخص کنید. یا بر روی  وکه می خواهید در کامپی

 را انتخاب کنید  Cancelرا انتخاب و یا به منظور خروج بدون ذخیره سازی   OKمنظور ذخیره سازی و خروج 

 اضافه کردن یک کتابخانه جدید، که شامل یک کتابخانه از قبل استفاده شده باشد، ممکن نیست. نکته:

) Set Library Rootدکمه ، بر روی مشخیص کردن مسیر کتابخانه برنامهجهت  به منظور ویرایش یا (

 شود.مسیر متفاوتی که کابردهای خصوصی سازی شده ذخیره می شود، منتقل  تا در. کلیک کنیدساخت فولدر 

، مسیر جدید فولدر را انتخاب و یا دکمه ساخت  Browse For Folderدر بخش لیست کتابخانه برنامه و سپس 

 Cancelرا به منظور ذخبره و خروج بزنید و یا    OKجدید را بزنید. سپس   Make New Folderیک فولدر 

 برای خروج بدون ذخیره سازی بزنید.

 ن بر روی آیک و سپسمورد نظر را انتخاب کرده برنامه یا فولدر ،  کتابخانه جدید مدل حذف یکجهت 

Remove Selected ( این دکمه پس از ساخته شدن  کلیک کنیدبه منظور حذف آن از کتابخانه برنامه ها   (

 کتابخانه برنامه شما، فعال می شود.
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 های فیزیکی رابط -11

  reza_mirghafurian@yahoo.com:پست الکترونیکی                     میرغفوریان       تهیه کننده: رضا

فیزیک ارائه شده  های اصلی فیزیکی به همراه لایسنس کامسول مولتی در این بخش، شرح مختصری دربارۀ رابط 

است.  اگر شما بخواهید از یک ماژول افزودنی استفاده کنید ، در قسمت اسناد نرم افزار توضیحات کاملی در 

 جود دارد .های فیزیک دیگری هم و مورد رابط فیزیکی انتخاب شده و سایر رابط 

 ای بر رابط های فیزیک مقدمه

های اصلی، بایستی تنظیمات مربوط به  معمولاً کاربر ضمن انتخاب معادله PDEبرای حل معادلات دیفرانسیل 

 کامسولافزار  های ماده، شرایط مرزیِ یک مسئلۀ و نوع شرایط حل )پایدار یا ناپایدار( را تعیین نمایید. نرم ویژگی

دهد  افزار چند رابط فیزیکی در اختیار شما قرار می کند. این نرم فیزیک، این امکان را برای شما مقدور می مولتی

کند.  های خاص فیزیک را تعیین می ها و متغیرهای حوزه هایی تشکیل شده است که معادله ها و محیط که از گره

های مهم فیزیک  تصویرسازی و ارزیابی کمیتای از متغیرهای وابسته به فیزیک،  وجود مجموعۀ گسترده

 کند. بااستفاده از علائم و واژگان متعارف را آسان می

معادله،  هستند که تنطیمات مدلسازی  سازی مبتنی  های فیزیکی، رابط های مخصوصی برای مدل مکمل رابط 

PDEاین، رابطهای دیگری نیز وجود بر  کند. علاوه هایی، که به حوزۀ کاربردی خاصی مرتبط نیستند، را ساده می

 Sensitivity userهای حساسیت) افزایند، مانند: رابط  ای به فیزیک انتخاب شده می دارند که کارکردهای ویژه

interfaces(و رابط کاربر مش متحرک )Moving Mesh user interfaces.) 
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 های رابط های فیزیک ها و زیرگروه گروه

( و نیز صفحۀ پنجرۀ افزودن فیزیک Model Wizard( در مدل ویزارد )Select Physicsصفحۀ انتخاب فیزیک )

(The Add Physics Windowشامل گروه ،) ابطهای فیزیکی و ریاضی است )برخی اقلام تنها های ر ها و زیرگروه

 های افزودنی در مجوز لحاظ شده باشند(. شوند که مدول درصورتی نمایش داده می

 

 (اند ) مواردی که اخیراً استفاده شده

اند و دسترسی به این رابط ها را تسهیل  این گروه شامل آن دسته از رابطهای فیزیک است که اخیراً استفاده شده

 کند. می

AC/DC ( ) 

( low-frequency electromagneticsهای فرکانس پایین ) این گروه شامل رابط های فیزیکِی  الکترومغناطیس

 Particleهای آن ردیابی ذره ) های الکترواستاتیکی و الکترونیکی است. یکی از زیرگروه نظیر جریان

Tracing.است، که نیازمند ماژول ردیابی ذره است) 

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.27.html
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)اکوستیک  ) 

 این گروه شامل رابط های فیزیک اکوستیکی است. ماژول های اصلی این گروه عبارتند از:

 ( برهم کنش ساختار اکوستیکیAcoustic-Structure Interaction) 

 ( ایرواکوستیکAeroacoustics) 

 (ترمواکوستیکThermoacoustics) 

 ( اکوستیک هندسیGeometrical Acoustics) 

 

 (اجزاء شیمیایی )انتقال 

این گروه شامل رابط های فیزیک انتقال اجزاء شیمیاییمی باشد، برای مثال، برای همرفت و نفوذ و حل 

 گیرد. ماژول های اصلی این گروه عبارتند از: های گونۀ شیمیایی مورد استفاده قرار می غلظت

 (  جریان واکنشیReacting Flow شامل می( )که زیرگروه جریان آشفته را نیز )شود 



 

 
82 

 ( جریان واکنشی در محیط متخلخلReacting Flow in Porous Media) 

 ( جریان واکنش در تجهیزات دوارRotating Machinery, Reacting Flow که زیرگروه جریان آشفته( )

 گیرد( را نیز دربر می

 

 (الکتروشیمی )

و پیل   اجزای الکترو شیمایی نظیر باتریسازی  این گروه شامل رابط های فیزیکی الکتروشیمی ویژۀ مدل

 شیمیایی است. ماژول های اصلی این گروه عبارتند از:

 ( رابط های باتریBattery Interfaces) 

 ( خوردگی، تغییر شکل هندسیCorrosion, Deformed Geometry ) 

 ( الکتروانباشت، تغییر شکل هندسیElectrodeposition, Deformed Geometry) 
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)جریان سیال   ) 

فاز جریان چندفازی و جریان آشفته است.   این گروه شامل رابط های فیزیک جریان سیال نظیر جریان آرام تک

 ماژول های اصلی این گروه عبارتند از:

 فاز ) جریان تکSingle-Phase Flowهای جریان سیال را  ( )که جریان آشفته و تجهیزات دوار، زیرگروه

 شود( شامل می

 ( جریان فیلم نازکThin-Film Flow) 

 فازی ) جریان چندMultiphase Flowهای جریان همراه حباب، مدل آمیخته؛ مدل اویلر ( )که زیرگروه-

اویلر؛ جریان دوفازه؛ مجموعۀ سطح؛ میدان فاز، شبکۀ متحرک؛ و تجهیزات دوار ؛ جریان چندفازی را شامل 

 شود( می

 ( محیط متخلخل و جریان زیر سطحیPorous Media and Subsurface Flow) 

 ( جریان غیرهم دماNon-Isothermal Flowهای جریان آشفته و دستگاه چرخان، جریان غیر  ( )که زیرگروه

 شود(. هم دما را شامل می

 ( جریان با عدد ماخ  بالاHigh Mach Number Flowهای دیگر جریان آشفته را شامل  (،)که زیرگروه

 شود( می

 جریان پالا( یش شدهRarefied Flow) 

 ( ردیابی ذرهParticle Tracing) 
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)انتقال گرما  ) 

فیزیک  دمایی نظیر  این گروه رابط های فیزیک ویژۀ انتقال گرما در جامدات و سیالات و کاربردهای مولتی

 شود. ماژول های اصلی این گروه عبارتند از: گرمای ژول را شامل می

 ( انتقال گرما درهم آمیختهConjugate Heat Transferهای جریان آشفته را شامل  ( )که دیگر زیرگروه

 شود( می

 (تابشRadiation) 

 ( گرمای الکترومغناطیسیElectromagnetic Heating) 
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)اپتیک  ) 

این گروه رابط های فیزیکِ ویژۀ انتشار امواج الکترومغناطیسی در محیط اپتیک خطی و غیرخطی را شامل 

 سازی طراحی کاربرد دارند. ماژول های اصلی این گروه عبارتند از: سازی دقیق اجزا و بهینه شبیه شود که در می

 ( اشعه اپتیکیRay Optics ) 

 ( امواج اپتیکیWave Optics) 

 

) پلاسما  ) 

باشد.  سازی پلاسما می این گروه شامل رابط های فیزیکِی مخصوص مدل

 

)فرکانس رادیویی  ) 

سازی میدان الکترومغناطیسی فرکانس بالا است که با معادلات  این گروه شامل رابط های فیزیکی ویژۀ شبیه

 کامل ماکسول حل می شوند. 
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)رسانا  نیمه ) 

های  این گروه شامل آن دسته از رابط های فیزیک است که در حل معادلۀ پواسون  پتانسیل الکتریکی و معادله

 های ماژول با فقط گروه رسانا کاربرد دارند. این ها و حفره های موجود در مادۀ نیمه ترونتغییر ولتاژ الک-نفوذ

 .است دسترس در هادی نیمه

 

)مکانیک ساختاری  ) 

ها در  ها و تنش جایی این گروه شامل رابط های فیزیک مکانیک ساختاری است که برای مثال، در مطالعۀ جابه

 .است دسترس در MEMS ماژول با زیرگروه پیزو تنهاجامدات کاربرد دارند. وجود 

 

)ریاضی  ) 

سازی  )که به  است که در بهینه DAEو  PDE ،ODRاین گروه شامل رابط های ریاضی مخصوص حل معادلات  

های متحرک و هندسۀ پارامتری کاربرد دارد. سازی مش سازی نیاز دارد( و تحلیل حساسیت و مدل مدول بهینه

 اصلی این گروه عبارتند از:ماژول های 
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  رابطهایPDE (PDE Interfacesشود تر را شامل می ( )که زیرگروه ابعاد پایین 

  رابطهایODE  وDAE 

 بهینه ( سازی و حساسیتOptimization and Sensitivity) 

 PDEهای کلاسیک 

 ( تغییر شکل مشDeformed Mesh) 

 (  رابط  متحرکMoving Interfaceواسطۀ وجود مدول  ()که بهCFD  یا ماژولmicrofluidics  در دسترس

 می باشد(.

 

نکته: برای اطلاع از فهرست تمام رابط های فیزیکی هر گروه و زیرگروه، اسناد مجزای گنجانده شده در هر 

 .وجو کنید جست online Helpماژول را مطالعه کنید. یا واژگان کلیدی راهنمای واسطۀ فیزیک را در 

همچنین با انتخاب هر ماژول در قسمت مدل ویزارد توضیحات مختصری در باره ماژول انتخابی ارائه می شود که 

 .به کاربر تا حدودی در انتخاب ماژول صحیح کمک می کند
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 افزودن پنجره فیزیک-11

 m.r.shahi.vazifeh@gmail.com پست الکترونیکی:                  محمدرضا شاهی وظیفهتهیه کننده:  

 

 select physicsو در قسمت ( Model Wizard) در مدل ویزاردمورد نظر انتخاب فیزیک  باپنجره فیزیک افزودن 

توسط کاربر انجام می گیرد. می تواند تعداد مازول های مورد نیاز خود را انتخاب کرده و  با کلیک بر روی دگمه 

Add  آنها را به قسمتAdd physics interface .اضافه نمایید 

 

متغییر مستقل هر ماژول نشان  Dependent variablesدر قسمت سمت راست این پنجره ودر قسمت  نکته:

 داده می شود. لازم به ذکر است این عبارت توسط کاربر قابل تغییر می باشد.

اضافه نمایید، به  Model Builderکاربر در هر مرحله از مدلسازی می تواند ماژول مورد نیاز را  در پنجره      

پنجره افزودن فیزیک  Add physicsکلیک راست کرده و با انتخاب گزینه  Componentاین منظور بر روی گره 

و  Add to componentمه های در سمت راست کامسول دسکتاپ ظاهر می شود، کاربر با انتخاب ماژول دگ
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Add to selection   فعال می شود که با انتخاب هر یک از این گزینه ها می تواند ماژول مورد نیاز خود را به

 اضافه نمایید Model Builderپنجره 

 

در منوی ابزار،  ازو یا   Add physicsبر روی   Model منوی ابزار، در قسمتاز همچنین کاربر می تواند 

 Model Builderماژول مورد نیاز خود را به پنجره ه و درکلیک ک  Add physicsو برروی  physics قسمت

 اضافه نمایید.
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 و کلیک بر روی دگمه   Add physicsجهت سهولت در انتخاب ماژل مورد نیاز، کاربر با جستجو در قسمت  نکته:

search متناسب با عبارت وارد شده نشان داده می شود. محتوای پنجره  لیستی از رابط های فیزیکیAdd 

physics ( به ابعاد فضای کامپوننتComponentبستگی دارد ،)()اگر هیچ  .یک بعدی، دو بعدی، و سه بعدی

  گره کامپوننتی در مدل وجود نداشته باشد لیست رابط های فیزیکی خالی نشان داده می شود.

 

موجود در زیر این   Studiesدر مدلسازی خود استفاده کرده باشد، در قسمت   Studiesچنانچه کاربر از چندین 

ظاهر Solve(  در ستون (علامت  studyها نمایش داده می شود، در صورت انتخاب هر studyپنجره لیست 

)علامت علامت  studyمی شود. ودر صورت عدم انتخاب هر   شود.نشان داده می  (
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هنگامی که کاربر رابط فیزیکی مورد نظر را انتخاب می کند، در پایین این پنجره اسامی متغیرهای وابسته 

 نمایش داده می شود.Dependent variablesدر قسمت 

 

 راهنمای رابط فیزیکی 

برای هندسه های یک بعدی، یک بعدی متقارن، دو بعدی، دو  موجود یو ریاضیاتفیزیکی  هایرابط جدول زیر

  .مولتی فیزیک کامسول لیست کرده استنرم افزار بعدی متقارن، و سه بعدی را  در 

 

 برای رابط فیزیکی مورد نظر از پیش تنظیم شده studyنوع  ابعاد فضا علامت نماد رابط فیزیکی

 AC/DC 

Electric 

Currents 
 

ec all 

dimensions 

 (stationaryحالت پایدار )

Electrostatics 
 

es all 

dimensions 

 (time dependent( و ناپایدار )stationaryحالت پایدار )

Magnetic 

Fields 
 

mf 

2D, 2D 

axisymmetric 

 frequency( و دامین فرکانسی )stationaryحالت پایدار )

domain) 
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 برای رابط فیزیکی مورد نظر از پیش تنظیم شده studyنوع  ابعاد فضا علامت نماد رابط فیزیکی

Acoustics Pressure Acoustics 

Pressure 

Acoustics, 

Frequency 

Domain 

 
acpr all 

dimensions 

 eigenfrequency( و frequency domainدامین فرکانسی )

 

 برای رابط فیزیکی مورد نظر تنظیم شده از پیش studyنوع  ابعاد فضا علامت نماد رابط فیزیکی

Chemical Species Transport 

Transport of 

Diluted Species  
tds all dimensions 

 (time dependent( و ناپایدار )stationaryحالت پایدار )

 

 برای رابط فیزیکی مورد نظر از پیش تنظیم شده studyنوع  ابعاد فضا علامت نماد رابط فیزیکی

Fluid Flow Single-Phase Flow 

Laminar 

Flow  
spf 3D, 2D, 2D 

axisymmetric 

 (time dependent( و ناپایدار )stationaryحالت پایدار )

 

 برای رابط فیزیکی مورد نظر از پیش تنظیم شده studyنوع  ابعاد فضا علامت نماد رابط فیزیکی

   Heat Transfer 

Heat 

Transfer in 

Solids 

 

ht 

all dimensions 
 (time dependent( و ناپایدار )stationaryحالت پایدار )

Heat 

Transfer in 

Fluids 

 

ht 

all dimensions 
 (time dependent( و ناپایدار )stationaryحالت پایدار )
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 برای رابط فیزیکی مورد نظر از پیش تنظیم شده studyنوع  ابعاد فضا علامت نماد رابط فیزیکی

Electromagnetic Heating 

Joule 

Heating1,  
— all dimensions 

 (time dependent( و ناپایدار )stationaryحالت پایدار )

 

 برای رابط فیزیکی مورد نظر از پیش تنظیم شده studyنوع  ابعاد فضا علامت نماد رابط فیزیکی

Electromagnetic Heating 

Solid 

Mechanics  
solid 3D, 2D, 2D 

axisymmetric 

( و time dependent( و ناپایدار )stationaryحالت پایدار )

eigenfrequency 

 

 برای رابط فیزیکی مورد نظر از پیش تنظیم شده studyنوع  ابعاد فضا علامت نماد رابط فیزیکی

  Mathematics 

Wall 

Distance  
wd all dimensions 

 (time dependent( و ناپایدار )stationaryحالت پایدار )

Curvilinear 

Coordinates  
cc all dimensions 

 eigenvalue( و stationaryحالت پایدار )

 

 برای رابط فیزیکی مورد نظر از پیش تنظیم شده studyنوع  ابعاد فضا علامت نماد رابط فیزیکی

  PDE Interfaces 

Coefficient 

Form PDE  
c all dimensions 

 eigenvalue ( و time dependent) ناپایدار(، stationary) حالت پایدار

General 

Form PDE  
g all dimensions 

 eigenvalue ( و time dependent)ناپایدار (، stationary)حالت پایدار 

Wave Form 

PDE  
wahw all dimensions 

 (time dependent) ناپایدار

Weak Form 

PDE  
w all dimensions 

 eigenvalue ( و time dependent)ناپایدار (، stationary)حالت پایدار 
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 برای رابط فیزیکی مورد نظر از پیش تنظیم شده studyنوع  ابعاد فضا علامت نماد رابط فیزیکی

  Lower Dimensions 

Coefficient 

Form 

Boundary 

PDE 

 
cb all dimensions 

 ( و time dependent(، ناپایدار )stationaryحالت پایدار )

eigenvalue 

Coefficient 

Form Edge 

PDE 

 
ce 3D 

 ( و time dependent(، ناپایدار )stationaryحالت پایدار )

eigenvalue 

Coefficient 

Form Point 

PDE 

 
cp 3D, 2D, 2D 

axisymmetric 

 ( و time dependent(، ناپایدار )stationaryحالت پایدار )

eigenvalue 

General 

Form 

Boundary 

PDE 

 
gb all dimensions 

 ( و time dependent(، ناپایدار )stationaryحالت پایدار )

eigenvalue 

General 

Form Edge 

PDE 

 
ge 3D 

 ( و time dependentناپایدار )(، stationaryحالت پایدار )

eigenvalue 

General 

Form Point 

PDE 

 
gp 3D, 2D, 2D 

axisymmetric 

 ( و time dependent(، ناپایدار )stationaryحالت پایدار )

eigenvalue 

Weak Form 

Boundary 

PDE 

 
wb all dimensions 

 ( و time dependent(، ناپایدار )stationaryحالت پایدار )

eigenvalue 

Weak Form 

Edge PDE  
we 3D 

 ( و time dependent(، ناپایدار )stationaryحالت پایدار )

eigenvalue 

Weak Form 

Point PDE  
wp 3D, 2D, 2D 

axisymmetric 

 ( و time dependent(، ناپایدار )stationaryحالت پایدار )

eigenvalue 
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 برای رابط فیزیکی مورد نظر از پیش تنظیم شده studyنوع  ابعاد فضا علامت نماد رابط فیزیکی

  ODE and DAE Interfaces 

Global 

ODEs and 

DAEs 

 
ge all dimensions 

 ( و time dependent(، ناپایدار )stationaryحالت پایدار )

eigenvalue( دامین فرکانسی ،frequency domain و )
eigenfrequency 

Domain 

ODEs and 

DAEs 

 
dode all dimensions 

 ( و time dependent(، ناپایدار )stationaryحالت پایدار )

eigenvalue 

Events 
 

ev all dimensions 
 (time dependentناپایدار )

Boundary 

ODEs and 

DAEs 

 
bode all dimensions 

 ( و time dependent(، ناپایدار )stationaryحالت پایدار )

eigenvalue 

Edge ODEs 

and DAEs  
eode 3D 

 ( و time dependent(، ناپایدار )stationaryحالت پایدار )

eigenvalue 

Point ODEs 

and DAEs  
pode 3D, 2D, 2D 

axisymmetric 

 ( و time dependent(، ناپایدار )stationaryحالت پایدار )

eigenvalue 

 

 

 برای رابط فیزیکی مورد نظر از پیش تنظیم شده studyنوع  ابعاد فضا علامت نماد رابط فیزیکی

Optimization and Sensitivity 

Optimization 

Requires the 

Optimization 

Module 

 
opt all dimensions 

 ( و time dependent(، ناپایدار )stationaryحالت پایدار )

eigenvalue( دامین فرکانسی ،frequency domain و )
eigenfrequency 

Sensitivity 
 

sens all dimensions 
 ( و time dependent(، ناپایدار )stationaryحالت پایدار )

eigenvalue( دامین فرکانسی ،frequency domain و )
eigenfrequency 
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 برای رابط فیزیکی مورد نظر از پیش تنظیم شده studyنوع  ابعاد فضا علامت نماد رابط فیزیکی

Classical PDEs 

Laplace 

Equation  
lpeq all dimensions 

 (stationaryحالت پایدار )

Poisson’s 

Equation  
poeq all dimensions 

 (stationaryحالت پایدار )

Wave 

Equation  
waeq all dimensions 

 (time dependentناپایدار )

Helmholtz 

Equation  
hzeq all dimensions 

 (stationaryحالت پایدار )

Heat 

Equation  
hteq all dimensions 

 (time dependent(، ناپایدار )stationaryحالت پایدار )

Convection-

Diffusion 

Equation 

 
cdeq all dimensions 

 (time dependent(، ناپایدار )stationaryحالت پایدار )

 

 

 برای رابط فیزیکی مورد نظر از پیش تنظیم شده studyنوع  ابعاد فضا علامت نماد رابط فیزیکی

  Deformed Mesh 

Deformed 

Geometry  
dg all dimensions 

(،دامین time dependent(، ناپایدار )stationaryحالت پایدار )

 eigenvalue (frequency domainفرکانسی )

Moving 

Mesh  
ale all dimensions 

(،دامین time dependent(، ناپایدار )stationaryحالت پایدار )

 eigenvalue (frequency domainفرکانسی )
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 نوار ابزارها و کلیدهای میانبر

 Saat35@yahoo.comپست الکترونیکی:                                     تهیه کننده: علیرضا خوزستانی

 

. طراحی شده اندشبیه سازی  اساس مراحلدر نرم افزار کامسول مولتی فیزیک بر  موجود ابزارها و منوهاینوار 

همچنین کلیدهای میانبر زیادی نیز وجود دارد که در فرایند شبیه سازی کمک می کنند. در جدول زیر 

به صورت کلی نرم افزار می باشد. اطلاعات بیشتری در رابطه با گزینه های موجود در نوار و نوار ابزارها موجود 

 کامسول دارای نوارآبزار های زیر می باشد.

 Home Toolbar 

 Definitions Toolbar 

 Geometry Toolbar 

 Work Plane Modal Toolbar 

 Materials Toolbar 

 Physics Toolbar 

 0D Component Toolbar 

 Mesh Toolbar 

 Study Toolbar 

 Results Toolbar 

 Plot Group Contextual Toolbar 

 Report Group Contextual Toolbar 

 View Toolbar 

 (HOME Toolbarنوار ابزار خانه )

در صورت که در ساختن و تحلیل یک مدل  ی است،لکردهای رایجمبسیاری از ویژگیها و ع شاملنوار ابزار خانه  

 ( در شکل و جداول زیر نشان داده شده است.HOME Toolbar) نوار ابزار خانهآیکن های  .نیاز را دارا می باشد

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.34.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.35.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.36.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.37.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.38.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.39.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.40.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.41.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.42.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.43.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.44.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.45.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.46.html
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Application 

 توضیحات نام آیکن

 

Application Builder 

(Ctrl+Alt+A) 
 در کامسولمدل  و پنجره ساخت اپلیکشن سازارتباط بین 

 Model Data Access انتخاب تنظیمات به منظور بهتر کردن شبیه سازی 

 Record a New Method مدل جاسازی شده به روش جدید  ثبت تغییرات 

 
Test Application 

(Ctrl+F8) 
 در یک پنجره  جدید یک اپلیکشناجرای 

 

Model 

 توضیحات نام آیکن

— Component 

بعدی، دو بعدی و دو بعدی متقارن، تک بعدی و تک  9 هندسه فضایی،هنگامی که 

 کاربربعدی متقارن در دسترس باشند و یا اضافه شوند همه اینها در اینجا لیست شده و

 برود.می توان با کلیک کردن بر روی آن به نقطه مورد نظر در نوار ابزار ساخت مدل 

 
Add 

Component 

بعدی متقارن، تک بعدی و تک بعدی متقارن و بی  2بعدی و  2بعدی ،  برای حالات9

 بعد
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Definitions 

 توضیحات نام آیکن

 Parameters به مدل کلی پارامترهای  جهت افزودن 

 Variables متغیرهای کلی و متغیرهای محلی جهت افزودن 

 Functions  توابع جهت انتخاب می باشدتمامی شامل لیست 

 

Geometry 

 توضیحات نام آیکن

 Build All  اعمال می کند موجودهمه ویژگیها را در مدل 

 Import  های فایل سایرکامسول و یا  با فرمتیک مدل  یهندسشکل وارد کردن CAD 

 LiveLink .جهت اتصال به سایر نرم افزار های موجود از این آیکن استفاده می شود 

 

 Material 

 توضیحات نام آیکن

 Add Material جهت افزودن یک ماده از پنجره مواد به بخشی و یا تمامی هندسه مدل 
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 physics 

 توضیحات نام آیکن

— 

Various—the 

physics interface 

name 

زمانی که رابط فیزیکی افزوده شده با شد کاربر از این لیست می تواند آنها را 

 مشاهده کرده و با کلیک بر روی آن به گره آن رابط فیزیکی برود.

 
Select Physics 

Interface 
 ( فعال می باشد.blank modelاین گزینه در مدل خالی )

 Add Physics 

رابط فیزیکی از پنجره رابط فیزیکی به مدل استفاده می جهت افزودن یک 

 شود

 

 Mesh 

 توضیحات نام آیکن

 Build Mesh .جهت ایجاد مش در مدل موجود از این گزینه استفاده می شود 

 Select Mesh1 ( این گزینه در مدل خالیblank model.فعال می باشد ) 

 Mesh1 

شند، کاربر از این لیست می تواند آنها را زمانی که مش ها  افزوده شده با 

 مشاهده کرده و با کلیک بر روی آن به گره آن مش برود.
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 Compute 

 توضیحات نام آیکن

 Compute1 ( این گزینه جهت محاسبه مطالعهStudy.انتخاب شده بکار می رود ) 

 Select Study1 ( این گزینه در مدل خالیblank model فعال می ).باشد 

 Study1 

( افزوده شده با شند، کاربر از این لیست می تواند Studyزمانی که مطالعه )

 (برود.Studyآنها را مشاهده کرده و با کلیک بر روی آن به گره آن مطالعه )

 Add Study1 ( جهت افزودن یک مطالعهStudy از پنجره )Study به مدل استفاده می شود  

 

Results 

 توضیحات نام آیکن

— 
Select Plot 

Group1 

 ,1D, 2D( فعال می باشد.blank modelاین گزینه در مدل خالی )

and 3D 

 
Add Plot 

Group1 

بعدی،  2بعدی، مجموعه نمودارهای  9مجموعه نمودارهای جهت افزودن 

 استفاده می شود. مجموعه نمودارهای یک بعدی، مجموعه نمودارهای قطبی

Table 20-

9 

(3D, 2D, 1D, 

or Polar) Plot 

Group1 

ی وجود داشته باشد، کاربر از این لیست می تواند آنها را هنگامی که نتایج

 برود.  مجموعه نمودارهایلیک بر روی آن به گره آن مشاهده کرده و با ک

 

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_results.27.066.html#2445740
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_results.27.066.html#2445740
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Layout 

 توضیحات نام آیکن

 Reset Desktop2 

دسکتاپ نرم افزار کامسول را به حالت اولیه باز گردانده و می توان نوع 

 تغییر داد.چیدمان را به صورت عریض و یا به صورت منظم 

 Windows 

 زدسکتاپ کامسول اضافه کرد. منوی ویندومی توان پنجره هایی موجود را به 

 .شامل پنجره هایی می شود که درجدول آمده است

 Add Physics2 با این گزینه می توان فیزیک جدیدی را به مجموعه اضافه کرد 

 Add Study2 با این گزینه می توان مطالعه جدیدی را به مجموعه اضافه کرد 

 Add Material2  توان ماده ی جدیدی را به مجموعه اضافه کردبا این گزینه می 

 
Material 

Browser2 

با باز کردن این گزینه می توان به کتابخانه مواد موجود در نرم افزار دسترسی 

 پیدا کرده و یا اینکه آنها را ویرایش کرد

 
Application 

Libraries2 
 .پنجره کتابخانه نرم افزار ها را باز می کند

 Part Libraries2 با این گزینه می توان به مجموعه اجزاء هندسی دسترسی پیدا کرد 

 Selection List2 

ه ن.برای مثال هنگامی با هدس می توان جزء مورد نظر را به راحتی انتخاب کرد

پیچیده ای کار می کنید و نیاز دارید جزئی را انتخاب کنید که به سادگی در 

 شکل دیده نمی شود.
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 Properties2 

را گزینه های خواص سایرپنجره خواص از منوی زمینه قابل دسترسی بوده و 

 نیز نشان می دهد.

 Messages2 بعد از انجام یک عملیات می باشد محتوی  اطلاعات مفید 

 Table2 

نشان دهنده ی نتایج تابع اولیه و سنجش متغیرهایی می باشد که در نقطه 

Drived Value   تعریف شده اند و یا در  نقاط جدول ذخیره شده باشند. 

 
External 

Process2 

فرایندهای بیشتری را دنبال می کند. به طور مثال هنگامی که یک فرایند 

 اضافی وصل بشوید پنجره آپدیت می شود.

 
Physics Builder 

Manager2 
 physic builderمدیریت تستها، تلفیق و مقایسه ی فایلهای 

 

های رایج که در ساخت و مگرنوار ابزار خانه )پنجره( و نوار ابزار مدل )مک و لینوکس( بسیاری از ویژگیها و عل

 تحلیل یک مدل نیاز می باشد را دارا هستند.

برای کسانی که از سیستم مک و یا لینوکس استفاده می کنند ترتیب گزینه هایی که نمایش داده می  نکته:

 Tools>Toolbarمی باشد. برای مثال بعضی از گزینه ها در صورتی که آنها تنظیمات تولبار  بهبسته ، شود

Display Mode   روی حالتNormal  و برچسبTools>Toolbar Button  روی حالتShow Icon and Text 

یز تاثیر می حالت صفحه دسکتایپ )صفحه عریض و یا منظم(  ن درباشد نمایان نخواهند بود. همچنین این مورد 

 پذیرد.

و پنجره ها قابل  دیگر منوها یگزینه ها ،که از سیستم مک و یا لینوکس استفاده می کنند اربرانیبرای ک

 دسترسی می باشد.
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 نمایش گزینه های بیشتر در قسمت فیزیک

برای نشان دادن قسمتهای اضافی برای قسمت فیزیک )و یا قسمتهای دیگر درختچه ی مدل( بر روی گزینه  

Show (  در )Model Builder  کلیک کرده و سپس applicable option را انتخاب کنید. 

 

گزینه های بیشتری از پنجره فیزیک و یا منوی زمینه در دسترس قرار می  Show بعد از کلیک بر روی گزینه 

اضافه خواهد شد و یا  Advancedقسمت تنظیمات پیشرفته   Advanced Physics Optionsانتخاب ، با گیرند

  Advanced Study Optionsانتخاب گزینه . اینکه گزینه ای در پنجره فیزیک در منوی زمینه فعال خواهد شد

 گزینه های مربوط به مطالعه و نتایج به ترتیب  فعال می شوند.  Advanced Results Optionsا ی
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 نوارابزار تعاریف 

 Ehsani_a70@ut.ac.irپست الکترونیکی:                                            احسانی تهیه کننده: عباس

های کاربردی است  لینوکس و مک شامل اکثر دستورات و فرمان سیتم های عاملتعاریف در ویندوز و  نوار ابزار

 Definitionsتعاریف )نوار ابزار آیکن های که در زیرشاخه تعاریف و قسمت ساخت مدل وجود دارد. درادامه 

Toolbar.در شکل و جداول زیر نشان داده شده است ) 

 

 

Variables  

 توضیحات نام آیکن

 
Local 

Variables 

افزودن متغییر های محلی در مدل استفاده می شود، با کلیک بر روی این آیکن، جهت 

 (، ایجاد می شود.Definitionsگره متغییرها در درخت طراحی و در زیر تعاریف )

 

Functions  

 توضیحات نام آیکن

 Analytic 
آیکن، گره جهت افزودن تابع تحلیلی در مدل استفاده می شود، با کلیک بر روی این 

 (، ایجاد می شود.Definitionsتابع تحلیلی در درخت طراحی و در زیر تعاریف )

 



 

 
107 

 Interpolation 
در مدل استفاده می شود، با کلیک بر روی این آیکن، گره  تابع درونیابجهت افزودن 

 (، ایجاد می شود.Definitionsدر درخت طراحی و در زیر تعاریف ) تابع درونیاب

 Piecewise 
در مدل استفاده می شود، با کلیک بر روی این آیکن،  ای تابع چندضابطهجهت افزودن 

(، ایجاد می Definitionsدر درخت طراحی و در زیر تعاریف ) ای تابع چندضابطهگره 

 شود.

 More 

Functions 

ای )توابع  غیر از توابع تحلیلی، درونیاب و چند ضابطهه توابع ب جهت افزودن سایر

در مدل استفاده می شود، با کلیک بر روی این آیکن ها ، گره گوسین، پله، ضربه و ....( 

 (، ایجاد می شود.Definitionsاین تابع در درخت طراحی و در زیر تعاریف )

 

Selections  

 توضیحات نام آیکن

 Explicit 
در مدل استفاده می شود، با کلیک بر روی این آیکن ، گره  ،هندسه تکیانتخاب جهت 

Explicit ( در درخت طراحی و در زیر تعاریفDefinitions.ایجاد می شود ،) 

 Complement 
، در مدل استفاده می شود، با کلیک بر روی این آیکن ، گره  انتخاب کلی هندسهجهت 

Complement  در درخت طراحی و در زیر ( تعاریفDefinitions.ایجاد می شود ،) 

 Adjacent 
در مدل استفاده می شود،  به همدیگرهندسی چند انتخاب  م کردنافزودن یا ک جهت 

در درخت طراحی و در زیر تعاریف  Adjacentبا کلیک بر روی این آیکن ، گره 

(Definitions.ایجاد می شود ،) 
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 Ball 
، در مدل استفاده می شود، با کلیک بر روی این آیکن  یک دایره هندسهانتخاب جهت 

  (، ایجاد می شود.Definitionsتعاریف ) در درخت طراحی و در زیر  Ball، گره 

 Box 
، در مدل استفاده می شود، با کلیک بر روی این یک مستطیل  انتخاب هندسهجهت 

 (، ایجاد می شود.Definitionsدر درخت طراحی و در زیر تعاریف ) Boxآیکن ، گره 

 Cylinder 
، در مدل استفاده می شود، با کلیک بر روی این  استوانهیک  انتخاب هندسهجهت 

(، ایجاد می Definitionsدر درخت طراحی و در زیر تعاریف ) Cylinderآیکن ، گره 

 شود.

 Union 
اده می شود، با جهت افزودن و یا کم کردن چندین انتخاب هندسی ، در مدل استف

در درخت طراحی و در زیر تعاریف  Unionکلیک بر روی این آیکن ، گره 

(Definitions.ایجاد می شود ،) 

 Intersection 
هندسی ، در مدل استفاده می شود، با کلیک  انتخاب اشتراک دو انتخاب متمایزجهت 

در درخت طراحی و در زیر تعاریف   Intersectionبر روی این آیکن ، گره 

(Definitions.ایجاد می شود ،) 

 Difference 
هندسی ، در مدل استفاده می شود، با کلیک بر  تفاضل دو انتخاب متمایز جهت اعمال

(، Definitionsدر درخت طراحی و در زیر تعاریف ) Differenceروی این آیکن ، گره 

 ایجاد می شود.
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Probes  

 توضیحات نام آیکن

 Update Probes 
 پراب ها استفاده می شود.بروزرسانی تمام اینگزینه به منظور  

 Probes 
 پراببر روی مرز، حجم و نقطه یا با استفاده از این گزینه کاربر می تواند پراب هایی را 

در درخت های پراب کلی برای مدل تعریف نمایید. با کلیک بر روی این آیکن ، گره 

 (، ایجاد می شود.Definitionsطراحی و در زیر تعاریف )

 

Mass Properties  

 توضیحات نام آیکن

 Mass 

Properties 

جهت افزودن ویژگی های جرمی ، در مدل استفاده می شود، با کلیک بر روی این 

(، ایجاد Definitionsدر درخت طراحی و در زیر تعاریف ) Mass Propertiesآیکن ، گره 

 می شود.

 Mass 

Contributions 

، در مدل استفاده می شود، با کلیک بر روی این آیکن ، گره توزیع جرمی جهت افزودن 

Mass Contributions ( در درخت طراحی و در زیر تعاریفDefinitions.ایجاد می شود ،) 
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Coupling  

 توضیحات نام آیکن

 Component 

Couplings 

جهت افزودن مولفه های کوپل ، در مدل استفاده می شود، با کلیک بر روی این آیکن ، 

(، ایجاد می Definitionsدر درخت طراحی و در زیر تعاریف ) های مربوط به آنگره 

 شود.

 Pairs 
، در مدل استفاده می شود، با کلیک بر روی این  اضافه کردن جفت کردن اعضاجهت 

 (، ایجاد می شود.Definitionsدر درخت طراحی و در زیر تعاریف ) هاآیکن ، گره 

 

Coordinate Systems  

 توضیحات نام آیکن

 Coordinate 

Systems1 

، در مدل استفاده می شود، با کلیک بر روی این  اضافه کردن دستگاه مختصاتجهت 

 ایجاد می شود.(، Definitionsآیکن ، گره در درخت طراحی و در زیر تعاریف )

 Perfectly 

Matched 

Layer1 

، در مدل استفاده می شود، با کلیک بر روی این آیکن ، (PML) اضافه کردن جهت 

 (، ایجاد می شود.Definitionsگره در درخت طراحی و در زیر تعاریف )

 Infinite 

Element 

Domain1 

ک بر روی این آیکن ، گره ، در مدل استفاده می شود، با کلی(IED)اضافه کردن جهت 

 (، ایجاد می شود.Definitionsدر درخت طراحی و در زیر تعاریف )
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View  

 توضیحات نام آیکن

 
View  ودو بعدی  جهت نمایش و مخفی کردن قسمتی از هندسه، در حالات سه بعدی

 در مدل استفاده می شود،  

 

Extra Dimensions  

 توضیحات نام آیکن

 Add Extra 

Dimension1 

 افزودن بعد اضافی به مدلجهت 

 Attached 

Dimensions1 

 اضافه کردن ابعاد با استفاده از ضرب کارتزین با استفاده از ابعاد دیگرجهت 

 Integration 

Over Extra 

Dimension1 

اضافه کردن گره در تعاریف به منظور انتگرال گیری از متغیرها در بعد اضافه جهت 

 شده

 

کنند، ترکیب نمایش نوارابزار بستگی به تنظیمات  مک یا لینوکس استفاده می سیستم عاملرای کاربرانی که از ب

 ، نمایش داده نمی شوند.در شرایطی که تنظیمات به صورت زیر باشد آیکن هادارد. برای مثال، بعضی از 

Tools>Toolbar Display Mode is set to Normal and the Tools>Toolbar Button Label is set to 

Show Icon and Text 

 روی نمایش نوار ابزار تاثیر گذار است.بر همچنین تمام صفحه بودن یا نبودن برنامه هم 
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 نوار ابزارها و کلیدهای میانبر

 Saat35@yahoo.comپست الکترونیکی:                                     تهیه کننده: علیرضا خوزستانی

 

. طراحی شده اندشبیه سازی  اساس مراحلدر نرم افزار کامسول مولتی فیزیک بر  موجود نوار ابزارها و منوهای

همچنین کلیدهای میانبر زیادی نیز وجود دارد که در فرایند شبیه سازی کمک می کنند. در جدول زیر 

به صورت کلی نرم افزار اطلاعات بیشتری در رابطه با گزینه های موجود در نوار و نوار ابزارها موجود می باشد. 

 کامسول دارای نوارآبزار های زیر می باشد.

 Home Toolbar 

 Definitions Toolbar 

 Geometry Toolbar 

 Work Plane Modal Toolbar 

 Materials Toolbar 

 Physics Toolbar 

 0D Component Toolbar 

 Mesh Toolbar 

 Study Toolbar 

 Results Toolbar 

 Plot Group Contextual Toolbar 

 Report Group Contextual Toolbar 

 View Toolbar 

 (HOME Toolbar) نوار ابزار خانه

در صورت که در ساختن و تحلیل یک مدل  ی است،لکردهای رایجمبسیاری از ویژگیها و ع شاملنوار ابزار خانه  

 ( در شکل و جداول زیر نشان داده شده است.HOME Toolbar) ابزار خانهنوار آیکن های  .نیاز را دارا می باشد

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.34.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.35.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.36.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.37.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.38.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.39.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.40.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.41.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.42.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.43.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.44.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.45.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_environment.09.46.html
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Application 

 توضیحات نام آیکن

 

Application Builder 

(Ctrl+Alt+A) 
 در کامسولمدل  و پنجره ساخت اپلیکشن سازارتباط بین 

 Model Data Access انتخاب تنظیمات به منظور بهتر کردن شبیه سازی 

 Record a New Method مدل جاسازی شده به روش جدید  ثبت تغییرات 

 
Test Application 

(Ctrl+F8) 
 در یک پنجره  جدید یک اپلیکشناجرای 

 

Model 

 توضیحات نام آیکن

— Component 

بعدی، دو بعدی و دو بعدی متقارن، تک بعدی و تک  9 هندسه فضایی،هنگامی که 

 کاربربعدی متقارن در دسترس باشند و یا اضافه شوند همه اینها در اینجا لیست شده و

 برود.می توان با کلیک کردن بر روی آن به نقطه مورد نظر در نوار ابزار ساخت مدل 

 
Add 

Component 

تقارن، تک بعدی و تک بعدی متقارن و بی بعدی م 2بعدی و  2بعدی ،  برای حالات9

 بعد
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Definitions 

 توضیحات نام آیکن

 Parameters به مدل کلی پارامترهای  جهت افزودن 

 Variables متغیرهای کلی و متغیرهای محلی جهت افزودن 

 Functions  توابع جهت انتخاب می باشدتمامی شامل لیست 

 

Geometry 

 توضیحات نام آیکن

 Build All  اعمال می کند موجودهمه ویژگیها را در مدل 

 Import  های فایل سایرکامسول و یا  با فرمتیک مدل  یهندسشکل وارد کردن CAD 

 LiveLink .جهت اتصال به سایر نرم افزار های موجود از این آیکن استفاده می شود 

 

 Material 

 توضیحات نام آیکن

 Add Material جهت افزودن یک ماده از پنجره مواد به بخشی و یا تمامی هندسه مدل 
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 physics 

 توضیحات نام آیکن

— 

Various—the 

physics interface 

name 

زمانی که رابط فیزیکی افزوده شده با شد کاربر از این لیست می تواند آنها را 

 رابط فیزیکی برود.مشاهده کرده و با کلیک بر روی آن به گره آن 

 
Select Physics 

Interface 
 ( فعال می باشد.blank modelاین گزینه در مدل خالی )

 Add Physics 

جهت افزودن یک رابط فیزیکی از پنجره رابط فیزیکی به مدل استفاده می 

 شود

 

 Mesh 

 توضیحات نام آیکن

 Build Mesh  گزینه استفاده می شود.جهت ایجاد مش در مدل موجود از این 

 Select Mesh1 ( این گزینه در مدل خالیblank model.فعال می باشد ) 

 Mesh1 

زمانی که مش ها  افزوده شده با شند، کاربر از این لیست می تواند آنها را 

 مشاهده کرده و با کلیک بر روی آن به گره آن مش برود.
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 Compute 

 توضیحات نام آیکن

 Compute1 ( این گزینه جهت محاسبه مطالعهStudy.انتخاب شده بکار می رود ) 

 Select Study1 ( این گزینه در مدل خالیblank model.فعال می باشد ) 

 Study1 

( افزوده شده با شند، کاربر از این لیست می تواند Studyزمانی که مطالعه )

 (برود.Studyبه گره آن مطالعه )آنها را مشاهده کرده و با کلیک بر روی آن 

 Add Study1 ( جهت افزودن یک مطالعهStudy از پنجره )Study به مدل استفاده می شود  

 

Results 

 توضیحات نام آیکن

— 
Select Plot 

Group1 

 ,1D, 2D( فعال می باشد.blank modelاین گزینه در مدل خالی )

and 3D 

 
Add Plot 

Group1 

بعدی،  2بعدی، مجموعه نمودارهای  9مجموعه نمودارهای جهت افزودن 

 استفاده می شود. مجموعه نمودارهای یک بعدی، مجموعه نمودارهای قطبی

Table 20-

9 

(3D, 2D, 1D, 

or Polar) Plot 

Group1 

ی وجود داشته باشد، کاربر از این لیست می تواند آنها را هنگامی که نتایج

 برود.  مجموعه نمودارهایمشاهده کرده و با کلیک بر روی آن به گره آن 

 

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_results.27.066.html#2445740
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_results.27.066.html#2445740
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Layout 

 توضیحات نام آیکن

 Reset Desktop2 

دسکتاپ نرم افزار کامسول را به حالت اولیه باز گردانده و می توان نوع 

 تغییر داد.چیدمان را به صورت عریض و یا به صورت منظم 

 Windows 

 زمی توان پنجره هایی موجود را به دسکتاپ کامسول اضافه کرد. منوی ویندو

 .شامل پنجره هایی می شود که درجدول آمده است

 Add Physics2 با این گزینه می توان فیزیک جدیدی را به مجموعه اضافه کرد 

 Add Study2 با این گزینه می توان مطالعه جدیدی را به مجموعه اضافه کرد 

 Add Material2 با این گزینه می توان ماده ی جدیدی را به مجموعه اضافه کرد 

 
Material 

Browser2 

کتابخانه مواد موجود در نرم افزار دسترسی با باز کردن این گزینه می توان به 

 پیدا کرده و یا اینکه آنها را ویرایش کرد

 
Application 

Libraries2 
 .پنجره کتابخانه نرم افزار ها را باز می کند

 Part Libraries2 با این گزینه می توان به مجموعه اجزاء هندسی دسترسی پیدا کرد 

 Selection List2 

ه ن.برای مثال هنگامی با هدس جزء مورد نظر را به راحتی انتخاب کردمی توان 

پیچیده ای کار می کنید و نیاز دارید جزئی را انتخاب کنید که به سادگی در 

 شکل دیده نمی شود.
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 Properties2 

را گزینه های خواص سایرپنجره خواص از منوی زمینه قابل دسترسی بوده و 

 نیز نشان می دهد.

 Messages2 بعد از انجام یک عملیات می باشد محتوی  اطلاعات مفید 

 Table2 

نشان دهنده ی نتایج تابع اولیه و سنجش متغیرهایی می باشد که در نقطه 

Drived Value   تعریف شده اند و یا در  نقاط جدول ذخیره شده باشند. 

 
External 

Process2 

به طور مثال هنگامی که یک فرایند  فرایندهای بیشتری را دنبال می کند.

 اضافی وصل بشوید پنجره آپدیت می شود.

 
Physics Builder 

Manager2 
 physic builderمدیریت تستها، تلفیق و مقایسه ی فایلهای 

 

های رایج که در ساخت و مگرنوار ابزار خانه )پنجره( و نوار ابزار مدل )مک و لینوکس( بسیاری از ویژگیها و عل

 تحلیل یک مدل نیاز می باشد را دارا هستند.

برای کسانی که از سیستم مک و یا لینوکس استفاده می کنند ترتیب گزینه هایی که نمایش داده می  نکته:

 Tools>Toolbarمی باشد. برای مثال بعضی از گزینه ها در صورتی که آنها تنظیمات تولبار  بهبسته ، شود

Display Mode   روی حالتNormal  و برچسبTools>Toolbar Button  روی حالتShow Icon and Text 

حالت صفحه دسکتایپ )صفحه عریض و یا منظم(  نیز تاثیر می  درباشد نمایان نخواهند بود. همچنین این مورد 

 پذیرد.

و پنجره ها قابل  دیگر منوها یگزینه ها ،که از سیستم مک و یا لینوکس استفاده می کنند اربرانیبرای ک

 دسترسی می باشد.
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 نمایش گزینه های بیشتر در قسمت فیزیک

برای نشان دادن قسمتهای اضافی برای قسمت فیزیک )و یا قسمتهای دیگر درختچه ی مدل( بر روی گزینه  

Show (  در )Model Builder  کلیک کرده و سپس applicable option را انتخاب کنید. 

 

گزینه های بیشتری از پنجره فیزیک و یا منوی زمینه در دسترس قرار می  Show روی گزینه بعد از کلیک بر 

اضافه خواهد شد و یا  Advancedقسمت تنظیمات پیشرفته   Advanced Physics Optionsانتخاب ، با گیرند

  Advanced Study Optionsانتخاب گزینه . اینکه گزینه ای در پنجره فیزیک در منوی زمینه فعال خواهد شد

 گزینه های مربوط به مطالعه و نتایج به ترتیب  فعال می شوند.  Advanced Results Optionsیا 
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 نوارابزار تعاریف

 Ehsani_a70@ut.ac.irپست الکترونیکی:                                            احسانی تهیه کننده: عباس

های کاربردی است  لینوکس و مک شامل اکثر دستورات و فرمان سیتم های عاملتعاریف در ویندوز و  نوار ابزار

 Definitionsتعاریف )نوار ابزار آیکن های که در زیرشاخه تعاریف و قسمت ساخت مدل وجود دارد. درادامه 

Toolbar.در شکل و جداول زیر نشان داده شده است ) 

 

Variables  

 توضیحات نام آیکن

 
Local 

Variables 

جهت افزودن متغییر های محلی در مدل استفاده می شود، با کلیک بر روی این آیکن، 

 (، ایجاد می شود.Definitionsگره متغییرها در درخت طراحی و در زیر تعاریف )

 

Functions  

 توضیحات نام آیکن

 Analytic 
بر روی این آیکن، گره جهت افزودن تابع تحلیلی در مدل استفاده می شود، با کلیک 

 (، ایجاد می شود.Definitionsتابع تحلیلی در درخت طراحی و در زیر تعاریف )

 



 

 
121 

 Interpolation 
در مدل استفاده می شود، با کلیک بر روی این آیکن، گره  تابع درونیابجهت افزودن 

 .(، ایجاد می شودDefinitionsدر درخت طراحی و در زیر تعاریف ) تابع درونیاب

 Piecewise 
در مدل استفاده می شود، با کلیک بر روی این آیکن،  ای تابع چندضابطهجهت افزودن 

(، ایجاد می Definitionsدر درخت طراحی و در زیر تعاریف ) ای تابع چندضابطهگره 

 شود.

 More 

Functions 

ای )توابع  غیر از توابع تحلیلی، درونیاب و چند ضابطهه توابع ب جهت افزودن سایر

در مدل استفاده می شود، با کلیک بر روی این آیکن ها ، گره گوسین، پله، ضربه و ....( 

 (، ایجاد می شود.Definitionsاین تابع در درخت طراحی و در زیر تعاریف )

 

Selections  

 توضیحات نام آیکن

 Explicit 
در مدل استفاده می شود، با کلیک بر روی این آیکن ، گره  ،هندسه تکیانتخاب جهت 

Explicit ( در درخت طراحی و در زیر تعاریفDefinitions.ایجاد می شود ،) 

 Complement 
، در مدل استفاده می شود، با کلیک بر روی این آیکن ، گره  انتخاب کلی هندسهجهت 

Complement  در درخت طراحی و در زیر ( تعاریفDefinitions.ایجاد می شود ،) 

 Adjacent 
در مدل استفاده می شود،  به همدیگرهندسی چند انتخاب  م کردنافزودن یا ک جهت 

در درخت طراحی و در زیر تعاریف  Adjacentبا کلیک بر روی این آیکن ، گره 

(Definitions.ایجاد می شود ،) 
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 Ball 
، در مدل استفاده می شود، با کلیک بر روی این آیکن  یک دایره هندسهانتخاب جهت 

  (، ایجاد می شود.Definitionsتعاریف ) در درخت طراحی و در زیر  Ball، گره 

 Box 
، در مدل استفاده می شود، با کلیک بر روی این یک مستطیل  انتخاب هندسهجهت 

 (، ایجاد می شود.Definitionsدر درخت طراحی و در زیر تعاریف ) Boxآیکن ، گره 

 Cylinder 
، در مدل استفاده می شود، با کلیک بر روی این  استوانهیک  انتخاب هندسهجهت 

(، ایجاد می Definitionsدر درخت طراحی و در زیر تعاریف ) Cylinderآیکن ، گره 

 شود.

 Union 
اده می شود، با جهت افزودن و یا کم کردن چندین انتخاب هندسی ، در مدل استف

در درخت طراحی و در زیر تعاریف  Unionکلیک بر روی این آیکن ، گره 

(Definitions.ایجاد می شود ،) 

 Intersection 
هندسی ، در مدل استفاده می شود، با کلیک  انتخاب اشتراک دو انتخاب متمایزجهت 

در درخت طراحی و در زیر تعاریف   Intersectionبر روی این آیکن ، گره 

(Definitions.ایجاد می شود ،) 

 Difference 
هندسی ، در مدل استفاده می شود، با کلیک بر  تفاضل دو انتخاب متمایز جهت اعمال

(، Definitionsدر درخت طراحی و در زیر تعاریف ) Differenceروی این آیکن ، گره 

 ایجاد می شود.
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Probes  

 توضیحات نام آیکن

 Update Probes 
 پراب ها استفاده می شود.بروزرسانی تمام اینگزینه به منظور  

 Probes 
 پراببر روی مرز، حجم و نقطه یا با استفاده از این گزینه کاربر می تواند پراب هایی را 

در درخت های پراب کلی برای مدل تعریف نمایید. با کلیک بر روی این آیکن ، گره 

 (، ایجاد می شود.Definitionsطراحی و در زیر تعاریف )

 

Mass Properties  

 توضیحات نام آیکن

 Mass 

Properties 

جهت افزودن ویژگی های جرمی ، در مدل استفاده می شود، با کلیک بر روی این 

(، ایجاد Definitionsدر درخت طراحی و در زیر تعاریف ) Mass Propertiesآیکن ، گره 

 می شود.

 Mass 

Contributions 

، در مدل استفاده می شود، با کلیک بر روی این آیکن ، گره توزیع جرمی جهت افزودن 

Mass Contributions ( در درخت طراحی و در زیر تعاریفDefinitions.ایجاد می شود ،) 
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Coupling  

 توضیحات نام آیکن

 Component 

Couplings 

جهت افزودن مولفه های کوپل ، در مدل استفاده می شود، با کلیک بر روی این آیکن ، 

(، ایجاد می Definitionsدر درخت طراحی و در زیر تعاریف ) های مربوط به آنگره 

 شود.

 Pairs 
، در مدل استفاده می شود، با کلیک بر روی این  اضافه کردن جفت کردن اعضاجهت 

 (، ایجاد می شود.Definitionsدر درخت طراحی و در زیر تعاریف ) هاآیکن ، گره 

 

Coordinate Systems  

 توضیحات نام آیکن

 Coordinate 

Systems1 

، در مدل استفاده می شود، با کلیک بر روی این  اضافه کردن دستگاه مختصاتجهت 

 ایجاد می شود.(، Definitionsآیکن ، گره در درخت طراحی و در زیر تعاریف )

 Perfectly 

Matched 

Layer1 

، در مدل استفاده می شود، با کلیک بر روی این آیکن ، (PML) اضافه کردن جهت 

 (، ایجاد می شود.Definitionsگره در درخت طراحی و در زیر تعاریف )

 Infinite 

Element 

Domain1 

ک بر روی این آیکن ، گره ، در مدل استفاده می شود، با کلی(IED)اضافه کردن جهت 

 (، ایجاد می شود.Definitionsدر درخت طراحی و در زیر تعاریف )
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View  

 توضیحات نام آیکن

 
View  ودو بعدی  جهت نمایش و مخفی کردن قسمتی از هندسه، در حالات سه بعدی

 در مدل استفاده می شود،  

 

Extra Dimensions  

 توضیحات نام آیکن

 Add Extra 

Dimension1 

 افزودن بعد اضافی به مدلجهت 

 Attached 

Dimensions1 

 اضافه کردن ابعاد با استفاده از ضرب کارتزین با استفاده از ابعاد دیگرجهت 

 Integration 

Over Extra 

Dimension1 

اضافه کردن گره در تعاریف به منظور انتگرال گیری از متغیرها در بعد اضافه جهت 

 شده

 

کنند، ترکیب نمایش نوارابزار بستگی به تنظیمات  مک یا لینوکس استفاده می سیستم عاملرای کاربرانی که از ب

 ، نمایش داده نمی شوند.در شرایطی که تنظیمات به صورت زیر باشد آیکن هادارد. برای مثال، بعضی از 

Tools>Toolbar Display Mode is set to Normal and the Tools>Toolbar Button Label is set to 

Show Icon and Text 

 روی نمایش نوار ابزار تاثیر گذار است.بر همچنین تمام صفحه بودن یا نبودن برنامه هم 
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 ابزارهای هندسهنوار 

 hoseini.amir42@yahoo.comپست الکترونیکی:                                              امیر حسینیتهیه کننده: 

 

فعال می با اضافه کردن یک هندسه به مدل، نوار ابزار هندسه)ویندوز( و ابزار متنی هندسه) ماک و لینوکس( 

 شد. برای می با بسیاری از ویژگی های مشترک و اقدامات مورد نیاز برای ایجاد و ساخت هندسهشود، که شامل 

آورده شده است، درنوار ابزارها و منوهای دیگر زیر  گزینه هایی که در جدول، برخی از cross-platform کاربران

 . شد.موجود می با

 

Build 

 توضیحات نام آیکن

 
Build All  ،ترسیم شده به کارمی رود. تمام ویژگی های هندسه جهت ساخت 

 

Import/Export  

 توضیحات نام آیکن

 
Import 

 
در پنجره  CADفایل سایر کامسول یا با فرمت  ترسیمی هندسهبا استفاده از این گزینه 

 گرافیکی فراخوانی می شود.

 
Insert 

Sequence 
در هندسه ی به صورت مرحله ای فایل کامسول مولتی  هندسهجهت اعمال و فراخوانی 

 استفاده می شود.جاری  

 
Export  کامسول و یا یک فایل متنی را در قالب یک فایل باینری یا  ترسیم شدههندسهCAD 

  می کند.استخراج 
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Primitives (3D) 

 توضیحات نام آیکن

 Block جهت ترسیم یک مکعب در مختصات فضایی سه بعدی 

 
Cone جهت ترسیم یک مخروط در مختصات فضایی سه بعدی  

 
Cylinder جهت ترسیم یک استوانه در مختصات فضایی سه بعدی 

 
Sphere  در مختصات فضایی سه بعدییک کره جهت ترسیم  

 
Torus  در مختصات فضایی سه بعدییک چنبره جهت ترسیم  

 
Helix  در مختصات فضایی سه بعدییک مارپیچ جهت ترسیم  

 
More 

Primitives 
این گزینه حاوی ابزارهای مختلف جهت ترسیم هندسه در مختصات فضایی سه بعدی 

 می باشد.

 

Primitives (2D) 

 توضیحات نام آیکن

 
Primitives  دایره، بیضی، مستطیل، مربع، چند ضلعی هایاین آیکن شامل ابزارهای Bezier الحاق ،

 برای ترسیم هندسی می باشد و چند ضلعی منحنی، منحنی پارامتری، نقطه

 

Primitives (1D) 

 توضیحات نام آیکن

 
Interval  برای مدل یک بعدی، ابتدا به کار می روددر پنجره گرافیکی جهت ترسیم یک خط .

تدایی و کلیک کنید، سپس در پنجره گرافیکی بر روی نقاط اب Intervalروی گزینه 

 انتهایی کلیک کنید. 

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_geometry.14.25.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_geometry.14.25.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_geometry.14.27.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_geometry.14.27.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_geometry.14.28.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_geometry.14.28.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_geometry.14.42.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_geometry.14.42.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_geometry.14.45.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_geometry.14.45.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_geometry.14.32.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_geometry.14.32.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_geometry.14.35.html
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Point  .به پنجره گرافیکی یک نقطه اضافه کنید. با این امکان می توانید یک نقطه رسم کنید

کلیک کرده، سپس  در پنجره گرافیکی )در  Point برای این کار ابتدا بر روی گزینه 

 Setting)ه را در پنجره تنظیماتش طیک بعد و دو بعد(کلیک کنید یا اینکه مکان نق

window)  تعیین کنید. در دو بعد و سه بعد، این دکمه در قسمتMore Primitives 

menu .قرار دارد 

 

Work Plane  

 توضیحات نام آیکن

 
Select Work 

Plane 
گزینه های  جهت انتخاب صفحات کار به استفاده می شود، با انتخاب هر صفحه کاری،

شود و شما می توانید با کلیک کردن اشکال صفحات  مربوط به آن برای شما لیست می

انتخاب کنید. این امکان همچنین یک  (Model Builder)هندسه مربوطه را در مدل 

 صفحه کار را باز خواهد کرد. نوار ابزار متنی صفحه کار برای 

 
Work Plane .جهت افزودن یک صفحه کار به استفاده می شود 

 

Operations  

 توضیحات نام آیکن

 
Extrude  جهت تبدیل هندسه دو بعدی ترسیم شده به سه بعدی 

 
Revolve  جهت تبدیل سطح دو بعدی ترسیم شده  به سه بعدی به صورت دورانی 

 
Sweep جهت تبدیل هندسه دو بعدی به سه بعدی با تعیین خط مسیر مشخص 

 
Loft  جهت  تبدیل چندین هندسه دوبعدی  در راستای اشکال ترسیم شده به سه بعدی 

 
Booleans 

and 

Partitions 

، (Union)اجتماعدر شرایط مختلف:  جهت تصحیح هندسه های سه بعدی ترسیم شده

 (Compose)، ترکیب(Difference)، تفاضل(Intersection)تقاطع

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_geometry.14.38.html
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http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_geometry.14.72.html
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Transforms  :آرایهاین آیکن شامل گزینه های مختلفی از قبیل(Array)کپی،(Copy) ،

 می باشد.  (Scale)، مقیاس(Rotate)، چرخش(Move)، حرکت(Mirror)آینه

 
Conversions

1 
این آیکن شامل گزینه های مختلفی می باشد که امکان نمایش و تبدیل هندسه سه 

 بعدی به منحنی و یا تبدیل منحنی های ترسیم شده به جسم و... به کار می رود. 

 
Chamfer1 .جهت ایجاد یک پخ در هندسه ترسیم شده به کار می رود 

 
Fillet1 جهت ایجاد پخ منحنی در هندسه ترسیم شده به کار می رود.  

 
Tangent سه های دو بعدی مماس دیک خط لبه درهن زاضافه کردن بخشی ا 

 
Delete1  جهت پاک کردن هندسه ویا خطوط ترسیمی  

 
Edit Object ،ترسیمی به کار می رود.این آیکن پس از دو بعدی  هندس لبه ها و رئوس جهت تغییر

کلیه خطوط  انتخاب هندسه موردنظر فعال می شود و پس از انتخاب این گزینه

محیطی هندسه دو بعدی به رنگ قرمز نمایش داده می شود پس از اعمال هر گونه 

 تغییر هندسی با کلیک راست این تغییرات بر روی هندسه قبلی اعمال می گردد.

 
Cross 

Section 
 به سه بعدی در همان راستا انجام می شود.سطوح مقطع دو بعدی جهت تبدیل 

 
Defeaturing 

and 

Repair1,3 

مختلف به منظور حذف گوشه های زائد به کار می  این آیکن شامل لیستی از ابزارهای

 رود.

 
Virtual 

Operations1 
این آیکن شامل گزینه های مختلفی به منظور انجام عملیات هندسی و مش به کار می 

 رود.

 

Other  

 توضیحات نام آیکن

 
Parts  داده می بیانگر هندسه ترسیمی در حالت دوبعدی می باشد که در گره هندسه نمایش

 شود.
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Programmin

g1 
  If + End If  :و بررسی پارامترها. از اضافه کردن قبل و اضافه کردن بعد از فهرست ها

و بررسی  (End If)، اگر پایان  (Else) ، دیگری (Else If) ، چیز دیگری اگر (If) اگر

  .(Parameter Check)پارامترها

 
Selections1 کاربر با انتخاب قسمتی از شکل هندسی می تواند نامی رابرای  با استفاده از این گزینه

  آن قسمت اختصاص دهد.

 
Measure1  به منظور اندازه گیری قسمت های مختلف هندسه از قبیل طول خطوط انتخابی و یا

 مساحت سطح مقطع و.. به کار می رود.

 
Delete 

Sequence1 
 استفاده می شود. به منظور پاک کردن کلیه مراحل ترسیم هندسی

 

 ابزارهای ترسیم هندسه

کاربر با استفاده از ابزارهای نمایش داده شده در جداول زیر مستقیما می تواند، مدل هندسی خود را در 

مختصات فضایی یک بعدی و دو بعدی ترسیم نمایید، اما جهت استفاده از این ابزار ها در مختصات فضایی سه 

 . می باشد Work Planeبعدی  منوط به ایجاد 

Draw Settings 

 توضیحات نام آیکن

 

Snap  نشانه هایی را در شبکه ای پنجره ای به منظور ترسیم آسان هندسه در پنجره گرافیکی

 برای) هندسه رئوس و شبکه نقاط بهرا  ماوس گر اشاره ،را مهیا می کند. و برای مثال 

 . را نشان می دهد (مستطیل یک های گوشه مثال،

 

Solid  

(2D and 2D 
axisymmetric) 

با .ی به کار می رودگرافیک پنجره در( منحنی یک جای به) سطح یک به منظور ترسیم

استفاده از این گزینه کاربر می تواند انواع سطوح همراه با منحنی مریع مستطیل و.. را 

بیل، ترسیم کند در صورت غیر فعال بودن این گزینه ، تمامی موارد ترسیمشدهازق

 مریع یا دایره و... به صورت خطوط نمایش داده می شود نه سطح.
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Draw (2D)  

 توضیحات نام آیکن

 

 

 

Line 

Quadratic 

Cubic 

 

استفاده   ضلعی چند یک مکعب منحنی و دوم، درجه منحنی خط، پاره رسمجهت  ت

 می شود.

 

 

Point از این گزینه استفاده کنید. به منظورتعیین نقاط مختلف در  پنجرهترسیم هندسی 

 

Rectangle کنید انتخاب رااین گزینه  مربع یا مستطیل یک رسم برای  

 

Circle بکارمی رود. بیضی، یا دایره یک رسم برای 

 

Draw (1D)  

 توضیحات نام آیکن

 

Interval  ،جهت ترسیم یک خط در پنجره گرافیکی از این گزینه استفاده می شود 

. 

 

Point  استفاده می شود ی ازاین گزینهگرافیک پنجره به نقطه یکجهت افزودن . 

 

، کلیک راست کرده و سپس Geometry ، در مختصات فضایی سه بعدی، بر رویWork Plane جهت ایجاد

 را انتخاب نمایید. Work Planeگزینه 
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Resulنوار ابزار نتایج) t s Tool bar) 

 manakord@gmail.comپست الکترونیکی:                                           مانا کردتهیه کننده: 

نوار ابزار نتایج) در نسخه ویندوز( و ابزار متنی نتایج ) در نسخه ی مک و لینوکس( ، در هر مدلی در انتهای نوار 

 ایجنت به کاربر این امکان را می دهد تا بتواند ها و آپشن های مختلفساخت مدل قرار دارد. این نوار با قابلیت

از  برای راحتی کاربر نوار ابزارهای دیگر سایر . قسمت نتایج مانندنماییدبررسی و ذخیره  ز شبیه سازی راحاصلا

 که در زیر نمایش داده شده است.دو طریق قابل دسترس است. 

 

 ت.کلیه نام آیکن های این قسمت درجداول نشان داده شده اس

 آیکن
 توضیحات نام

Plot Group  

 Plot 
روی این گزینه باید کلیک کرد تا بر تنظیمات مربوطه  پس از اعمال ،برای رسم نمودار

 در صفحه گرافیک رسم شود. نمودار مربوط به آن

— Select Plot 

Group 

با توجه به هندسه مسئله و خواست کاربر یکی از گزینه های زیر را می تواند برای مشاهده 

 تغییرات متغییرهای مسئله برگزید.

 3D Plot Group 
کاربر تا بکار می رود، نمودار سه بعدی جدید مانند نمودارهای حجمی و برشی،  ایجادبرای 

 را در کل هندسه سه بعدی خود مشاهده کند. خود بتواند تغییرات متغییر مورد خواست

 2D Plot Group 
 بکار می رود. نمودار دو بعدی جدید مانند نمودارهای سطحی و کانتورها  ایجادبرای 

 1D Plot Group 
د طول یا زمان و یا تغییرات ساده بر حسب یک متغیر مانن یک بعدی، نمودارهای برای ایجاد

 بکار می رود.هر متغییر دیگری 

 Polar Plot 

Group 

 نمودارهای قطبی در مختصات قطبی این گزینه قابل دسترس است. ایجادبه منظور 

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_results.27.126.html
http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_results.27.126.html
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 ه شده است:ی از انواع  نمودار های مذکور نشان داددر زیر نمونه های
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 آیکن
 توضیحات نام

Data Set  

 Cut Plane 
ها از برای ایجاد نمودار های مربوط به یه برش معین از صفحه ابتدا در قسمت مجموعه  داده

های آن را یافته  سپس در قسمت رسم و یا متغیر مورد مطالعه صفحه ای برش زده و داده

 تخمین مقادیر از برش ایجاد شده استفاده می شود. 

 
Cut Line 3D 

در نمودارهای سه بعدی از این گزینه می توان استفاده  ها در طول یک خطبرای یافتن داده

 کرد.

 Cut Point 3D 
 ها در یک نقطه در مختصات سه بعدی از این گزینه می توان استفاده کرد.برای یافتن داده

 Cut Line 2D 
ها در طول یک خط در نمودارهای دو بعدی از این گزینه می توان استفاده برای یافتن داده

 کرد.

 Cut Point 2D 
 ها در یک نقطه در مختصات دو بعدی از این گزینه می توان استفاده کرد.برای یافتن داده 

 More Data 

Sets 

 .موجود است. Data Setدر اینجا کلیه ابزارهای 

 Selection 
و انتخاب یک قسمت شامل نقطه یا ناحیه یا  جهت بررسی نتایج قسمتی از هندسه ترسیمی

ها پس از حل از این گزینه می توان بهره برد تا در قسمت مورد ی داده مرز  از مجموعه

 خواست نتایج بررسی گردد.

 Remesh 

Deformed 

Configuration 

 جهت ایجاد داده ها در هندس تغییر شکل یافته به کار می رود.
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 موارد بالا شکل زیر نشان داده شده است.برای درک بهتر 
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 آیکن
 توضیحات نام

Derived Values  

 Evaluate All 
به  های خواسته شده توسط کاربر پس از حل مدلدادن کل دادهبرای بدست آوردن و نشان

نمایش داده  tableکار می رود با کلیک بر روی این آیکن داده های عددی در جداول پنجره 

 می شود.

 
Clear and 

Evaluate All 

. با کلیک بر نها ی قبل و یافتن و تخمین مجددآها و مقادیر یافت شدهپاک کردن کل داده

 پاک می شود. tableروی این آیکن داده های عددی در جداول پنجره 

 Point 

Evaluation 

بکار می رود، با انتخاب این گزینه کلیه  برای یافتن مقدار یک متغییر در یک نقطه مشخص

کنج های مدل هندسی به صورت نقطه سیاه رنگ درآمده و به کاربرامکان انتخاب و ارزیابی 

 این نقاط را می دهد. 

 Global 

Evaluation 

از قبیل: واریانس، انتگرال، مشتق، ماکزیمم، مقادیر کلی متغییر ها و عبارت ها مشاهده برای 

 قدار متوسط داده ها ی از قبیل تعریف شده به کار می رود.مینیم و م

 More Derived 

Values 

 .موجود است. Derived Valuesدر اینجا کلیه ابزارهای 
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 آیکن
 توضیحات نام

Table  

 Table 
 ها روی این گزینه کلیک راست کنید.داده افزودن یک جدولبرای 

 

 

 

 

 

 آیکن
 توضیحات نام

Export  

 Data 
ها در قالب جدول و نمودار و داده و مش می توان از این گزینه داده خروجی گرفتن ازبرای 

 فرمت های داده های خروجی در شکل نشان داده شده است. استفاده کرد.

 

 
Image 

برای ذخیره سازی عکس ها از نماهای مختلف هندسی در ابعاد مختلف  این گزینه در نرم 

کاربر با انجام تنظیمات این قسمت می تواند تصاویری با کیفیت ها و  شده است.افزار تعبیه 

 فرمت های مختلف ازنرم افزار استخراج کند.

 Animation 
های متغیر با زمان به صورت فیلم در محیط نرم حل وذخیره انیمیشن حاصل از برای پخش 

 GIF, Flash, or AVI movieافزار از پلیر و برای ذخیره سازی این فیلم در قالب )

file ) مکان مشخص ذخیره کرد. و در استفاده کرد،از گزینه انمیشن 
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 آیکن
 توضیحات نام

Report  

 Report 
ی نتایج انتخاب گزارش مختصر و یا کامل از مستندات مدل که در انتهای آپشن های زبانه

و یا  htmlقرار دارد. با استفاده از این گزینه می توانید هر مدل را در قالب یک فایل کامل 

docو ی نمودارهاذخیره کنید. این فایل شامل پارامترها و متغییر ها و ماژول ها و همه

 ست.اطلاعات مدل 
 

 

 

 نوار ابزارمتنی رسم نمودار

این نوار هنگامی که یکی از شکل های نمودار بسته به کاربر انتخاب می گردد، فعال می شود. به این صورت 

 همانطور که در شکل زیر مشاهده می کنید ابزار هایی بسته به مدل و نوع نمودار ظاهر می شود. 

 

 3D Plot Group, 2Dشود)نام نوار ابزار های ظاهر شده وابسته به نوع نمودارهایی است که انتخاب می 

Plot Group, 1D Plot Group, or Polar Plot Group اما در صورت تغییر نام نمودارها با اسم جدید در نوار .)

گردد. همانطور که در شکل بالا هم مشاهده می کنید که به نام دیگری این ی نتایج ظاهر میبالا بعد از زبانه

 ابزارهای این قسمت توضیح داده شده است. در جداول زیرزبانه ایجاد شده است. 
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 آیکن
 توضیحات نام

Plot  

 Plot 
نمودار کلیک کرد تا  برای رسم کردن نمودار در انتهای تنظیمات مربوطه روی این گزینه باید

 در صفحه گرافیک رسم شود.

 
Plot In New 

Window 

 ی گرافیکیایجاد نمودار در صفحات جدید در صفحه

Attributes  

 Add a Color Expression to 
the currently selected plot. 

جهت نمایش و بهتر نتایج و ویرایش رنگ بندی استفاده می شود برای مثال 

 Streamlineدر پلات های 

 Add a Deformation to the 
currently selected plot. 

 جهت نمایش تغییر شکل هندسی استفاده میشود

 Add a Filter to the currently 
selected plot. 

 برای فیلتر کردن برخی از نتایج بکار می رود

 Add a Height Expression to 
the currently selected plot. 

This is for 2D plots. 

 برای نشان دادن  بزرگی مقادیر دو بعدی به صورت سه بعدی 

 های زیر توجه کنید:برای آشنایی با موارد بالا به عکس

 

http://localhost:8090/doc/com.comsol.help.comsol/comsol_ref_results.27.126.html
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 ساخت یک مدل در کامسول

 fereshtehabbasizade@gmail.comپست الکترونیکی:                  زاده عباسی فرشتهتهیه کننده: 

 

هنننا و موضنننوعاتی کنننه در سننناخت ینننک مننندل در کامسنننول اسنننتفاده منننی   روششنننامل اینننن بخنننش 

گرفتنننه تنننا مسنننائل   model builderاز کنننار کنننردن بنننا پنجنننره  داده شنننده اسنننت. شنننود توضنننیح 

سنناخت یننک منندل کامننل و کنناربرد     اننننداساسننی بننرای سنناختن یننک منندل در واحنندهای مختلننف. م     

 کتابخانه نرم افزار کامسول آورده شده است. آن  به صورت مرحله به مرحله ، در قسمت 

 در این بخش موارد زیر بررسی می شوند :

  ساختن مدل درmodel builder  

  کار کردن با زیر شاخه هایmodel builder 

 دستورالعملهای مدلسازی 

 راههای مدلسازی مولتی فیزیک 

  تعیین کردن تنظیمات معادلات مربوط به مدل 

 شرایط مرزی 

  کردن فلاکس ها به صورت دقیقمحاسبه 

 پایداری عددی 

 استفاده از واحدها 

 

 model builderمدلسازی در 

سنناده مننی   model builderمزیننت کامسننول در ایننن اسننت کننه کننار کننردن بننا اجننزای موجننود در          

باشنند. در ایننن قسننمت، ترتیننب عملیننات، شنناخه هننای اجننزا، شنناخه هننا و زیننر شنناخه هننای موجننود           

در سننناختار درختنننی، پنجنننره تنظیمنننات و خصوصنننیات بنننرای شننناخه هنننای موجنننود توضنننیح داده      

 می شود.
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فیزیکنننی منعطنننف رابطفیزیکنننی اضنننافه کنننرد،  رابطشننناخه هنننای فیزیکنننی دیگنننر را منننی تنننوان بنننه   

قسنننمت راههنننایی بنننرای شناسنننایی تغیینننرات، بنننه روز رسنننانی وضنننعیت و       هسنننتند و در چنننندین 

 راههای کار کردن با این گره ها شرح داده شده است :

 شاخه های فیزیکی 

  فیزیکیرابطشاخه های پیش فرض 

 شاخه های پیش فرض فیزیکی باتوجه به ابعاد فضایی 

 ترتیب منوی شاخه فیزیک در زمینه های مختلف 

 انحصاری و در حالت مشارکت با انواع شاخه های دیگر بررسی فیزیک به صورت 

 وضعیت شاخه فیزیک 

  شاخه های دینامیک درmodel builder 

 خطاها و هشدارها 

 

Model builder 

کنتننرل مننی شننود، کننه اساسننا یننک منندل درختننی بننا          model builderپنجننره  درروننند مدلسننازی  

تمننام قابلیتهننا و عملیاتهننا بننرای ایجنناد و حننل منندلها و نمننایش نتننایج حننل مننی باشنند. ایننن روننند بننا         

انجننام مننی شننود. هننر یننک از شنناخه هننای معرفننی شننده خننود       Geometryاضننافه کننردن یننک شنناخه   

 اصلی می شود.  می توانند شامل چندین زیر شاخه باشند که مربوط به همان شاخه

هنننر گنننره پنجنننره خصوصنننیات و تنظیمنننات مربنننوط بنننه خنننودش را دارد، و همچننننین هنننر شننناخه و    

زیننر شنناخه از ایننن گننره نیننز مننی تواننند تنظیمننات و خصوصننیات خاصننی را داشننته باشنند. شنناخه هننا          

 ها می توانید ببینید.  و زیر شاخه ها و پنجره تنظیمات و خصوصیات هر یک را در مثال

کننه بننه شننما بننرای ایجنناد کننردن     اسننت،انننواع مختلفننی از گننره هننا    شننامل، Model builderپنجننره  

، بنننا ابعننناد  componentهنننا و تجسنننم سننناختار مننندلی کمنننک منننی کنننند. بنننرای مثنننال، گنننره   مننندل

فضننایی،  طبقننه بننندی مننی شننود، و گننره هننایی کننه دینامیننک هسننتند، کننه بننه شننما کمننک مننی            

 یی کنید.کنند تغییرات پایه ای در گره ها را شناسا
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همچنننین منننوی زمینننه بننرای هننر گننره بننا راسننت کلیننک کننردن روی آن گننره بنناز مننی شننود. در            

،پینندا کننردن گننره     model builderقسننمت بعنندی کننار کننردن بننا گننره هننای موجننود در قسننمت         

کنننردن، کپنننی کنننردن ینننک گنننره ، غینننر فعنننال و فعنننال کنننردن عملینننات،  psteمنبنننع، کپنننی کنننردن، 

 و غیرفعال کردن گره ها توضیح داده خواهد شد. حذف کردن مراحل یا گره ها

 مراحل عملیات

 model builderکامسنننول از طرینننق ترتینننب دهنننی و ارزینننابی گنننره هنننا و شننناخه هنننای موجنننود در     

،از بننالا بننه پننایین ، بننه عنننوان مراحننل عملیننات عمننل مننی کننند.  بننه وسننیله اضننافه کننردن یننک گننره        

در ینننک مرتبنننه مشنننخص، شنننما بعضنننی از مراحنننل    model builderبنننه شننناخه هنننای موجنننود در  

عملیننات را راه اننندازی مننی کنینند، کننه آن را بننرای انجننام ممکننن مننی کننند، بننرای مثننال، پننارامتری           

کننردن یننک منندل و اجننرا کننردن شننبیه سننازی. سننپس کامسننول هننر مرحلننه را دوبنناره ارزیننابی مننی          

حنننل را بنننه   فیزیکنننی و مشخصننناتش و رابطکنننند، بنننه صنننورت اتوماتینننک هندسنننه، منننش بنننندی،     

روزرسننانی مننی کننند. مرحلننه حننل، مننی تواننند بننه وسننیله یننک حننل کننننده تعریننف شننود و سننپس بننا        

 استفاده از حل بازگشتی، یک حل کننده متناوب ، حل شود. 

( بننرای  Build Allاعمننال تنطمیننات هننر مرحلننه بننا راسننت کلیننک بننر روی گننروه  و انتخنناب )         

 f8( و یننننا کلینننند Plotی مطالعننننه، )( بننننرا Compute( بننننرای مننننش، )Buildهندسننننه،  )

بننرای پننلات اسننتفاده مننی شننود،  همچنننین ایننن دگمننه هننا در پنجننره تنطیمننات هننر گننره  و نننوار            

 ابزار  وجود دارد.
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فیزیکننی، مننی توانننند بننه وسننیله گننره هننای دیگننر در       رابننط بعضننی از گننره هننای موجننود در شنناخه    

ایننن شنناخه باطننل شننوند. چگننونگی رفتننار نننرم افننزار کامسننول بننا ایننن موضننوع، بسننتگی بننه ایننن دارد        

 مشارکتی هست مانند شکل زیر:که آیا آن گره انحصاری یا 

 

. عملیننات مرحلننه ای بننه ایننن معنننی اسننت کننه ، مرتبننه گننره هننا در سنناختار درختننی مهننم مننی باشنند       

در زیرشنناخه هننای منندل درختننی، ایننن مرتبننه گننره هننا اسننت کننه تفنناوت را ایجنناد مننی کننند، و شننما        

و مراحننل را تغییننر دهینند و تنظیمننات مربننوط     گننره هننا را جابجننا کننرده  مننی توانینند از بننالا بننه پننایین   

، منننش بنننندی و حنننل رابنننط فیزیکنننیبنننه هنننر گنننره را وارد کنیننند.ترتیب مراحنننل : هندسنننه، منننواد،   

 کننده.

 ، این مرتبه ها می تواند در نمودارهای رسم شده در شاخه نتایج مهم باشد.همچنین
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 Global Definitionsگره تعاریف کلی 

کاربرمیتوانننند  ، زیرشننناخه هنننایی موجودنننند کنننه   (,Global Definitionsگرررره  تعررراریف کلررری ) 

بنننا راسنننت کلینننک کنننردن روی ببنننرد. در کنننل مننندل بنننه کنننار آنهنننا را توابنننع کننناربردی بنننا تعرینننف 

Global Definitions   مننننی تننننوان پارامترهننننا، متغیرهننننا، توابننننع ،user-defined ،load group   و

constrain group  .را اضافه کرد 
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اسنننت کنننه در آن منننی تنننوان، قسنننمتهای مختلنننف هندسنننه را اضنننافه و   بخشنننی،   partsشررراخه 

بهننم مننرتبط سنناخت. ایننن شنناخه و جزئینناتش اگننر قابننل رویننت نبودننند، مطننابق شننکل بننالا مننی             

آن را اضنننافه کنننرد. زیرشننناخه هنننای    Global Definitionsتنننوان بنننا راسنننت کلینننک کنننردن روی    

،بننه صننورت شننکل زیننر مننی     Geometryموجننود در ایننن قسننمت کننه بننا راسننت کلیننک کننردن روی       

 در این قسمت می توان ابعاد انتخابی به مدل را نیز تعیین کرد.، که باشد

     

 

جننایی اسننت کننه مننی تننوان مننواد را بننا خصوصننیات مننورد نظننر بننه         ، Materialsشرراخه مررواد  

منندل اضننافه کننرد، و خصوصننیات تمننام مننوادی کننه در کننل منندل بننه کننار مننی روننند در ایننن  قسننمت        

 تعریف می شود.
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  Componentگره 

ایننن گننره قسننمت اساسننی منندل مننی باشنند کننه شننامل هندسننه و سننطح فیزیکننی مناسننب و تعیننین          

شننده، مننش و متغیرهننا و تعنناریف محلننی بننرای منندل مننی باشنند. یننک منندل مننی تواننند چننندین گننره        

Component   داشنننته باشننند. بنننرای مثنننال، اگنننر سیسنننتمی را بخنننواهیم مننندل کننننیم کنننه در بخشنننی

یگننری سننه بعنندی نینناز باشنند، هننر یننک از ایننن قسننمت      از ایننن سیسننتم منندل دوبعنندی و دربخننش د   

 Model Builderجننندا مننندل منننی کننننیم و هنننر دو شننناخه را بنننه        Componentهنننا را در ینننک  

 Componentاضننافه کننرده و همزمننان حننل مننی کنننیم. شننما مننی توانینند متغیرهننای بننین ایننن دو            

گنننره  هنننای آیکنننون  مختلنننف را بنننه وسنننیله اپراتنننور کوپلیننننگ ، بنننه یکننندیگر کوپنننل کنننرد.        

Component  در جدولزیر نشان داده شده است.، همچنین ابعاد فضایی  

 MODEL BUILDERفضایی در مختصات  آیکون

 مختصات فضایی آیکون

 

 سه بعدی      

 
 دو بعدی متقارن محوری    

 
 دو بعدی      

 
 یک بعدی متقارن محوری    

 

 یک بعدی    

 
صنننفربعدی، بنننرای مننندلهایی تعرینننف منننی شنننود کنننه مسنننتقل از فضنننا منننی باشنننند، منننثلا           

 ها ODEواکنشهای شیمیایی یا دیگر 
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 به مدل  Componentافزودن  یک 

شننما مننی توانینند منندلهایی را بننا چننند هندسننه مختلننف، بننه وسننیله اضننافه کننردن یننک یننا چننند گننره        

Component  بنننهModel Builder   .بنننرای اینننن کنننار بایننند روی گنننره      ایجننناد کنیننندroot کنننه ،

 Add Componentمنننی باشننند راسنننت کلینننک کنننرده و گزیننننه    Model Builderبنننالاترین گنننره در 

 را انتخاب کرد. و در ادامه ابعاد مورد نظر را هم تعیین می کنیم. مطابق شکل زیر : 

 

 جزئیات گره ها 

، بنننرای مدلسنننازی جرینننان الکتریکنننی  Model Builder، مثنننالی از جزئینننات گنننره هنننا در زینننرشنننکل 

 می باشد.  اتجامدرابط و انتقال حرارت در 
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گننره هننای پننیش فرضننی کننه بننه هنگننام انتخنناب رابننط فیزیکننی و نننوع حننل در نننرم افننزار نمننایش           

 داده می شود به شرح زیر می باشد:

 pairsمحورها،  viewها،  انتخاب user-defined  ،selectionsشامل متغیرهای :  (Definitions)تعاریف

مختصات  coordinate systemکوپلینگ اجزا، probes  ،coupling componentتوابع،  functionsها،  جفت

 سیستم می باشد که به صورت محلی برای یک مدل تعریف می شود. 

 

: اینننن بخنننش شنننامل مراحنننل عملینننات هندسنننی و ینننا وارد کنننردن      ( Geometry) هندسررره

 می باشد.  CADیک هندسه از 
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: شنننامل اطلاعنننات منننواد و خصوصنننیات منننواد منننورد نیننناز در مننندل منننی    ( Materials) مرررواد

 باشد. 

 

کننناربر منننی : اینننن ننننرم افنننزار چنننند فیزیکنننی اسنننت و (Phisycs Interface ) فیزیکنننی رابنننط 

مننورد نینناز خننود را از پنجننره فیزیکننی  همانننند شننکل زیننر انتخنناب کننند. بننا          هننای فیزیننک تواننند

 ایجاد می شود. Model Builderانتخاب هر یک از رابط های فیزیکی گره آن در پنجره 

 

اسنننتفاده  چنننندین رابنننط فیزیکنننی بنننرای مننندل   زمنننانی ( : Multiphysicsچنرررد فیزیکررری )

ی چننند فیزیکنن ایننن گننره ظنناهر مننی شننود، ایننن گننره شننامل  تمننامی ویژگیهننای نسننبی        مننی شننود  

 رابط ها می باشد.

انجننام   مراحننل انجننام عملیننات مننش بننندی     در ایننن گننره تمننامی    ( : Meshesمررش بنرردی) 

  تغییر می باد. Meshمی گیرد. زمانی که فقط یک مش  انتخاب شود نام این گره به 
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در ایننن پنجننره قابننل تغییننر اسننت و مننی تننوانیم      Component هننر یننک از گننره هننای مربننوط بننه    نننام

 گذاری کنیم.  آن را به راحتی نام

 Component پنجره تنظیمات

 (generalقسمت عمومی )

ایننن قسننمت شننامل تنظیمننات عمننومی مننی باشنند کننه شننما بننه صننورت نرمننال بننرای هننر منندل نینناز         

 به تغییر آنها دارید .

 (unit system)  سیستمواحد 

مننی باشنند،    Same as global systemبننه صننورت پننیش فننرض لیسننت تنظیمننات ایننن قسننمت        

چنانچننه کنناربر بخواهینند سیتسننم اننندازه گیننری را تغییننر دهنند مننی تواننند از لیسننت گزینننه هننای             

 این قسمت گزینه واحد اندازه گیری را انتخاب کند. 

 مختصات فضایی

اسنننتفاده منننی شنننود. همچننننین بنننرای مننندلهای  Zو  X  ،Yحورهنننای بنننرای مننندلهای سنننه بعننندی از م

دوبعننندی و ینننک بعننندی نینننز از محورهنننای ذکنننر شنننده اسنننتفاده منننی شنننود. بنننرای هندسنننه هنننای   

اسنننتفاده منننی شنننود. اینننن اسنننامی در مواقنننع نیننناز قابنننل   zو  r φ متقنننارن محنننوری از محورهنننای

 تغییر می باشند .

 مرتبه شکل هندسی 

گزینننه هننای مختلننف مننی باشنند کننه بننرای تعیننین مرتبننه منحنننی          ایننن قسننمت شننامل لیسننتی از   

المننان هننای مننش اسننتفاده مننی شننود بننه صننورت پننیش فننرض اتوماتیننک مننی باشنند، کننه باعننث              

کنناهش مراتننب در برخننی از مننوارد مننی شننود.  ولننی ایننن تنظیمننات بننا توجننه بننه هندسننه مننورد نظننر        

 .  جهی و شش وجهیقابل تغییر می باشد مانند : خطی، منشور قائم، مکعبی، چهارو
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